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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed 
as constituting an additional warranty. HP shall not be liable for technical or editorial errors 
or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or 
copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software, 
Computer Software Documentation, and Technical Data for Commercial Items are licensed 
to the U.S. Government under vendor's standard commercial license.

Third-Party Web Sites

HP provides links to external third-party Web sites to help you find supplemental 
information.  Site content and availability may change without notice.  HP makes no 
representations or warranties whatsoever as to site content or availability.

Copyright Notices

©  1993 - 2007 Mercury Interactive Corporation, All rights reserved

Trademark Notices

Adobe® is a trademark of Adobe Systems Incorporated.

JavaTM is a US trademark of Sun Microsystems, Inc.

Microsoft®, Windows®, and Windows NT® are U.S registered trademarks of Microsoft 
Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

Unix® is a registered trademark of The Open Group.
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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

http://ovweb.external.hp.com/lpe/doc_serv/
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Support

Mercury Product Support

You can obtain support information for products formerly produced by Mercury as follows:

• If you work with an HP Software Services Integrator (SVI) partner (www.hp.com/
managementsoftware/svi_partner_list), contact your SVI agent.

• If you have an active HP Software support contract, visit the HP Software Support Web 
site and use the Self-Solve Knowledge Search to find answers to technical questions.

• For the latest information about support processes and tools available for products 
formerly produced by Mercury, we encourage you to visit the Mercury Customer Support 
Web site at: http://support.mercury.com.

• If you have additional questions, contact your HP Sales Representative.

HP Software Support

You can visit the HP Software Support Web site at:

www.hp.com/managementsoftware/services 

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract. To find more information about access levels, go to: 
www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to: 
www.managementsoftware.hp.com/passport-registration.html

www.hp.com/managementsoftware/svi_partner_list
www.hp.com/managementsoftware/svi_partner_list
http://support.mercury.com
www.hp.com/managementsoftware/services
www.hp.com/managementsoftware/access_level
www.managementsoftware.hp.com/passport-registration.html
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Welcome to This Guide

Welcome to HP Quality Center, the HP Web-based test management tool. 
Quality Center helps you organize and manage all phases of the application 
testing process, including specifying testing requirements, planning tests, 
executing tests, and tracking defects.

Throughout the testing process, Quality Center projects are accessed by 
many users—including developers, testers, and quality assurance managers. 
In order to protect, maintain, and control information in a testing project, 
users are assigned to groups with different access privileges. Only a 
Quality Center project administrator (belonging to the TDAdmin user 
group) has full privileges in a Quality Center project.

As a Quality Center site administrator, you use Site Administration to create 
and maintain Quality Center domains and projects; manage Quality Center 
users, connections, and licenses; define database servers; and modify 
Quality Center configurations.

As a Quality Center project administrator, you use Project Customization to 
customize project entities and lists, set up user groups and permissions, 
configure mail, set alert rules, and configure the workflow in the 
Quality Center modules.

Quality Center is shipped without any passwords defined. To protect your 
testing data from unauthorized access, it is highly recommended that you 
set passwords early in the Quality Center process.



Welcome to This Guide

12

How This Guide is Organized

The Quality Center Administrator’s Guide provides information regarding 
the administration, maintenance, and customization of Quality Center. 

It contains the following parts:

 Part I Site Administration

Describes how the site administrator uses Site Administration to manage 
Quality Center projects. This includes maintaining projects, users, 
connections, licenses, servers, configuration parameters, and site analysis.

 Part II Project Customization

Describes how the project administrator uses the Project Customization 
window to control access to a project by defining the project users and their 
privileges. It also describes how to customize a project to meet the specific 
needs of the project users.

 Part III Workflow Customization

Describes how to create workflow scripts to customize the Quality Center 
user interface and to control the actions that users can perform.

 Part IV Appendixes

Describes how to use Quality Center Checker, a diagnostic tool that tests 
many of the Quality Center server components that Quality Center uses; 
the methodology for upgrading and migrating from previous versions of 
TestDirector or Quality Center; and storing project data in the project’s 
database as an alternative to storage on the application server's file system.
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Documentation Library

The Documentation Library is an online help system that describes how to 
use Quality Center. You can access the Documentation Library in the 
following ways:

➤ Click Documentation Library in the Quality Center Help menu to open 
the Documentation Library home page. The home page provides quick 
links to the main help topics.

➤ Click Help on this page in the Quality Center Help menu to open the 
Documentation Library to the topic that describes the current page.

Documentation Library Guides

The Documentation Library consists of the following guides and references, 
available online, in PDF format, or both. PDFs can be read and printed using 
Adobe Reader, which can be downloaded from the Adobe Web site 
(http://www.adobe.com).

Getting Started explains how to use the Documentation Library and how it 
is organized. (Available online.)

What’s New? describes the newest features in the latest versions of 
Quality Center. (Available online and in PDF format.)

You can also access What’s New? from the Quality Center Help menu. In 
addition, you can choose Help > Product Feature Movies to view short 
movies that demonstrate the main product features. 

Readme provides last-minute news and information about Quality Center. 

Quality Center Guides:

HP Quality Center User’s Guide explains how to use Quality Center to 
organize and execute all phases of the testing process. It describes how to 
define requirements, plan tests, run tests, and track defects. (Available 
online and in PDF format.)

HP Quality Center Administrator’s Guide explains how to create and 
maintain projects using Site Administration, and how to customize projects 
using Project Customization. (Available online and in PDF format.)

http://www.adobe.com
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HP Quality Center Tutorial is a self-paced guide teaching you how to use 
Quality Center to manage the software testing process. (Available in PDF 
format.)

HP Quality Center Installation Guide explains how to install Quality Center 
on a server machine in a cluster environment or as a stand-alone 
application. (Available in PDF format.)

Business Process Testing Guides:

HP Business Process Testing User’s Guide explains how to use Business 
Process Testing to create business process tests. (Available online and in PDF 
format.)

HP Business Process Testing Tutorial provides a self-paced guide that teaches 
you the basics of Business Process Testing in the Quality Center application. 
(Available in PDF format.)

API References:

HP Quality Center Database Reference provides a complete online reference 
for the project database tables and fields. (Available online.)

HP Quality Center Open Test Architecture API Reference provides a 
complete online reference for the Quality Center COM-based API. You can 
use the Quality Center open test architecture to integrate your own 
configuration management, defect tracking, and home-grown testing tools 
with a Quality Center project. (Available online.)

HP Quality Center Site Administration API Reference provides a complete 
online reference for the Site Administration COM-based API. You can use 
the Site Administration API to enable your application to organize, manage, 
and maintain Quality Center users, projects, domains, connections, and site 
configuration parameters. (Available online.)

HP Quality Center Custom Test Type Guide provides a complete online 
guide for creating your own testing tool and integrating it into the Quality 
Center environment. (Available online.)
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Additional Online Resources

The following additional online resources are available from the 
Quality Center Help menu:

Knowledge Base uses your default Web browser to open the Mercury 
Customer Support Web Site directly to the Knowledge Base landing page.

Customer Support Web Site uses your default Web browser to open the 
Mercury Customer Support Web site. This site enables you to browse the 
Mercury Support Knowledge Base and add your own articles. You can also 
post to and search user discussion forums, submit support requests, 
download patches and updated documentation, and more. The URL for this 
Web site is http://support.mercury.com. 

HP Software Web site uses your default Web browser to access the HP 
Software Web site. This site provides you with the most up-to-date 
information on HP Software products. This includes new software releases, 
seminars and trade shows, customer support, and more. The URL for this 
Web site is http://www.hp.com/managementsoftware. 

Add-ins Page opens the HP Quality Center Add-ins Page, which offers 
integrations with HP testing tools, as well as third-party, synchronization, 
and version control tools. For more information, refer to the 
HP Quality Center Installation Guide.

 

http://support.mercury.com
http://www.hp.com/managementsoftware
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Typographical Conventions

This guide uses the following typographical conventions:

UI Elements and 
Function Names

This style indicates the names of interface elements on 
which you perform actions, file names or paths, and 
other items that require emphasis. For example, “Click 
the Save button.” It also indicates method or function 
names. For example, "The wait_window statement has 
the following parameters:"

Arguments This style indicates method, property, or function 
arguments and book titles. For example, “Refer to the 
HP User’s Guide.”

<Replace Value> Angle brackets enclose a part of a file path or URL 
address that should be replaced with an actual value. 
For example, <MyProduct installation folder>\bin.

Example This style is used for examples and text that is to be 
typed literally. For example, “Type Hello in the edit 
box.”

CTRL+C This style indicates keyboard keys. For example, “Press 
ENTER.”

[ ] Square brackets enclose optional arguments.

{ } Curly brackets indicate that one of the enclosed values 
must be assigned to the current argument. 

... In a line of syntax, an ellipsis indicates that more items 
of the same format may be included. In a 
programming example, an ellipsis is used to indicate 
lines of a program that were intentionally omitted.

| A vertical bar indicates that one of the options 
separated by the bar should be selected.
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1
Site Administration at a Glance

Using Site Administration, you create and maintain Quality Center projects, 
users, servers, site connections, license usage, and parameters. You can also 
define site administrators and change site administrator passwords.

Starting Site Administration

Using Site Administration, you create and maintain your Quality Center 
projects. 

To start Site Administration:

 1 To start Site Administration, you can:

➤ Open your Web browser and type your Quality Center URL:
http://<Quality Center server name>[<:port number>]/qcbin. The 
Quality Center Options window opens. Click the Site Administration 
link.

➤ Alternatively, open your Web browser and type your Site Administration 
URL: http://<Quality Center server name>[<:port number>]/sabin.

This chapter describes: On page:

Starting Site Administration 19

Understanding Site Administration 21

Defining Site Administrators 23
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The first time you run Site Administration, files are downloaded to your 
workstation. Subsequently, Quality Center carries out a version check on the 
client files installed on your workstation. If there is a newer version on the 
server, updated files are downloaded to your workstation.

Note: To download files to your computer, you must log in with 
administrator privileges. This applies if you are running Quality Center for 
the first time, upgrading to a newer version, or applying a service pack. For 
more information on the minimum permissions required to install client 
components, refer to the HP Quality Center Installation Guide.

After the Quality Center version has been checked and updated if necessary, 
the Quality Center Site Administration Login window opens.
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 2 In the User Name box, type the name of a user who is defined as a site 
administrator. The first time you log in to Site Administration, you must use 
the site administrator name that you specified during the installation of 
Quality Center. After you log in to Site Administration, you can define 
additional site administrators. For more information, see “Defining Site 
Administrators” on page 23.

 3 In the Password box, type your site administrator password. The first time 
you log in to Site Administration, you must use the site administrator 
password that you specified during the installation of Quality Center.

To define or change the site administrator password, see “Changing 
Passwords” on page 97.

 4 Click Login. Site Administration opens.

Understanding Site Administration

As a Quality Center site administrator, you create and maintain 
Quality Center projects, users, and servers using Site Administration.

➤ Click the Site Projects tab to manage your Quality Center projects. This 
includes adding new domains and projects, enabling extensions for projects, 
querying project data, restoring projects, renaming projects, and activating 
or deactivating projects. For more information, see Chapter 2, “Managing 
Quality Center Projects.”

You can also upgrade projects from a previous Quality Center version to the 
current version. For more information, see Chapter 3, “Upgrading and 
Migrating Projects.”

➤ Click the Site Users tab to add new users and define user properties, 
including changing passwords. For more information, see Chapter 4, 
“Managing Quality Center Users.”

➤ Click the Site Connections tab to monitor the users currently connected to a 
Quality Center server. For more information, see Chapter 5, “Managing User 
Connections and Licenses.”

➤ Click the Licenses tab to monitor the total number of Quality Center 
licenses in use and to modify the license key. For more information, see 
Chapter 5, “Managing User Connections and Licenses.”
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➤ Click the Servers tab to modify Quality Center server information, such as 
the log file and mail protocol. For more information, see Chapter 6, 
“Configuring Servers and Parameters.”

➤ Click the DB Servers tab to manage your database servers. This includes 
adding a new database server, editing a database’s connection string, and 
changing a database’s default administrator user name and password. For 
more information, see Chapter 6, “Configuring Servers and Parameters.”

➤ Click the Site Configuration tab to modify Quality Center configuration 
parameters. For more information, see Chapter 6, “Configuring Servers and 
Parameters.”

➤ Click the Site Analysis tab to monitor the number of licensed Quality Center 
users connected to your projects at specific points over a period of time. For 
more information, see Chapter 7, “Analyzing Site Usage.”

➤ Click the Tools button on the upper-right corner of the Site Administration 
window, and choose Migration Tool to migrate any projects you created in 
TestDirector to Quality Center. For more information, see Chapter 3, 
“Upgrading and Migrating Projects.”
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Defining Site Administrators

You can define Quality Center users as site administrators. Only users 
defined as site administrators can access Site Administration.

To secure the information in Site Administration, ensure that each user you 
add as a site administrator has a password defined. For more information, 
see “Changing Passwords” on page 97. 

To define site administrators:

 1 In Site Administration, click the Site Users tab.

 2 Click the Site Administrators button. The Site Administrators dialog box 
opens displaying the Site Administrators list.

To change the sort order of the Site Administrators list from ascending to 
descending, click the UserName or FullName column heading. Click the 
column heading again to reverse the sort order.

You can search for a user in the Site Administrators list by typing the name 
of a user in the Find box, and clicking the Find button.
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 3 Click the Add Site Administrators button. The Quality Center Users list is 
displayed in the right pane.

 4 Select the users that you want to assign as site administrators. You can 
search for users by typing a search string in the Find box above the Users list, 
and clicking the Find button.

 5 Click the Add Selected Users button. Alternatively, double-click a user. The 
selected users are moved to the Site Administrators list in the left pane.

 6 To remove a site administrator from the Site Administrators list, select the 
user and click the Remove Selected Site Administrators button. Click OK to 
confirm. The user is removed from the Site Administrators list.

 7 To refresh the Site Administrators list or Users list, click the Refresh button 
above the appropriate list.
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2
Managing Quality Center Projects 

Site Administration enables you to manage and maintain Quality Center 
domains and projects.

This chapter describes: On page:

About Managing Quality Center Projects 26

Understanding the Quality Center Project Structure 27

Creating Quality Center Domains 30

Creating Quality Center Projects 32

Copying Quality Center Projects 38

Updating Project Details 42

Assigning Users to Projects 46

Enabling Extensions for a Project 50

Querying Project Tables 51

Deactivating and Activating Projects 53

Pinging Projects 54

Renaming Projects 54

Removing Projects 55

Deleting Projects 55

Deleting Domains 56

Editing the Connection String 57
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About Managing Quality Center Projects

Before you start working in Quality Center, you need to create a 
Quality Center project. A Quality Center project collects and stores data 
relevant to a testing process. You can create a Quality Center project that 
works on Oracle, Microsoft SQL, or Microsoft Desktop Engine (MSDE). You 
can either create an empty Quality Center project, or copy the contents of 
an existing project to a new project. You can also restore access to an 
existing project.

After you create a project, you can add and remove users from the project, 
enable extensions for the project, query the contents of the project by 
defining and running SQL statements, and deactivate/activate access to the 
project. You can also migrate a project from TestDirector to the current 
version of Quality Center.

Quality Center projects are grouped by domain. A domain contains a group 
of related Quality Center projects and assists you in organizing and 
managing a large number of projects.

Restoring Access to Quality Center Projects 58

Renaming the Defects Module for a Project 60

This chapter describes: On page:
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Understanding the Quality Center Project Structure

When you install Quality Center, the installation program creates a base 
repository on the application server's file system. The Site Administration and 
Quality Center directories are subfolders of this repository. 

The Site Administration directory is located in C:\Program Files\Mercury\
Quality Center\repository\sa, by default. This directory stores global XML 
files, style sheets, templates, and reports to be used by all projects in the base 
repository.

The Quality Center directory is located in C:\Program Files\Mercury\
Quality Center\repository\qc, by default. It is a working area for a group of 
domains that are shared by multiple users. Each domain stores 
Quality Center projects. If you chose to install the Quality Center demo 
project during installation, the QC directory includes a default domain that 
stores the QualityCenter_Demo project. When you create a new project, you 
can add it to the default domain or to a user-defined domain.
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The following diagram shows the structure of the repository.

For each project, you can store data such as test scripts, reports, and 
attachments in the QC directory.

A project directory contains the following subdirectories:

➤ attach. A subdirectory for storing attachments.

➤ checkouts. A subdirectory for version control integration.

➤ components. A subdirectory for storing business component scripts. 
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➤ scripts. A subdirectory for storing workflow scripts.

➤ script_templates. A subdirectory for storing template workflow scripts.

➤ StyleSheets. A subdirectory for storing style sheets that are used when 
mailing defects, requirements, or tests.

➤ Templates. A subdirectory for storing report templates (if empty, the report 
template from the SA subdirectory is used).

➤ tests. A subdirectory for storing automated tests.

➤ dbid.xml. An initialization file that stores project information required for 
restoring a connection to a project. For more information on restoring a 
connection to a project, see “Restoring Access to Quality Center Projects” on 
page 58.

Under the SA directory, the DomsInfo subdirectory contains the following 
information:

➤ StyleSheets. A subdirectory for storing global style sheets.

➤ Templates. A subdirectory for storing database templates used when creating 
new projects.

Note: Project data can also be stored in the project’s database. For more 
information, see “Storing Project Data in the Project’s Database” on 
page 363.
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Creating Quality Center Domains 

You can add new domains to Site Administration. Quality Center organizes 
projects in the Projects list by domain.

To create a domain:

 1 In Site Administration, click the Site Projects tab.

 2 Click the Create Domain button. The Create Domain dialog box opens.

 3 Type a Domain Name and click OK.

The new domain is added to the Projects list in alphabetical order. In the 
right pane, under Directories, you can view the location of the domain.

 4 To add a person’s name as a contact when there are questions or problems 
with the domain and/or its projects, click the Contact Name link. In the Set 
Contact Name dialog box, type the name of the contact person and click 
OK.

 5 To add the e-mail address of the contact person for the domain, click the 
Contact E-mail link. In the Set Contact E-mail dialog box, type the e-mail 
address and click OK.
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 6 To change the number of users allowed to connect concurrently to the 
domain, click the User Quota link. The Domain User Quota dialog box 
opens.

Choose Maximum Connections and type the maximum number of 
concurrent connections allowed. Click OK. 

Note: In addition to changing the number of users allowed to connect 
concurrently to a domain, you can also change the number of users allowed 
to connect concurrently to a project. For more information, see “Updating 
Project Details” on page 42.

 7 To select a default database server when creating projects in the domain, 
select a default database server from the Default DB Server list.
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Creating Quality Center Projects 

You can create Quality Center projects in Oracle, Microsoft SQL, or MSDE. 
When you create a new project, you can create an empty project or copy the 
contents of an existing project. For more information on copying projects, 
see “Copying Quality Center Projects” on page 38.

Note: For information on the Oracle or Microsoft SQL permissions required 
by Quality Center, refer to the HP Quality Center Installation Guide.

To create a project:

 1 In Site Administration, click the Site Projects tab.

 2 Select the domain where you want to create the project.

 3 Click the Create Project button. The Create Project dialog box opens.
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Note: If the SHOW_REPOSITORY_OVER_DB parameter exists and is set to 
“Y” in the Site Configuration tab, the Create a project by importing data 
from an exported Quality Center project option is also available. For more 
information on importing data, see “Importing a Project” on page 368.

 4 Choose the Create an empty project option and click Next. The following 
dialog box opens.

 5 In the Project Name box, type a name for your Quality Center project. 

 6 In the In Domain box, select a domain. 

Tip: After the project has been created, you can move it to a different 
domain in the Projects list using a drag-and-drop operation.
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 7 Click Next. The following dialog box opens.

 8 Under Database Type, select Oracle or MS-SQL. If you are working in MSDE, 
select MS-SQL.

 9 By default, the default values defined for the domain are displayed for 
Server Name, DB Admin User, and DB Admin Password. If additional 
database servers are defined, you can select another name from the Server 
Name list.

Note: For more information on defining database servers, see “Defining 
New Database Servers” on page 115.
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 10 Click Next.

If your selected database server does not have the text search feature 
enabled, a message box opens. It indicates that after this process completes, 
you can enable the text search feature. For more information on enabling 
the text search feature, see “Configuring Text Search” on page 120.

 11 If you are creating a Microsoft SQL project, proceed to step 12. For an Oracle 
project, the following dialog box opens.

In the Create in TableSpace box, select a storage location that has sufficient 
space to store the new project. You should not use UNDO as the storage 
location.

In the Temporary TableSpace box, select a temporary storage location that 
has sufficient space to store the new project.
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 12 Click Next. The Add Project Administrators dialog box opens.

Selected Project Administrators lists Quality Center users that are assigned 
as project administrators. Available Users lists Quality Center users available 
in the project. When you assign project administrators, they are moved 
from the Available Users list to the Selected Project Administrators list. 
Project administrator users can add and administer other users in the 
project.

➤ Refresh. Click the Refresh button to refresh the list of available users.

➤ Find. Type the name of a user in the Find box, and click the Find button 
to search the Available Users list.

➤ Add Selected Users. Select the users you want to assign as project 
administrators, and click the Add Selected Users button. Alternatively, 
double-click a user. The selected users are moved to the Selected Project 
Administrators list.

➤ Delete. To remove a user from the Selected Project Administrators list, 
right-click the user and click Delete.
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Note: You can also assign project administrators after you have created the 
project. For more information, see “Assigning Project Administrators” on 
page 48.

 13 Click Next. The following dialog box opens.

Verify the project details. To change any of the details, click Back.

 14 You can select Activate Project to instruct Quality Center to activate the new 
project. Only activated projects are available to users in the Quality Center 
Login window when they log in to a project. For more information, see 
“Deactivating and Activating Projects” on page 53.

 15 If the SHOW_REPOSITORY_OVER_DB parameter exists and is set to “Y” in 
the Site Configuration tab, the Store project’s repository in the database 
check box is available. You can select the check box to store project data in 
the project’s database instead of in the file system. For more information on 
storing project data in the database, see “Storing Project Data in the Project’s 
Database” on page 363. For more information on setting parameters, see 
“Setting Quality Center Configuration Parameters” on page 126. 

 16 Click Create. The new project is added to the Projects list.
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Copying Quality Center Projects 

When you create a new Quality Center project, you can copy the contents 
of an existing project to the new project.

Note: If your Quality Center server becomes unavailable while copying, you 
can resume the copying process at a later stage. To resume copying, reopen 
Site Administration and select the project from the Projects list. In the right 
pane, click the Click Here link.

To copy a Quality Center Project:

 1 Deactivate the project you want to copy. For more information, see 
“Deactivating and Activating Projects” on page 53.

 2 In Site Administration, click the Site Projects tab.

 3 Select the domain where you want to create the project.

 4 Click the Create Project button. The Create Project dialog box opens.
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Note: If the SHOW_REPOSITORY_OVER_DB parameter exists and is set to 
“Y” in the Site Configuration tab, the Create a project by importing data 
from an exported Quality Center project option is also available. For more 
information on importing data, see “Importing a Project” on page 368.

 5 Choose the Create a project by copying data from an existing project 
option and click Next. The following dialog box opens:
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 6 Under Select Project To Copy From, select the domain and project you want 
to copy and click Next. The following dialog box opens.

 7 Select Customization to copy project lists, host data, system and 
user-defined fields, workflow, and transition rules to the new project. If this 
option is selected, you can also choose to copy any of the following:

Option Description

Requirements Copies requirement data from the project. Selecting this 
option enables you to choose Include History.

Tests Copies test data from the project. If this option is selected, 
you can also choose to copy the following option:

➤ Test Sets. Copies test set data from the project. If this 
option is selected, you can also choose to copy the 
following option:

➤ Runs. Copies test run data from the project.

Selecting this option enables you to choose Include History. 

Defects Copies defect data from the project. Selecting this option 
enables you to choose Include History.

Include History Copies history data for the options that are selected. 



Chapter 2 • Managing Quality Center Projects

41

Note: If the project from which you are copying has extensions enabled, 
Quality Center automatically copies the extensions and their associated data 
to the new project.

 8 To clear all options, click Clear All.

 9 To select all options, click Select All.

 10 Click Next to continue, and perform steps 5 - 16 in “Creating Quality Center 
Projects” on page 32. 

After you successfully complete these steps, the contents of the existing 
project is copied to a new project, and the new project is added to the 
Projects list.

Public Favorite 
Views

Copies public favorite view data and Excel report definitions 
from the project. For more information, refer to the 
HP Quality Center User’s Guide.

Users and 
Groups

Copies user and group information and permission settings. 
If this option is selected, you can also choose to copy the 
following options:

➤ Private Favorite Views. Copies private favorite view data 
and Excel report definitions from the project. For more 
information, refer to the HP Quality Center User’s Guide.

➤ Mail Conditions. Copies the mailing configuration data. 
For more information, see “Configuring Automail” on 
page 217.

➤ Alerts and Follow up Flags. Copies alerts and follow up 
flags. For more information, refer to the HP Quality Center 
User’s Guide.

Option Description
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Updating Project Details 

You can update project details such as database type and project directory 
from the Project Details tab. You can also enable the automatic sending of 
defect e-mail. Updated project details are written to the dbid.xml file, so that 
if a project is restored, the updated project data is used. For more 
information, see “Restoring Access to Quality Center Projects” on page 58.

Tip: You can move a project to a different domain in the Projects list using a 
drag-and-drop operation. This does not change the physical location of the 
project.

To update project details:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project. In the right pane, select the Project 
Details tab. The project’s details are displayed.
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Note: If a project is inactive, the project icon is displayed in red. To activate, 
see “Deactivating and Activating Projects” on page 53.

 3 Under Project Database, view the following project details:

Field Description

Database Type The database type can be MS-SQL or Oracle.

Database Name The project name, as defined in the database. 

Database Server The name of the database server on which the database 
is located.

Created From Project The project was copied from this project. An Empty 
Database value indicates that the project was not 
copied. For more information, see “Copying 
Quality Center Projects” on page 38.

Restored From Project The project was restored from this project. For more 
information, see “Restoring Access to Quality Center 
Projects” on page 58.

Note: This field is displayed instead of Created From 
Project.

Created From Domain The project was copied from this domain. 

Restored From 
Domain

The project was restored from this domain. For more 
information, see “Restoring Access to Quality Center 
Projects” on page 58.

Note: This field is displayed instead of Created From 
Domain.

Connection String The connection string. To modify the connection string, 
see “Editing the Connection String” on page 57.

DB User Password The user password for the Oracle server on which the 
database is located. To modify this password, see 
“Modifying Database Server Properties” on page 117.
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 4 If you enable the Text Search link in the DB Servers tab after you have 
added a project to the Projects list in the Site Projects tab (for example, after 
creating, upgrading, or migrating a project), you must also click the 
Enable/Rebuild Text Search button. For more information, see “Enabling 
Text Search in Quality Center” on page 122.

 5 Select Send mail automatically to enable the mail configuration settings for 
a project. This instructs Quality Center to send e-mail to specified users 
every time set defect fields are updated. If this check box is not selected, 
mail configuration settings for the project have no effect and e-mail is not 
sent. For more information on configuring mail, see Chapter 12, 
“Configuring Automail.”

Quality Center sends the defect messages automatically, at specified time 
intervals. You can edit the time interval using the MAIL_INTERVAL parameter 
in the Site Configuration tab. You can also specify if you want the e-mail to 
include attachments and/or history. For more information, see “Setting 
Quality Center Configuration Parameters” on page 126.

To manually send the defect messages that have accumulated during the 
current time interval, click the Send E-mail Now button. If the Send mail 
automatically check box is not selected, defect messages do not accumulate, 
so this button has no effect.

Repository in DB Indicates where the project repository is stored. If Yes, 
the project repository is stored in the database. If No, 
the project repository is stored in the file system. 

Note: This field is displayed only if the repository is 
stored in the database, or if the SHOW_REPOSITORY_
OVER_DB parameter exists and is set to “Y” in the 
Site Configuration tab. For more information on storing 
the project repository in the database, see Appendix C, 
“Storing Project Data in the Project’s Database.”

Project Directory The location of the project repository in the file system.

Search Language Indicates the search languages for performing a text 
search. For more information, see “Selecting a Text 
Search Language for a Project” on page 123.

Field Description
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 6 To change the number of users allowed to connect concurrently to the 
project, click the User Quota link. The Project User Quota dialog box opens.

Choose Maximum connections and type the maximum number of 
concurrent connections allowed. Click OK. 

Note: The maximum number of users allowed to connect concurrently to 
the project should not exceed the number of users allowed to connect to its 
domain. For more information, see “Creating Quality Center Domains” on 
page 30.

 7 To add a description for the project, click the Description link. In the Edit 
Project Description dialog box, type your description and click OK.

 8 Click the Refresh Projects List button to refresh the projects in the selected 
domain. To refresh projects in all domains, click the Refresh Projects List 
arrow and choose Refresh All Domains.

 9 To assign users to a project, see “Assigning Users to Projects” on page 46.
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Assigning Users to Projects 

As a site administrator, you can control access to Quality Center projects by 
defining the users that can log on to the project. You can assign users to 
projects from the Quality Center Users list, or copy users from existing 
Quality Center projects. You can also assign users as project administrators. 
For more information on assigning project administrators, see “Assigning 
Project Administrators” on page 48.

When a user is no longer working on a project, remove the user from the 
project to ensure project security. Removing a user from a project does not 
delete the user from the Quality Center Users list. To remove the user from 
Quality Center, you must delete the user from the Site Users tab, as 
described in “Deleting Users” on page 104.

Notes: 

➤ As a Quality Center project administrator, you can assign and remove 
users from projects, and change user privileges from the Project 
Customization window. For more information, see Chapter 9, “Managing 
Users in a Project”.

➤ You can assign projects to users from the Site Users tab. For more 
information, see “Assigning Projects to Users” on page 101.

➤ Quality Center sends automatic e-mail notification to project 
administrators when users are assigned or removed from a project in Site 
Administration. You can make automatic notification unavailable by 
adding the AUTO_MAIL_USER_ NOTIFICATION parameter in the Site 
Configuration tab. For more information, see “AUTO_MAIL_USER_ 
NOTIFICATION” on page 131.
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To assign users to a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project. In the right pane, select the Project Users 
tab. 

The users for the selected project are displayed. 

You can click the User Name or Full Name column to change the sort order 
of user names or full names in the Project Users list from ascending to 
descending. You can also click the Project Administrator column to group 
users by project administrators.
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 3 Click the Add button, and choose one of the following options:

➤ Add From The Users List. The Users list is displayed to the right of the 
Project Users tab. Select the users that you want to assign to the project. 
You can search for users by typing a search string in the Find box above 
the Users list, and clicking the Find button. 

➤ Copy From Another Project. The Projects list is displayed to the right of 
the Project Users tab. To copy a user, click a project to expand the project 
directory, and select the user name check box. To copy all users from a 
project, select the project’s check box. To clear all selected users, click 
Clear All.

 4 Select users from the Users list or Projects list, and click the Add Selected 
Users button. Alternatively, double-click a user. The selected users are 
displayed in the Project Users list.

 5 To remove a user from a project, select the user in the Project Users list and 
click the Remove button. Click Yes to confirm. The user is removed from the 
Project Users list.

 6 To refresh the Project Users list or Users list, click the Refresh button above 
the appropriate list.

Assigning Project Administrators
After you add users to projects you can assign users as project administrators 
(belonging to the TDAdmin user group). Project administrators have full 
privileges in the Quality Center project from the Project Customization 
window. For more information, see Chapter 10, “Managing User Groups 
and Permissions.”

When you copy users from other projects, they are added with the same user 
group privileges they had in the project from which they were copied, 
provided the user group exists in this project. If the user group does not 
exist in this project, the users are added with Viewer group privileges. If you 
copy a user from another project in which the user is a project 
administrator, the user is automatically assigned as a project administrator 
in this project.
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When you add users to the project from the Users list, those users are added 
with Viewer group privileges (read-only privileges). 

Note: You can also assign project administrators when you create a new 
project. For more information, see “Creating Quality Center Projects” on 
page 32.

To assign Project Administrator privileges to a user:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project. In the right pane, select the Project Users 
tab.

 3 In the Project Users list, select the Project Administrator check box for each 
user you want to assign as a project administrator.

 4 To remove a user from the Project Administrator group, clear the Project 
Administrator check box, and confirm you want to remove the user from 
the group.



Chapter 2 • Managing Quality Center Projects

50

Enabling Extensions for a Project

If you have a license for a Quality Center extension and the extension is 
installed on your Quality Center server, you must enable the extension for a 
project before you can use it with the project. Extensions add extra 
functionality to Quality Center. Note that you cannot disable an extension 
for a project after you enable it.

To enable Quality Center extensions for a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project. In the right pane, click the Project 
Extensions tab. This tab is available only if you have a license for at least one 
extension and the extension is installed on the Quality Center server. The 
Extensions list is displayed, listing extensions installed on the 
Quality Center server.

 3 To enable a single extension for the project, in the Extensions list, select the 
Enabled check box for the extension you want to enable.
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 4 To enable more than one extension for the project, select the extensions you 
want to enable and click the Enable Selected Extensions button. Click Yes to 
confirm. The selected extensions are enabled for the project.

 5 To refresh the Extensions list, click the Refresh button.

Querying Project Tables 

You can query specific data that is stored in your project. You query a project 
by defining and running SQL statements. The following examples show SQL 
queries and the results that they return.

Query Results

select * from BUG
where BG_STATUS = 'Open'

All defects that are open.

select * from BUG
where BG_RESPONSIBLE = 'james_qc' or 
BG_RESPONSIBLE = 'mary_qc'

All defects assigned to either 
James or Mary.

select count (*) from BUG
where BG_RESPONSIBLE = 'mary_qc'

The number of defects assigned to 
Mary.

select * from BUG
where BG_RESPONSIBLE='james_qc' and 
BG_STATUS='open'

All open defects assigned to 
James.
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Using the first query example, the SQL query returns the following:

To query a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, double-click a project.

 3 Select a table. Quality Center automatically runs the “SELECT *” query for 
this table and displays all the data for the table in the SQL Query Results 
grid.

 4 Define a query by typing an SQL statement in the SQL pane.

 5 Click the Execute SQL button. The data returned by the query appears in the 
SQL Query Results grid. 

To export query results, your database administrator can run the same 
queries on the project database and export the results for you.
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Deactivating and Activating Projects 

You can deactivate or activate a Quality Center project. When you 
deactivate a project, the project name is removed from the Projects box in 
the Quality Center Login window. The project is not deleted from the server. 
Any users currently connected to the project are forced to log out when you 
deactivate.

Note: It is recommended that you deactivate a project before you change 
any data that may cause inconsistency for a connected user.

To deactivate a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Deactivate Project button. A message box indicates that all 
connected users will be disconnected. 

 4 Click OK to confirm. The project is deactivated and the project icon is 
changed in the Projects list.

To activate a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Activate Project button. The project is activated and the project 
icon is changed in the Projects list.
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Pinging Projects 

You can check whether a project database is accessible from Site 
Administration.

To ping a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Ping Project button.

 4 Click OK when prompted with a message that the ping was successful.

Renaming Projects 

You can rename a project in the Projects list.

To rename a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Rename Project button. If the project is active, you are prompted 
to deactivate it. For more information, see “Deactivating and Activating 
Projects” on page 53.

 4 In the Rename Project dialog box, enter the new name for the project and 
click OK. The project is renamed in the Projects list.
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Removing Projects 

You can remove a project from the Projects list in Site Administration. This 
does not delete the project from the server and you can restore the project if 
necessary. For more information on restoring access to a project, see 
“Restoring Access to Quality Center Projects” on page 58.

To remove a project from the Projects list:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Remove Project button.

 4 Click OK to confirm. If the project is still active, you are prompted to 
deactivate it. For more information, see “Deactivating and Activating 
Projects” on page 53.

 5 Click OK.

Deleting Projects 

You can delete a project from the Projects list in Site Administration. This 
deletes the contents of the project from the server and you cannot restore 
the project.

To delete a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Delete Project button. 

 4 Click OK to confirm. If there are active users connected to the project, you 
are prompted to disconnected them. 

The Database Admin Password dialog box opens. If you did not specify a 
database administrator user name or password, enter the database 
administrator’s user name and password and click OK. If you previously 
specified a database administrator user name or password, these credentials 
are already entered in the dialog box.

 5 Click OK.
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Deleting Domains 

You can delete a domain. It is removed from the Projects list, and its 
contents are deleted from the server. 

Note: You cannot delete a domain if it contains projects. To delete the 
domain, you must first delete the projects. For more information, see 
“Deleting Projects” on page 55.

To delete a domain:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a domain.

 3 Click the Delete Domain button.

 4 Click Yes to confirm.



Chapter 2 • Managing Quality Center Projects

57

Editing the Connection String 

You can edit a project’s connection string. For more information on 
connection strings, see “Defining New Database Servers” on page 115.

To edit the connection string:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project.

 3 Click the Edit Connection String button or the Connection String link. If the 
project is still active, you are prompted to deactivate it. For more 
information, see “Deactivating and Activating Projects” on page 53.

The Connection String Editor dialog box opens.

 4 In the Connection String box, modify the attributes of the connection 
string. 

 5 To test the connection string, click Test Connection. 

 6 Click OK to save your connection string modification and close the 
Connection String Editor.
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Restoring Access to Quality Center Projects 

You can restore access to a Quality Center project that is not in your current 
Projects list in Site Administration. For example, you may want to access a 
project from another server. After you restore access to a project, it is added 
to the Projects list in Site Administration.

Notes: 

➤ To restore a TestDirector 7.6 or 8.0 project, you must migrate the project 
to Quality Center 9.2. Before restoring the project, make sure that the 
database where the project resides exists in the DB Servers tab in Site 
Administration on your Quality Center server, since the Quality Center 
server needs to access the contents of the restored project from the 
project’s database. For more information, see Chapter 3, “Upgrading and 
Migrating Projects.”

➤ If a project has extensions installed, the server to which you restore it 
must also have the same extensions installed.

To restore access to a Quality Center project:

 1 In Site Administration, click the Site Projects tab.

 2 Click the Restore Project button. The Restore Project dialog box opens.

 3 To locate the file that includes the project that you want to restore, click the 
browse button to the right of the dbid.xml file location box. The Open File 
dialog box opens.
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 4 Locate the file. For information on the location of the dbid.xml file, see 
“Understanding the Quality Center Project Structure” on page 27.

 5 Select the dbid.xml file and click Open. The Restore Project dialog box opens 
and displays the database type, name, server, and the directory path of the 
project.

 6 In the Restore Into Domain box, select the domain in which you want the 
restored project to be located.

 7 Click Restore.

 8 If your database server does not have the text search feature enabled, a 
message box opens. You can enable the text search feature before or after 
this process completes. 

➤ Click Yes to continue this process. After the process completes, you can 
enable the text search feature. 

➤ Click No to stop this process. Enable the text search feature and then 
restart the process. 

For more information on enabling the text search feature, see “Configuring 
Text Search” on page 120.

 9 When the restore process completes, click OK.

 10 Click Close to close the Restore Project dialog box and view the restored 
project in the Projects list.
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Renaming the Defects Module for a Project

You can rename the Defects module for a specific project. For example, you 
can change the name of the Defects module from Defects to Bugs. You 
rename the Defects module by adding a parameter to the DATACONST table 
of the project. For more information on modifying project tables, see 
“Querying Project Tables” on page 51.

Note: You can rename any Quality Center module for all your projects by 
adding the REPLACE_TITLE parameter in the Site Configuration tab. For 
more information, see “REPLACE_TITLE” on page 136.

To rename the Defects module for a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, double-click the project for which you want to rename 
the Defects module.

 3 Select the DATACONST table.

 4 In the SQL pane, type an SQL INSERT statement to insert a row into the 
table with the following values:

➤ In the DC_CONST_NAME column, insert the parameter name 
REPLACE_TITLE.

➤ In the DC_VALUE column, insert a string that defines the new name for 
the Defects module, in the following format:

original title [singular];new title [singular];original title [plural];new title [plural]

For example, to change the name of the module from Defects to Bugs, type 
the following SQL statement into the SQL pane:

insert into dataconst values ('REPLACE_TITLE', 'Defect;Bug;Defects;Bugs')

 5 Click the Execute SQL button. The new row is added to the DATACONST 
table. The Quality Center project displays the new Defects module name.
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3
Upgrading and Migrating Projects 

To work with previously created projects, you must upgrade or migrate them 
to your current version of Quality Center.

Tip: To enable you to upgrade and migrate from a previous TestDirector or 
Quality Center version to Quality Center 9.2 with the minimum possible 
interruption to your system operations, you should be familiar with the 
considerations and recommendations involved in the migration process. For 
more information, see Appendix B, “Guidelines for Upgrading and 
Migrating to Quality Center.”

This chapter describes: On page:

About Upgrading and Migrating Projects 62

Upgrading Quality Center Projects 63

Migrating TestDirector Projects to Quality Center 70

Backing Up Quality Center and TestDirector Projects 81

Restoring Quality Center and TestDirector Projects 83
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About Upgrading and Migrating Projects

To work with a project from a previous version, you must either upgrade or 
migrate your project to Quality Center. The following table describes the 
process required for working with a previously created project.

Before you upgrade or migrate from a previous version, protect data stored 
in your databases by backing up your projects. You can back up projects 
stored on a database or in the file system. For more information on backing 
up projects, see “Backing Up Quality Center and TestDirector Projects” on 
page 81. 

In the event that the upgrade or migration fails, you can restore the data 
from the back ups. You must restore backed up projects before trying the 
upgrade or migration process again. For more information on restoring 
projects, see “Restoring Quality Center and TestDirector Projects” on 
page 83.

From Quality Center or 
TestDirector:

To Quality Center 9.2:

Quality Center 8.x or 9.0 You must upgrade the project to Quality Center 9.2 
using Quality Center 9.2 Site Administration. For 
more information, see “Upgrading Quality Center 
Projects” on page 63.

TestDirector 7.6 or 8.0 You must migrate the project to Quality Center 9.2 
using the Quality Center 9.2 Migration Tool. For 
more information, see “Migrating TestDirector 
Projects to Quality Center” on page 70.
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Upgrading Quality Center Projects

This section describes how to upgrade projects from Quality Center 8.x or 
9.0 to Quality Center 9.2. You can choose to upgrade one project at a time, 
or several projects in a domain consecutively. After you have upgraded, you 
can no longer use your projects with a previous Quality Center version.

If you are upgrading projects on an Oracle database server earlier than 
Oracle 10g, it is recommended that you collect statistics both before and 
after you perform the upgrade. For more information, see “Collecting Oracle 
Database Statistics” on page 67.

Note: When upgrading a project to Quality Center 9.2, all requirements are 
assigned a requirement type of Undefined in the Requirement Type field. 

To upgrade a single project:

 1 Before commencing the upgrade process, back up your Quality Center 
project. For more information, see “Backing Up Quality Center and 
TestDirector Projects” on page 81.

 2 In Site Administration, click the Site Projects tab.

 3 In the Projects list, select a project.

 4 Click the Upgrade Project button. 

 5 If your database server does not have the text search feature enabled, a 
message box opens. You can enable the text search feature before or after 
this process completes.

➤ Click Yes to continue this process. After the process completes, you can 
enable the text search feature. 

➤ Click No to stop this process. Enable the text search feature and then 
restart the process. 

For more information on enabling the text search feature, see “Configuring 
Text Search” on page 120.

 6 If the project is active, you are prompted to deactivate it. For more 
information, see “Deactivating and Activating Projects” on page 53.
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 7 If the option to store project data on the database is available, you are 
prompted to move the project repository to the database.

➤ Click Yes to confirm that you want to move the repository to the 
database.

➤ Click No to confirm that you want to keep the repository in the file 
system.

For more information on storing project data on the database, see 
Appendix C, “Storing Project Data in the Project’s Database.”

 8 Click Yes to confirm that you want to upgrade your project. The upgrading 
process starts.

If the upgrade fails, Quality Center displays an error message with reasons 
for the failure and refers you to the log file. You must restore the backed up 
project before you try to upgrade again. For more information, see 
“Restoring Quality Center and TestDirector Projects” on page 83.

 9 When the upgrade process completes, you are prompted to activate the 
project. Click Yes.

Tip: If the upgrade process completes with warning messages, you should fix 
the problems and then upgrade the project again.

To upgrade several projects in a domain consecutively:

 1 Before commencing the upgrade process, back up your Quality Center 
projects. For more information, see “Backing Up Quality Center and 
TestDirector Projects” on page 81.

 2 In Site Administration, click the Site Projects tab.

 3 In the Projects list, select a domain.
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 4 Click the Upgrade Multiple Projects button. The Upgrade Multiple Projects 
dialog box opens.

 5 Under After the upgrade, choose whether you want Quality Center to leave 
all projects deactivated after the upgrade, activate only the previously active 
projects, or activate all projects. By default, only the currently active projects 
are activated after the upgrade is performed.

 6 If the option to store project data on the database is available, the Project 
Repository section is displayed. If any of the projects that you are about to 
upgrade contain project repositories in the file system, you can select Move 
project’s repository from the file system to the database to move the 
repositories to the project databases. For more information on storing 
project data on the database, see Appendix C, “Storing Project Data in the 
Project’s Database.”
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 7 You can view the current version numbers of your projects. You can view the 
version numbers for all the projects in the domain, or select specific projects 
for which you want to view the version numbers:

➤ To view the version numbers for all projects, click Select All and then 
click the Display Versions button.

➤ To view the version numbers for specific projects only, select the boxes 
beside the project names  and click the Display Versions button. 

The project version number appears in the Version column. 

 8 You can upgrade all projects in the domain, or select specific projects to 
upgrade:

➤ To upgrade all projects, click Select All and then click the Upgrade 
Projects button.

➤ To upgrade specific projects only, select the boxes beside the project 
names  and click the Upgrade Projects button.

 9 If your database server does not have the text search feature enabled, a 
message box opens. You can enable the text search feature before or after 
this process completes.

➤ Click Yes to continue this process. After the process completes, you can 
enable the text search feature. 

➤ Click No to stop this process. Enable the text search feature and then 
restart the process. 

For more information on enabling the text search feature, see “Configuring 
Text Search” on page 120.

 10 If any of the selected projects are active, you are prompted to deactivate 
them. For more information, see “Deactivating and Activating Projects” on 
page 53. 

 11 The upgrading process and results are displayed in the Upgrade Results box. 
Click Close to close the Upgrade Multiple Projects dialog box.

If the upgrade fails, Quality Center displays an error message with reasons 
for the failure and refers you to the log file. You must restore the backed up 
projects before you try to upgrade again. For more information, see 
“Restoring Quality Center and TestDirector Projects” on page 83.
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Collecting Oracle Database Statistics
Quality Center uses Oracle’s cost-based SQL optimizer to determine the 
most efficient way to carry out a SQL statement. For the optimizer to work 
properly, it requires up-to-date statistical information on the data being 
accessed. In Oracle 10g, collecting statistics is an automatic task. In earlier 
versions of Oracle, you must collect statistics for all Quality Center project 
schema tables on a periodic basis. In particular, database statistics must be 
collected before and after upgrading a Quality Center project.

Collecting Statistics on a Periodic Basis

During the initial phase of Quality Center deployment, it is recommended 
that you collect statistics for all Quality Center project schemas (tables and 
indexes). After your Quality Center system is stable, you can collect statistics 
on a weekly basis.

When working with large Quality Center environments, it is recommended 
that you collect statistics only for objects for which the amount of data 
changes significantly during the day, or for new objects that are created 
(such as new tables and indexes created by the upgrade process).

Note: Collecting statistics is a resource-consuming operation that can take a 
long time. It is therefore recommended that you collect statistics during 
special maintenance hours.

To collect statistics for a specific project schema:

 1 Log in to the Quality Center database schema using SQL*Plus.

 2 Run the following command:

Exec DBMS_STATS.GATHER_SCHEMA_STATS (ownname => '<name of 
Oracle schema>', estimate_percent => 20, cascade => TRUE);
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To collect statistics for a specific project schema table and its indexes:

 1 Log in to the project schema using SQL*Plus.

 2 For each table, collect statistics by running the following command:

Exec DBMS_STATS.GATHER_TABLE_STATS (ownname => '<name of Oracle 
Schema>', tabname => '<Name of table for which you want to collect statistics>', 
estimate_percent => 5, cascade => TRUE);

(Cascade => True instructs the Oracle database to analyze all the indexes in 
the table.)

Collecting Statistics Before Upgrading Quality Center Projects

When you upgrade a Quality Center project, Quality Center performs 
numerous changes to the installed version including applying database 
schema changes and data modifications. These changes may require some 
time to complete like any other set of SQL statements performed by the 
database server. To reduce the time spent by the upgrade process on 
changing the database schema or data to the minimum necessary, it is 
mandatory that the database statistics are updated.

Quality Center’s project upgrade process checks if the database statistics 
were collected recently. If they were not collected recently, it performs 
statistics collection for the project's user schema prior to starting the 
upgrade. The database keeps this information for each user schema in a view 
called USER_TABLES.

Since collecting statistics can take a long time, it is recommended that you 
collect statistics before you perform the upgrade. You should collect 
statistics when there is less demand on the database server. For more 
information on collecting statistics, see “Collecting Statistics on a Periodic 
Basis” on page 67.

To check when the database statistics were last collected for a specific table:

 1 Login to the project schema using Oracle SQL*Plus.

 2 Run the following query:

SELECT TO_CHAR(LAST_ANALYZED,'DD/MM/YYYY HH24:MI:SS') FROM 
USER_TABLES WHERE TABLE_NAME LIKE '<table name>';
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To check when the database statistics were last collected for any table in 
the project user schema:

 1 Login to the project schema using Oracle SQL*Plus.

 2 Run the following query:

SELECT TO_CHAR(MIN(LAST_ANALYZED),'DD/MM/YYYY HH24:MI:SS') 
FROM USER_TABLES;

Collecting Statistics After Upgrading Quality Center Projects

After the upgrade process is complete, it is recommended that you collect 
database statistics again to enhance database performance. This is because 
Quality Center performs significant database schema changes and data 
modifications during the upgrade. For more information on collecting 
statistics, see “Collecting Statistics on a Periodic Basis” on page 67.
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Migrating TestDirector Projects to Quality Center

To work with TestDirector 7.6 or 8.0 projects, you must migrate the projects 
to Quality Center 9.2. Projects are migrated to Quality Center using the 
Migration Tool. You must specify the source and target servers. The source 
server is the TestDirector server from which you want to migrate the project. 
The target server is the Quality Center server to which you want to migrate 
the project. When migrating from TestDirector, you can use the same 
repository used in TestDirector, or you can copy the repository to 
Quality Center.

This section describes the migration prerequisites, the migration workflow, 
the repository migration options, and the migration process.

Tip: To enable you to migrate from TestDirector 7.6 or 8.0 to Quality Center 
9.2 with the minimum possible interruption to your system operations, you 
should be familiar with the considerations and recommendations involved 
in the migration process. For more information, see Appendix B, 
“Guidelines for Upgrading and Migrating to Quality Center.”
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Migration Prerequisites 
Before you start the migration process, make sure that you consider the 
following issues:

➤ The user account that is running the Quality Center (target) server must 
have the same read and write permissions as the user account used to run 
the TestDirector (source) server.

➤ To specify the maximum number of projects that can be migrated from 
TestDirector to Quality Center at one time, set the MIGRATION_MAX_ 
NUMBER_OF_PROJECTS parameter. By default, you can migrate up to 50 
projects at a time. For more information, see “MIGRATION_MAX_ 
NUMBER_OF_PROJECTS” on page 135.

Migration Workflow
When you migrate projects from TestDirector to Quality Center, the 
following events occur:

➤ The TestDirector project is upgraded to Quality Center.

➤ The project is removed from the TestDirector server but it remains on the 
database server. The project can now be accessed only from the 
Quality Center server.

➤ The users are imported from TestDirector to Quality Center.

➤ The Site Configuration parameters are imported from TestDirector to 
Quality Center.

➤ One of the following migration options is performed:

➤ If you choose the Use the current repository option, the repository path 
is updated so that it can be accessed by Quality Center. 

➤ If you choose the Create a copy of all repository data on the target 
server file system option, the repository is copied to Quality Center and 
is stored in the file system.

For more information on migration options, see “Choosing a Repository 
Migration Option” on page 72.
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Choosing a Repository Migration Option
The Migration Tool provides the following options for migrating the 
repository:

➤ Use the current repository. Uses the same repository used in TestDirector. 
You need to define the path to be accessed by Quality Center.

➤ Create a copy of all repository data on the target server file system. 
Copies the repository to Quality Center and stores it in the file system.

Note: When migrating Microsoft SQL Server or Oracle-based TestDirector 
projects, the databases of these projects are not copied to Quality Center.

The following table compares the migration options:

Use the current repository
Create a copy of all repository data on 
the target server file system

The repository is unchanged. The repository is copied to 
Quality Center and stored in the file 
system.

Additional configurations may be 
required on the TestDirector and 
Quality Center servers. See table 
below.

No additional configurations are 
required.

This option is faster than the Create a 
copy of all repository data on the 
target server file system option.

This option is slower than the Use the 
current repository option.
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To work with the Use the current repository option, the following 
additional configurations may be required:

When choosing the Create a copy of all repository data on the target server 
file system option, the Migration Tool uses the HTTP protocol to copy the 
repository from the TestDirector server to the Quality Center server. If the 
TestDirector repository is larger than 3 GB or if it contains over 200 projects, 
the migration process may take a long time to complete. 

To improve performance, instead of using the Create a copy of all repository 
data on the target server option, you can copy the repository at the 
operating system level. For more information on copying from the 
operating system level, refer to the Mercury Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 38780.

Configure the repository for 
Quality Center on Windows

Configure the repository for 
Quality Center on UNIX or 
Linux

Repository is on 
the same 
computer as the 
TestDirector server

On the TestDirector server, 
share the repository 
directory so that it can be 
accessed from 
Quality Center by a UNC 
path by the user running 
Quality Center.

Configure the repository 
and the Quality Center 
computer settings so that 
the repository on the 
TestDirector computer can 
be accessed from the 
Quality Center computer by 
a UNIX/Linux-based path. 

Repository is on a 
different computer 
than the 
TestDirector server

No need to modify the UNC 
path. The same path can be 
used by Quality Center. 
Note that the user running 
Quality Center must have 
permissions to this shared 
path.

Configure the repository 
and the Quality Center 
computer settings so that 
the repository on a 
computer other than 
TestDirector can be accessed 
from the Quality Center 
computer by a 
UNIX/Linux-based path. 

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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Migrating Projects
This section describes how to migrate a project from TestDirector to 
Quality Center. Before you start the migration process, it is recommended 
that you review “Migration Prerequisites” on page 71, and “Choosing a 
Repository Migration Option” on page 72.

To migrate a project:

 1 Before you start the migration process, back up your TestDirector project. 
For information on backing up projects, see “Backing Up Quality Center and 
TestDirector Projects” on page 81. 

 2 On the TestDirector machine, insert the HP Quality Center installation DVD 
into the DVD drive. Install the MercuryQualityCenter_MigrationTool.exe 
file.

Note: Make sure that the executable is installed using the same user account 
that is used for running the TestDirector server.

 3 On a separate machine, open the Quality Center Site Administration 
(http://<Quality Center server name>[<:port number>]/sabin), and log in. 
Site Administration opens.
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 4 Click the Tools button on the upper-right corner of the Site Administration 
window and choose Migration Tool. The Login Servers page opens. 

 5 Under Source Login, specify the following:

➤ In TestDirector URL, specify the TestDirector URL from which you want 
to migrate the project (http://<TestDirector server name>/tdbin). 

➤ In the Password box, type the TestDirector password for logging in to the 
Site Administrator. 

 6 Under Target Login, specify the following:

➤ In Quality Center Site Admin URL, specify the Quality Center Site 
Administration URL to which you want to migrate the project 
(http://<Quality Center server name>[<:port number>]/sabin).

➤ In the User Name box, type the Quality Center site administrator user 
name.

➤ In the Password box, type the Quality Center site administrator 
password.
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 7 Click Next. The Domains and Projects page opens.

 8 Select the projects to be migrated. To select all projects, click Select All. 

You cannot migrate a project in the following situations:

➤ A project of that name already exists on the Quality Center server.

➤ The project database server is not defined on the Quality Center server. 
On the Quality Center target server, define the database server 
configuration to be identical to that defined on the TestDirector source 
server. For more information on defining a database server, see “Defining 
New Database Servers” on page 115.

 9 To clear all selected projects, click Clear All.

 10 To refresh the projects list, click Refresh List.

 11 If the migration process was previously interrupted before completion, you 
can resume the process. To resume, select a resumable project from the 
projects list or click Select All Resumable to select all resumable projects. 
Click Resume to continue the migration process. These buttons are available 
only if you have resumable projects.
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 12 Click Next. The Repository page opens.

 13 Choose a repository migration option. For more information on the 
repository migration options, see “Choosing a Repository Migration 
Option” on page 72.

 14 If you chose Create a copy of all repository data on the target server file 
system, proceed to step 16 on page 80.

If you chose Use the current repository, modify the target repository path in 
the Repository Path on Target Server After Migration box, as follows:

➤ If the target server runs on a Windows platform, modify the path from an 
absolute path to a UNC path. For example, change the target path from 
F:\Td_dir to \\<source_server>\Td_dir.

➤ If the target server runs on a UNIX or a Linux platform, modify the 
Windows-based path to the UNIX-based path. For example, to modify an 
absolute path to a UNIX/Linux-based path, change the target path from 
F:\Td_dir to /net/<source_server>/td_dir.

To undo all changes, click Restore All and then click Yes to confirm.
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 15 To modify or verify the physical path of a project on the Quality Center 
server, click Advanced. 

If your database server does not have the text search feature enabled, a 
message box opens. After this process completes, you can enable the text 
search feature. For more information, see “Configuring Text Search” on 
page 120.

The Repository Path page opens. 

The following columns are available:

Column Name Description

Projects Indicates the project name.

DB Server Name Indicates the name of the database server used for 
the project. The database server name used on the 
Quality Center machine must be the same as the 
name on the TestDirector machine.
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Physical Location Indicates the physical path of the project on the 
Quality Center server. To modify, double-click a 
physical location path or click Modify, and edit the 
path. If the Quality Center server runs on a UNIX 
or a Linux platform, modify the Windows-based 
path to the UNIX-based path. If the Quality Center 
server runs on a Windows platform, modify the 
path from an absolute path to a UNC path. 

➤ To verify the availability of the paths, click 
Verify Paths.

➤ To undo a change, click Restore and then click 
Yes to confirm.

➤ To undo all changes, click Restore All and then 
click Yes to confirm.

Test Repository Location The path is displayed if the test folder is not stored 
in the project repository. To modify, double-click a 
repository location path or click Modify, and edit 
the path. If the Quality Center server runs on a 
UNIX or a Linux platform, modify the 
Windows-based path to the UNIX-based path. If 
the Quality Center server runs on a Windows 
platform, modify the path from an absolute path to 
a UNC path. 

➤ To verify the availability of the paths, click 
Verify Paths.

➤ To undo a change, click Restore and then click 
Yes to confirm.

To undo all changes, click Restore All and then 
click Yes to confirm.

Column Name Description
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 16 Click Next. 

If your database server does not have the text search feature enabled, a 
message box opens. After this process completes, you can enable the text 
search feature. For more information, see “Configuring Text Search” on 
page 120.

The Migration Summary page opens.

 17 Click Migrate to start the migration process. An information box opens.

 18 Click OK to confirm.

 19 When the migration process ends, an information box opens. Click OK.

If the migration fails, you must restore the backed up project before trying 
the migration process again. For more information, see “Restoring 
Quality Center and TestDirector Projects” on page 83.

 20 To save the log file of the migration process as an HTML file, click Save to 
File.

 21 Click Close to exit the Migration Tool.
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Backing Up Quality Center and TestDirector Projects

You can protect data stored in your databases by backing up your 
Quality Center and TestDirector projects. It is recommended that you back 
up your projects before you upgrade or migrate from a previous version. You 
can back up projects stored on a database or in the file system.

Note: 

➤ For information on where Quality Center 8.x stores its data, refer to the 
Mercury Support Knowledge Base (http://support.mercury.com/cgi-bin/
portal/CSO/kbBrowse.jsp), select TestDirector for Quality Center, and 
search for Article Number 36165. 

➤ For information on where TestDirector stores its data, refer to the 
Mercury Support Knowledge Base (http://support.mercury.com/
cgi-bin/portal/CSO/kbBrowse.jsp), select TestDirector for Quality Center, 
and search for Article Number 18859. You can also refer to the 
TestDirector 8.0 Administrator’s Guide.

Backing Up Projects Stored on the Database
You can back up Quality Center and TestDirector projects stored on an 
Oracle, Microsoft SQL, or MSDE database. In addition, you can back up 
TestDirector projects stored on an Access or Sybase database.

To back up projects stored on the database:

➤ For Oracle: Use the exp command. For more information on backing up a 
project on an Oracle database, refer to the Mercury Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 6760.

➤ For Microsoft SQL and MSDE: From the SQL Server Enterprise Manager, 
choose Tools > Backup Database. For more information on backing up a 
project on a Microsoft SQL or MSDE database, refer to the Mercury Support 
Knowledge Base (http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), 
select TestDirector for Quality Center, and search for Article Number 10657.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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➤ For Access: Navigate to the TestDirector Domain Physical directory on the 
file system. Under each project folder, make a copy of the TestDir.mdb file 
and store it elsewhere.

➤ For Sybase: Open Sybase Central, select your server, and click Databases. 
Right-click the TestDirector SQL database you want to back up, and select 
Backup Database.

Backing Up Projects Stored in the File System
If the project repository is stored in the file system, ensure that all data, 
including automated tests scripts and results, and attachments, is saved in 
the project directory under the repository defined during the installation of 
Quality Center. Make a copy of this common directory including all 
subdirectories and files.

If your automated tests are stored outside the project directory, make a copy 
of them. To find out whether your tests are outside the project directory, log 
in to the Site Administrator. In the Projects tab, click the DATACONST table 
for the project you want to back up. Check the value of the DC_VALUE field 
for the record with the DC_CONST_NAME tests directory. If it is not set as 
tests but is set instead to some other location, then your tests are outside of 
the project folder.
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Restoring Quality Center and TestDirector Projects

If the upgrade or migration process fails, you must restore the backed up 
projects before trying the process again. You can restore Quality Center and 
TestDirector projects that were backed up on an Oracle, Microsoft SQL or 
MSDE database server, or in the file system.

To restore a project backed up on a Microsoft SQL or MSDE database 
server:

 1 From the Site Administrator, create a new empty project using the same 
name and database location as the project you want to restore.

 2 From the SQL Server Enterprise Manager, navigate to the database and select 
Tools > Restore Database.

 3 Navigate to the backup file, and follow the restore procedure to complete 
the data restore process.

 4 In the Site Administrator, restore the project. If you are restoring your 
project from a different directory, or if you renamed your schema, you must 
update the dbid.xml file accordingly. For more information on restoring 
projects, see “Restoring Access to Quality Center Projects” on page 58.

Note: For more information on restoring a project backed up on a Microsoft 
SQL or MSDE database, refer to the Mercury Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 10657.

To restore a project backed up on an Oracle database server:

 1 Copy the backup file to the Oracle server machine.

 2 Using the SQL*Plus utility, log in to the Oracle server using the system 
account.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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 3 Create a user for the Quality Center or TestDirector project. Make sure you 
create it with the same name as the Quality Center or TestDirector project 
name (or the Oracle user name) when the project was exported.

Use these SQL statements:

CREATE USER [<project name>] IDENTIFIED BY tdtdtd DEFAULT 
TABLESPACE TD_data TEMPORARY TABLESPACE TD_TEMP; 

GRANT CONNECT,RESOURCE TO [<project name>]; 

 4 Using the command line, type imp to run the import utility.

 5 Follow the prompt, and log in to the Oracle server using the system 
account. Make sure you import all the dump files.

After all tables have been successfully imported, a confirmation message 
displays.

 6 In Site Administrator, restore the project. If you are restoring your project 
from a different directory, or if you renamed your schema, you must update 
the dbid.xml file accordingly. For more information on restoring projects, 
see “Restoring Access to Quality Center Projects” on page 58.

Note: For more information on restoring a project backed up on an Oracle 
database, refer to the Mercury Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 6760.

To restore a project backed up in the file system:

 1 Copy the backed up repository to the Quality Center or TestDirector 
repository.

 2 In the Site Administrator, restore the project. If you are restoring your 
project from a different directory, or if you renamed your schema, you must 
update the dbid.xml file accordingly. For more information on restoring 
projects, see “Restoring Access to Quality Center Projects” on page 58.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp


85

4
Managing Quality Center Users

You manage Quality Center users in Site Administration. You can add new 
Quality Center users, define user details, change user passwords, and define 
site administrators. You can also import users from LDAP and enable LDAP 
authentication for users. After you add users, you can assign projects to 
users.

This chapter describes: On page:

About Managing Users 86

Adding a New User 86

Importing Users from LDAP 88

Updating User Details 96

Changing Passwords 97

Enabling LDAP Authentication for Users 99

Assigning Projects to Users 101

Exporting User Data 104

Deleting Users 104
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About Managing Users

You use Site Administration to manage the users connected to your 
Quality Center projects. You begin by adding or importing new users to the 
Users list in Site Administration. You can then define user details and 
change or override a user’s password. You can also enable users to log in to 
Quality Center using their LDAP passwords. 

For each Quality Center user, you can select projects that the user can 
access. You can also define Quality Center users as site administrators. For 
more information, see “Defining Site Administrators” on page 23.

Note: You can monitor the users currently connected to a Quality Center 
server. For more information, see Chapter 5, “Managing User Connections 
and Licenses.”

Adding a New User 

You can add new users to the Users list in Site Administration. After the user 
is added, you can view users and define user details. For more information 
on updating user details, see “Updating User Details” on page 96.

You can also import new users from LDAP directories. For more information, 
see “Importing Users from LDAP” on page 88.

Note: Creating a new user for a Quality Center project consists of two steps:

➤ Adding the user to the Users list in Site Administration (as described in 
this section).

➤ Assigning the user to a user group using Project Customization. Each user 
group has access to certain Quality Center tasks. For more information, 
see Chapter 9, “Managing Users in a Project,” and Chapter 10, 
“Managing User Groups and Permissions.”
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To add a new user:

 1 In Site Administration, click the Site Users tab. 

 2 Click the New User button. The New User dialog box opens.

 3 Type a User Name (maximum length 60 characters) and Full Name.
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 4 Type additional user information: E-mail, Phone Number, and a Description. 
The e-mail information is important, as it enables users to receive project 
information directly to their mailboxes. 

Note: You can update user information in the User Details tab. For more 
information, see “Updating User Details” on page 96.

 5 Click OK. The new user is added to the Users list.

Importing Users from LDAP 

You can import users from an LDAP directory to the Users list in Site 
Administration.

Notes:

➤ To work with LDAP through SSL requires that you perform additional 
steps. For more information, refer to the Mercury Support Knowledge 
Base (http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 34793.

➤ The LDAP_TIMEOUT parameter enables you to define a connection time-
out between Quality Center and an LDAP server. By default, the value is 
set to 10 minutes. For more information, see “LDAP_TIMEOUT” on 
page 134.

To import a user from LDAP:

 1 In Site Administration, click the Site Users tab.

 2 Ensure that the LDAP import settings are defined. For more information, see 
“Defining LDAP Settings for Importing Users” on page 90.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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 3 Click the Import LDAP Users button. The Import LDAP Users dialog box 
opens.

 4 To filter the LDAP directory base, click the Filter All button. If you have 
preselected users, a warning message box opens. Click OK to clear all 
selections and continue. The Filter dialog box opens. Type a filter condition 
to display specific records from your LDAP directory base and click OK.

 5 To view LDAP details for a user, select an item and click the Show LDAP 
Details button. The LDAP User Details dialog box opens and displays the 
user attributes. 

 6 You can use the following options to import users:

➤ To import a user, expand a directory and mark the user name by selecting 
the check box.

➤ To import a group of users, use Ctrl or Shift to highlight users to include. 
Click the Mark All Items arrow and choose Mark Selected Items to select 
the check boxes of the highlighted users.

➤ To import all users, click Mark All Items.
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 7 To clear the check boxes of highlighted users, click the Mark All Items arrow 
and choose Clear Selected Items. To clear all check boxes, click the Mark All 
Items arrow and choose Clear All. 

 8 Click Import. A confirm message box opens. Click Yes to continue.

➤ If the users were imported successfully, a message box opens. Click OK. 
Proceed to step 9.

➤ If the same user names exist in the Users list, the Handle Conflict dialog 
box opens. For more information, see “Handling User Name Conflicts” 
on page 94.

 9 Click Close to close the Import LDAP Users dialog box.

Defining LDAP Settings for Importing Users
To enable you to import users from an LDAP directory to the Users list in 
Site Administration, you must define your LDAP import settings. 

When you import users from an LDAP directory, Quality Center copies 
attribute values from an LDAP directory into Quality Center. For each 
imported user, the following attribute values are copied:

➤ Distinguished name (DN). A unique name that is made up of a sequence of 
relative distinguished names (RDN) separated by commas. 

For example: CN=John Smith, OU=QA, O=Mercury

where CN is the common name; OU is the organizational unit; and O is the 
organization.

➤ Userid (UID). The name that identifies a user as an authorized user. The UID 
attribute value is mapped to the User Name field in Quality Center. 

➤ Full Name, Description, E-mail and Phone. Optional attributes that are used 
to populate the Full Name, Description, E-mail, and Phone Number fields 
for each user imported from an LDAP directory.
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Note: The optional LDAP_IMPORT_ATTRIBUTE_MASK parameter enables 
you to define a regular expression that can be used to distinguish between 
different values for an LDAP attribute. For more information, see “Setting 
Quality Center Configuration Parameters” on page 126.

To define LDAP settings for importing users:

 1 In Site Administration, click the Site Users tab.

 2 Click the User Settings button and choose LDAP Import Settings. The LDAP 
Import Settings dialog box opens.

 3 In the Directory provider URL box, type the URL of the LDAP server 
(ldap://<server name>:<port number>).

 4 Under LDAP authentication type:

➤ Select Anonymous to enable you to import users from the LDAP server 
using an anonymous account.

➤ Select Simple to enable you to import users from the LDAP server using 
an authorized user account and password. 
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 5 If you select Simple, the following options are enabled: 

➤ In the Authentication principal box, type the authorized user name.

➤ In the Authentication credentials box, type the password.

 6 Click the Test Connection button to test the URL of the LDAP server.

 7 Choose one of the following options:

➤ To define additional LDAP settings, proceed to step 8.

➤ To close the LDAP Import Settings dialog box, click Finish.

 8 To define additional LDAP settings, click Next. The following dialog box 
opens. 

 9 In the Directory base box, type the LDAP directory name.

 10 In the Base filter box, define filter criteria.

 11 To set the default values for the Active Directory, click the Set Default for 
Active Directory button.

 12 To set the default values for LDAP, click the Set Default for LDAP button.

 13 Choose one of the following options:

➤ To populate optional attributes in Quality Center for each user imported 
from an LDAP directory, proceed to step 14.

➤ To close the LDAP Import Settings dialog box, click Finish.
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 14 To populate optional attributes in Quality Center for each user imported 
from an LDAP directory, click Advanced. The following dialog box opens. 

 15 Define the corresponding LDAP field names. Note that User Name is a 
required field.

 16 Click Finish to close the LDAP Import Settings dialog box.
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Handling User Name Conflicts
When importing users from an LDAP directory to the Users list in Site 
Administration, you may encounter the following conflicts:

➤ Same user. A user with the same LDAP distinguished name already exists. 

➤ Same user name. A user with the same user name already exists.

To resume the process of importing users, you can choose to ignore the user, 
rename a user name, or update user information.

To handle user name conflicts:

 1 Import users (see step 8 in “Importing Users from LDAP”). If conflicts occur, 
the Handle Conflict dialog box opens. 
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 2 If the conflict is listed under Conflict: Same User, you can choose one of the 
following options to resume the process:

 3 If the conflict is listed under Conflict: Same User Name, you can choose one 
of the following options to resume the process:

 4 Click Continue. 

Option Description

Update Updates existing user information. Click the corresponding 
Solution box. Click the browse button and choose Update.

Skip Does not import the selected user (default).

Option Description

Rename Assigns a new name to the selected user. Click the 
corresponding Solution box. Click the browse button and 
choose Rename. In the New User Name box, type the new 
name.

Auto Rename Assigns a new name to the selected user by adding a suffix. 
Click the corresponding Solution box. Click the browse 
button and choose Auto Rename. The new name is displayed 
in the New User Name box.

Update Updates existing user information. Click the corresponding 
Solution box. Click the browse button and choose Update.

Skip Does not import the selected user (default).
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Updating User Details

After you add a user, you can update user details. For example, you may 
need to update a user’s full name or contact details. You can also define 
Quality Center users as site administrators. For more information, see 
“Defining Site Administrators” on page 23.

To update user details:

 1 In Site Administration, click the Site Users tab. In the right pane, click the 
User Details tab. 

 2 Select a user from the Users list.

You can search for a user in the Users list by typing the name of a user in the 
Find box, and clicking the Find button. The first user that matches the 
searched text is highlighted. Click the button again to search for other users 
containing the searched text.
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 3 Edit the user detail fields.

Note: If the user was imported from an LDAP directory to Site 
Administration, the Domain Authentication box displays the LDAP 
authentication properties of the imported user. If the user was not imported, 
the Domain Authentication box is not displayed. For more information, see 
“Importing Users from LDAP” on page 88.

 4 To assign projects to a user, click the User Projects tab. For more 
information, see “Assigning Projects to Users” on page 101.

 5 Click Apply to save your changes.

Changing Passwords 

The site administrator can change or override a user’s password. 

Notes: 

➤ You can only change passwords for users that are set to log in to 
Quality Center using their Quality Center passwords. If LDAP passwords 
are in use, this option is unavailable. For more information on LDAP 
authentication, see “Defining LDAP Settings for Importing Users” on 
page 90.

➤ Non-administrators can change their passwords using the User 
Properties link in the Project Customization window. For more 
information, refer to the HP Quality Center User’s Guide. 
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To change a password:

 1 In Site Administration, click the Site Users tab.

 2 Select a user from the Users list.

 3 Click the Password button. The Set User Password dialog box opens. 

 4 In the New Password box, type a new password (maximum length 20 
characters).

 5 In the Retype Password box, retype the user’s new password.

 6 Click OK.
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Enabling LDAP Authentication for Users

You can allow users to log in to Quality Center using their LDAP passwords, 
instead of Quality Center passwords.

Working with LDAP through SSL requires that you perform additional steps. 
For more information, refer to the for Mercury Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 34793.

Note: When users attempt to log in to Quality Center, they are 
authenticated against LDAP using the distinguished names (DN) that are 
stored in the Domain Authentication property in the Quality Center 
database. When the user attempts to log in, and the DN information in 
Quality Center is invalid, the user is unable to log in to Quality Center. 

You can enhance the search so that when the DN information is invalid, 
Quality Center also searches on the LDAP server, using the LDAP import 
settings defined in Site Administration. If the user is found, the DN is 
updated in Quality Center, and an automatic login attempt is performed.

To set this extended search, define a comma-separated list for the 
LDAP_SEARCH_USER_CRITERIA Site Configuration parameter. The possible 
values are username, email, fullname, phone, description. The order of the 
properties defines their priority if multiple results are found. 

For example, if the parameter is set to username and email, and two users are 
found with the same user name on the LDAP server, their e-mail addresses 
are checked. If more than one user is found answering the set properties, an 
error message is returned. If the search for the user succeeds, the user is 
logged in to Quality Center. 

For more information, see “Setting Quality Center Configuration 
Parameters” on page 126.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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To enable LDAP authentication for users:

 1 In Site Administration, click the Site Users tab.

 2 Click the User Settings button and choose Authentication Settings. The 
Authentication Settings dialog box opens.

 3 Under Authentication type, select LDAP to set the authentication type as 
LDAP for all users.

 4 In the Directory provider URL box, type the URL of the LDAP server 
(ldap://<server name>:<port number>).

 5 Click the Test Connection button to test the URL of the LDAP server.

 6 Click OK.

Note: Once LDAP authentication is enabled, authentication will be 
performed against the LDAP server. Make sure that the site administrator is 
set up as an LDAP user before switching to LDAP authentication, otherwise 
the site administrator will not be able to log in after the authentication type 
is switched.
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Assigning Projects to Users

As a Quality Center site administrator, you can control user access to 
Quality Center projects by defining the projects to which a user can log on. 
When a user is no longer working on a project, remove the user from the 
User Projects list. 

When you add a user to a project, the user is automatically assigned to the 
project with Viewer privileges. For more information on user groups and 
group privileges, see Chapter 9, “Managing Users in a Project,” and 
Chapter 10, “Managing User Groups and Permissions.”

Notes: 

➤ You can assign users to projects from the Site Projects tab. For more 
information, see “Assigning Users to Projects” on page 46.

➤ Quality Center sends automatic e-mail notification to project 
administrators when users are assigned or removed from a project in Site 
Administration. You can make automatic notification unavailable by 
adding the AUTO_MAIL_USER_ NOTIFICATION parameter in the Site 
Configuration tab. For more information, see “AUTO_MAIL_USER_ 
NOTIFICATION” on page 131.
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To assign projects to a user:

 1 In Site Administration, click the Site Users tab. In the right pane, select the 
User Projects tab. The Projects list for the selected user is displayed. 

You can click the Domain column to change the sort order from ascending 
to descending domain names. You can also click the Project column to sort 
according to project instead of domain name.

 2 In the Users list in the left pane, select a user. You can search for a user by 
typing the name of a user in the Find box, and clicking the Find button. 

The selected user’s projects are displayed in the User Projects list.

To group user projects by domain, select Group By Domain. Clear the check 
box to remove the group by settings.
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 3 In the User Projects tab, click the Select Projects button. The Quality Center 
Projects list is displayed in a new pane to the right of the User Projects tab.

 4 To select projects from the Projects list, expand the directory, and select the 
projects that you want to assign to the user.

To clear all selected projects, click Clear All.

 5 Click the Add current user to the selected projects button. The selected 
projects are added to the User Projects list.

 6 To remove a project from the User Projects list, select the project and click 
the Remove button. Click OK to confirm. The project is removed from the 
User Projects list. Note that this does not delete the project from the server.

 7 To refresh the User Projects list, click the Refresh Users List button.
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Exporting User Data

You can export the user name and full name of all site users from the Users 
list to a text file.

To export user data:

 1 In Site Administration, click the Site Users tab. 

 2 Click the Export User Data To File button. The Export Data To File dialog 
box opens.

 3 Select the directory where you want to save the parameters, and enter a 
name for the file in the File name box. 

 4 Click Save to export the data to a text file.

Deleting Users

You can delete a user from the Users list.

To delete a user:

 1 In Site Administration, click the Site Users tab. 

 2 Select a user from the Users list.

 3 Click the Delete User button. 

 4 Click Yes to confirm.
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5
Managing User Connections and Licenses

In Site Administration, you can monitor user connections and modify 
license information.

About Managing User Connections and Licenses

You use the Site Connections tab in Site Administration to monitor and 
manage the users connected to your Quality Center projects. For more 
information, see “Monitoring User Connections” on page 106.

You use the Licenses tab in Site Administration to view Quality Center 
license information and to modify the license key, if needed. For more 
information, see “Managing Quality Center Licenses” on page 109.

This chapter describes: On page:

About Managing User Connections and Licenses 105

Monitoring User Connections 106

Managing Quality Center Licenses 109
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Monitoring User Connections 

You can use the Site Connections tab to perform the following:

➤ Monitor the users currently connected to a Quality Center server. For each 
user, you can view the domain and project being used, the user’s machine 
name, the time the user first logged in to the project, and the time the most 
recent action was performed. You can also view the client type connection 
to the Quality Center server.

➤ View the licenses that are currently being used by each user. The 
HP Quality Center license  indicates that the user can access all modules 
in a specific project. The Defects Module license  indicates that the user 
can access only the Defects module.

➤ Send messages to users connected to your Quality Center projects. You can 
also disconnect users from projects.

➤ Modify access to a Quality Center project using the Module Access link. For 
more information, see “Customizing Module Access for User Groups” on 
page 194.

Notes: 

➤ To view the total number of licenses that are in use for each 
Quality Center module, click the Licenses tab. For more information, see 
“Managing Quality Center Licenses” on page 109.

➤ To view and analyze the number of licensed Quality Center users 
connected to your projects at specific points over a period of time, click 
the Site Analysis tab. For more information, see “Monitoring Site Usage” 
on page 144.
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To monitor user connections:

 1 In Site Administration, click the Site Connections tab.

You can click any column heading to change the sort order of the column 
from ascending to descending.

 2 To refresh the Connections list, click the Refresh Connections List button.

To instruct Quality Center to automatically refresh the Connections list, 
click the Refresh Connections List arrow and choose Automatic Refresh. By 
default, the Connections list is automatically refreshed every 60 seconds. To 
change the automatic refresh rate, click the Refresh Connections List arrow 
and choose Set Refresh Rate. In the Set Refresh Rate dialog box, specify a 
new refresh rate in seconds.

 3 You can group connected users by clicking the Group By arrow, and 
choosing a Group By option. To group connected users by project, choose 
Group By Project. To group connected users by user, choose Group By User. 
To clear the Group By settings, click the Group By arrow and choose Clear 
Group By.

 4 You can send a message to a connected user or group of users by clicking the 
Send Message button. For more information on sending messages, see 
“Sending Messages to Connected Users” on page 108.

 5 To disconnect a user or group of users from a project, select the row of the 
user or group and click the Disconnect Users button. Click Yes to confirm.
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Sending Messages to Connected Users
You can send messages to users connected to your Quality Center projects. 
This enables you to routinely inform connected users about important 
maintenance activities. For example, disconnecting a project, or restarting a 
Quality Center server. 

When you send a message, a pop-up window automatically opens on the 
user’s machine displaying the message text. The message box is displayed 
until the user closes it or disconnects from Quality Center. For more 
information, refer to the HP Quality Center User’s Guide.

To send messages to connected users:

 1 In Site Administration, click the Site Connections tab.

 2 Select the users to whom you want to send a message:

➤ To send a message to a user or group of users, select the row of the user or 
group.

➤ To send a message to multiple users, use Ctrl or Shift to highlight users to 
include.

 3 Click the Send Message button. The Send Message dialog box opens.

The To box displays the intended recipients of the message in the format 
[DOMAIN:Project Name:User Name].
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 4 In the Message Text box, type a message.

 5 Click Send. Quality Center sends the message to user machines within five 
minutes.

Managing Quality Center Licenses 

You can view the total number of licenses in use and the maximum number 
of licenses that you have for each Quality Center module. When other HP 
tools, such as QuickTest Professional, are connected to a Quality Center 
project, you can view the total number of licenses in use for these tools. You 
can also modify your license file.

Notes: 

➤ To view the Quality Center licenses that are currently being used by each 
user, click the Site Connections tab. For more information, see 
“Monitoring User Connections” on page 106. 

➤ To view and analyze the number of licensed Quality Center users 
connected to your projects at specific points over a period of time, click 
the Site Analysis tab. For more information, see “Monitoring Site Usage” 
on page 144.
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To manage Quality Center licenses:

 1 In Site Administration, click the Licenses tab. 

 2 To refresh the license information displayed in the Licenses tab, click the 
Refresh Licenses List button.

 3 To modify the license, click the Modify License button. The License Edit 
dialog box opens. To load the license file, click Load License and select the 
file. Alternatively, copy the license file and click Paste License. Click OK.
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6
Configuring Servers and Parameters

You use Site Administration to configure Quality Center and Site 
Administration servers, define and modify database servers, configure the 
text search, set configuration parameters, and define the Quality Center 
mail protocol.

This chapter describes: On page:

About Configuring Servers and Parameters 112

Configuring Server Information 113

Defining New Database Servers 115

Modifying Database Server Properties 117

Configuring Text Search 120

Setting Quality Center Configuration Parameters 126

Setting the Quality Center Mail Protocol 142
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About Configuring Servers and Parameters

You use the Servers tab to configure Quality Center and Site Administration 
server information. You can set the server log file and maximum number of 
database handles. For more information, see “Configuring Server 
Information” on page 113.

You use the DB Servers tab to define database servers that were not defined 
during installation. For each database server, you enter the database type, 
database name, default connection string, and administrator user and 
password. For more information, see “Defining New Database Servers” on 
page 115. 

You also use the DB Servers tab to modify existing database server 
definitions. For more information, see “Modifying Database Server 
Properties” on page 117. In addition, you can configure the text search 
option for a specified database server that has the text search feature 
installed and configured. For more information, see “Configuring Text 
Search” on page 120.

You use the Site Configuration tab to add and modify Quality Center 
configuration parameters. For more information, see “Setting 
Quality Center Configuration Parameters” on page 126. In addition, you 
can set the mail protocol to be used by all the server nodes in your 
Quality Center site. For more information, see “Setting the Quality Center 
Mail Protocol” on page 142.
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Configuring Server Information

You can configure Quality Center and Site Administration server 
information. This includes:

➤ Setting the Quality Center server log file. The Quality Center server can 
write all Quality Center events—API functions that send requests to a 
Quality Center project—to a log file. The log file displays the date and time 
a function was run. This enables Customer Support to trace where errors 
occur, if necessary. By default, the Quality Center server does not 
automatically record events. 

➤ Setting the maximum number of database connections. The Quality Center 
server can open a number of connections for each project on a database 
server. You can set the maximum number of concurrent connections that 
can be opened by the Quality Center server for each project.

To configure Quality Center server information:

 1 In Site Administration, click the Servers tab.

 2 In the Server list, expand a server.

 3 To set Site Administration server information, select Site Administration. To 
set Quality Center server information, select Quality Center.
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The General Settings area displays the server address and virtual directory 
name. For the Site Administration server, the virtual directory name is sabin. 
For the Quality Center server, the virtual directory name is qcbin.

 4 Under Log File Settings, click the Log Level link to configure the type of log 
file you want the server to create. Select one of the following options in the 
Log Level dialog box:

➤ None. Does not create a log file.

➤ Errors. Records error events.

➤ Warnings. Records potentially harmful situations.

➤ Flow. Records informational messages that highlight the application 
flow. 

➤ Debug. Records events that are most useful for debugging.

 5 Click the Max. Log Lines link to open the Maximum Log Lines dialog box 
and configure the maximum number of lines that the Quality Center server 
can write to the log file. Quality Center creates a new log file after the log 
file reaches the maximum number of lines. The default value is 10,000.

 6 Click the Max. Log Days link to open the Maximum Log Days dialog box 
and configure the maximum number of days that the Quality Center server 
keeps the log file. Quality Center automatically deletes the log files once the 
maximum number of days has been reached. The default value is Unlimited, 
which is displayed as -1. 

 7 Click the Log File Location link to change the directory path of the log file. 
In the Log File Location dialog box, type the new location for the log file. 

 8 If you are setting the Quality Center server information, you can also set the 
maximum number of concurrent connections that can be opened by the 
Quality Center server for each project. Click the Max. Database Connections 
link to open the Maximum Database Connections dialog box and set the 
maximum number of concurrent connections.

 9 To delete a Quality Center server from the Server list, select it and click the 
Delete QC Server button. Click Yes to confirm.

 10 Click the Refresh QC Servers List button to refresh the servers list.
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Defining New Database Servers 

You can define additional database servers that were not defined during the 
installation process.

Note: For information on the Oracle or Microsoft SQL permissions required 
by Quality Center, refer to the HP Quality Center Installation Guide.

To define a new database server:

 1 In Site Administration, click the DB Servers tab.

 2 Click the New Database Server button. The Create Database Server dialog 
box opens.
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 3 Under Database Type, select the type of database server you want to define:

➤ MS-SQL (SQL Auth.). Uses SQL authentication.

➤ MS-SQL (Win Auth.). Uses Microsoft Windows authentication.

➤ Oracle

 4 Under Database Values, in the Database Name box, type the database 
name.

 5 In the DB Admin User box, type the login name of the database 
administrator.

➤ For Oracle database type, the default administrator user account enabling 
you to create Quality Center projects is system.

➤ For MS-SQL (SQL Auth.) database type, the default administrator user 
account enabling you to create Quality Center projects is sa. 

➤ For MS-SQL (Win Auth.) database type, the DB Admin User box is 
unavailable. The login name of the database administrator is the 
Windows user that is set to run Quality Center as a service.

 6 In the DB Admin Password box, type the password of the database 
administrator. This field is unavailable if you selected the MS-SQL (Win 
Auth.) database type.

 7 Under Default Connection String, you can edit the default connection string 
parameters or the connection string, as follows: 

➤ To edit the default connection string parameters, choose Connection 
String Parameters and define the following parameters:

➤ To edit the connection string, choose Connection String and edit the 
connection string.

Parameter Description

Server Host The server name.

Port The port number of the database server.

SID The service ID for an Oracle database server.
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 8 To check whether you can connect to the database server, click the Ping 
Database Server button. The DB admin user and password you entered are 
displayed in the Ping Database Server dialog box. Click OK.

 9 Click OK to close the Create Database Server dialog box. The new database 
server you defined appears in the Database Servers list.

 10 Click the Refresh Database Servers List button to refresh the database 
servers list.

Modifying Database Server Properties

You can modify the database server properties.

Note: For information on the Oracle or Microsoft SQL permissions required 
by Quality Center, refer to the HP Quality Center Installation Guide.

To modify database server properties:

 1 In Site Administration, click the DB Servers tab.
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 2 Select a database server in the Database Servers list.

 3 To modify the connection string, click the Edit Connection String button, or 
click the Connection String link. Edit the connection string in the 
Connection String Editor and click OK. For more information on 
connection strings, see “Defining New Database Servers” on page 115.

 4 To modify the database administrator’s login name, click the Database 
Administrator User Name link. In the Database Administrator User Name 
dialog box, type the new login name and click OK. 

For more information on defining a new login name for a database 
administrator, see “Defining New Database Servers” (step 5) on page 116.

 5 To modify the database administrator’s password, click the Database 
Administrator Password button, or click the Database Administrator 
Password link. In the Database Administrator Password dialog box, type the 
new password and then retype it. Click OK.
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 6 To modify the default Quality Center user password for accessing the 
database schema, click the Quality Center User Password link. In the 
Quality Center User Password dialog box, type the new password and retype 
it. Click OK.

Note: If you have existing Quality Center projects on your MS-SQL server, 
after you change the Quality Center user password, you must also update 
the password for each project.

 7 To enable text search capabilities in Quality Center, click the Text Search 
link. 

If the text search is enabled, you can set the default text search language for 
the database server in the Default Search Language list. 

For more information on text search, see “Configuring Text Search” on 
page 120.

 8 To check whether you can connect to the database server, click the Ping 
Database Server button. The DB admin user and password you entered are 
displayed in the Ping Database Server dialog box. Click OK.

 9 To delete a database server from the Database Servers list, select it and click 
the Delete Database Server button. Click Yes to confirm.

 10 Click the Refresh Database Servers List button to refresh the database 
servers list.
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Configuring Text Search

Text search allows users to enter keywords and search specific project fields 
in the Requirements, Test Plan and Defects modules. For information on 
working with the text search feature, refer to the HP Quality Center User’s 
Guide.

Note: The Text Search link is available only if you install and configure the 
Oracle or SQL text searching feature. For Microsoft SQL 2005 SP1 and Oracle 
10g, the text search feature is installed by default. For Oracle 9i, you must 
install and configure the text searching feature on your Oracle database 
server. Quality Center does not support the text search feature for Microsoft 
SQL 2000.

To configure text search, perform the following steps:

➤ Install and enable the text search feature on the database server. For more 
information, see “Enabling Text Search on the Database Server” on 
page 121.

➤ In Site Administration, enable text search and define the default search 
language for a specified database server in the DB Servers tab. For more 
information, see “Enabling Text Search in Quality Center” on page 122.

➤ To specify a different search language for a specific project, change the 
search language from the Site Projects tab. For more information, see 
“Selecting a Text Search Language for a Project” on page 123.

➤ For a specific project, define the project fields to be included in the search 
from Project Customization. For more information, see “Defining 
Searchable Fields” on page 124.
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Enabling Text Search on the Database Server
Text search is available only if the text searching feature has been installed 
and configured on an Oracle or SQL database server. For Microsoft SQL 2005 
SP1 and Oracle 10g, the text search feature is installed by default, and no 
configuration is required.

For Oracle 9i, you must install the text search feature on your Oracle 
database server, and configure it using a predefined Quality Center package 
(QC_CTX_DDL) that is created in the CTXSYS user schema. You can create 
the QC_CTX_DDL package either by:

➤ Supplying the CTXSYS password in Site Administration when you enable 
the text search, as described in step 3 of “Enabling Text Search in 
Quality Center” on page 122. Contact your database administrator for the 
CTXSYS password.

➤ Having your database administrator manually create the QC_CTX_DDL 
package, and then enable the text search. For more information on creating 
the QC_CTX_DDL package, see the procedure that follows.

Note: For information on installing the text search feature, refer to the 
documentation provided with your database server.

To create the QC_CTX_DDL package on an Oracle 9i server:

 1 Navigate to the qc_ctxsys9i_db___oracle.sql script located in the 
\utilities\databases\scripts folder on the Quality Center installation DVD.

 2 Log in to the CTXSYS user account using Oracle SQL*Plus.

 3 Run the following command to execute the package creation script: 
@qc_ctxsys9i_db___oracle.sql.

 4 Open the qc_ctxsys9i_db___oracle.log file that is created by the package, 
and check that no errors are specified in it.

 5 Perform steps 1-3 in “Enabling Text Search in Quality Center” on page 122.
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Enabling Text Search in Quality Center
In Site Administration, you can enable text search for a specified database 
server that has the text search feature installed and configured. You can 
enable text search on a database server before or after you add any projects 
to your Projects list.

When you enable text search on a database server before you add projects, 
the projects that you add afterwards are text search enabled. When you 
enable text search on a database server after you have added projects, you 
must manually enable text search for each existing project.

After you have enabled the text search for a specified database server, you set 
the default search language for the database server. You can change the 
default search language for a specific project from the Site Projects tab. For 
more information, see “Selecting a Text Search Language for a Project” on 
page 123.

To enable text search on a database server before adding projects:

 1 In Site Administration, click the DB Servers tab.

 2 In the Database Servers list, select a database server.

 3 Click the Text Search link and click Yes to confirm. 

If you are using an Oracle 9i database server and you are prompted for the 
CTXSYS user password, type the password in the Set CTXSYS Password 
dialog box and click OK. A password is not required if the QC_CTX_DDL 
package was manually created (see “Enabling Text Search on the Database 
Server” on page 121).

The Text Search value changes from Disabled to Enabled. You cannot 
disable the text search after you have enabled it.

 4 In the Default Search Language list, set the default text search language for 
the database server.
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To enable text search on a database server after adding projects:

 1 In Site Administration, click the DB Servers tab.

 2 In the Database Servers list, select a database server.

 3 Click the Text Search link and click Yes to confirm.

If you are using an Oracle 9i database server and you are prompted for the 
CTXSYS user password, type the password in the Set CTXSYS Password 
dialog box and click OK. A password is not required if the QC_CTX_DDL 
package was manually created (see “Enabling Text Search on the Database 
Server” on page 121).

The Text Search value changes from Disabled to Enabled. You cannot 
disable the text search after you have enabled it.

 4 In the Default Search Language list, set the default text search language for 
the database server.

 5 Click the Site Projects tab, and in the right pane click the Project Details tab.

 6 For each project that you want to enable text search, click the 
Enable/Rebuild Text Search button. Click Yes to confirm.

Selecting a Text Search Language for a Project
For each project, you can specify a search language other than the default 
search language you set for the database server. For more information on 
enabling the text search and setting the default search language, see 
“Enabling Text Search in Quality Center” on page 122.

Note: Search languages are not available for a project created on a database 
server that does not have the text search feature enabled.

To select a search language for a project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project. In the right pane, click the Project 
Details tab.
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 3 In the Search Language field, select a language for the project. For more 
information on updating project details in the Project Details tab, see 
“Updating Project Details” on page 42.

Defining Searchable Fields
For each project, you must define the fields to be included in the search. The 
searchable option is only available in the Requirement, Test, Test Step (for 
design steps only), and Defect entities. Note that only user-defined fields 
with field type Memo or String, or the following system fields are available 
as searchable fields:

Entity Searchable Fields

Defect ➤ Comments

➤ Description

➤ Detected in Cycle

➤ Detected in Release

➤ Reproducible

➤ Summary

➤ Target Cycle

➤ Target Release

Requirement ➤ Comments

➤ Creation Time

➤ Description

➤ Name

➤ Target Cycle

➤ Target Release

Test ➤ Comments

➤ Description

➤ Path

➤ Template

➤ Test Name

Test Step (Design steps only) ➤ Description

➤ Expected

➤ Step Name
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To define a searchable field:

 1 In the Project Customization window, click the Project Entities link. The 
Project Entities page opens. For more information on customizing project 
entities, see “Customizing Project Entities” on page 199.

 2 Under Project Entities, expand an entity, and select a system or user-defined 
field that can be made searchable. 

 3 Select the Searchable check box.

 4 Click Save to save your changes to the Project Entities page. 
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Setting Quality Center Configuration Parameters 

You can set the default Quality Center configuration parameters and add 
optional ones.

This section includes:

➤ Default Quality Center Parameters

➤ Optional Quality Center Parameters

➤ Setting Quality Center Parameters

Default Quality Center Parameters
You can set the following default Quality Center configuration parameters:

Parameter Description

ADD_NEW_USERS_FROM_
PROJECT

(formerly 
CUSTOM_ENABLE_USER_
ADMIN)

If this parameter is set to “N”, you can add new 
Quality Center users from Site Administration 
(Site Users tab) only. If this parameter is set to “Y” 
(default), new Quality Center users can also be 
added from Project Customization. In the Project 
Users page, click Add User. The Add User to Project 
dialog box opens. If this parameter is set to “Y”, a 
New button is available for adding new 
Quality Center users. For more information, see 
“Adding a User to a Project” on page 160.

ATTACH_MAX_SIZE The maximum size (in kilobytes) of an attachment 
that can be sent with e-mail from Quality Center. If 
the attachment size is greater than the specified 
value, the e-mail is sent without the attachment. By 
default, the maximum e-mail attachment size is 
3,000 KB.
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AUTO_MAIL_WITH_
ATTACHMENT

(formerly SAQ_MAIL_
WITH_ATTACHMENT)

If this parameter is set to “Y” (default), defect e-mail 
is sent with attachments. This applies only if you 
select Send defect e-mail messages automatically in 
the Site Projects tab. For more information, see 
Chapter 12, “Configuring Automail”.

Note: The former parameter name is supported for 
purposes of backward compatibility.

AUTO_MAIL_WITH_
HISTORY

(formerly SAQ_MAIL_
WITH_HISTORY) 

If this parameter is set to “Y” (default), defect e-mail 
is sent with the history. This applies only if you 
select Send defect e-mail messages automatically in 
the Site Projects tab. For more information, see 
Chapter 12, “Configuring Automail”.

Note: The former parameter name is supported for 
purposes of backward compatibility.

BASE_REPOSITORY_PATH The base repository path. The Quality Center and 
Site Administration repositories are subfolders of 
this repository. If you change this parameter value, 
you must copy the repository to its new location 
and then restart all servers in the cluster.

CREATE_HTTP_SESSION You can use this parameter if you are working with 
load balancing over a cluster of application servers. 
If the parameter is set to “Y”, Quality Center creates 
an HTTP session. This causes the load balancer to 
operate in sticky mode, meaning that after a request 
sent by a client is directed to a particular node in 
the cluster, all subsequent requests sent by that 
client are directed to the same node.

By default, this parameter is set to “N”.

Parameter Description
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LDAP_SEARCH_USER_
CRITERIA

A comma-separated list of Quality Center user 
properties to be used as LDAP search criteria, if the 
Domain Authentication property does not contain 
the user’s distinguished name (DN). The order of 
the properties defines their priority if multiple 
results are found. The following are the possible 
values: username, email, fullname, phone, 
description. For more information on LDAP, see 
“Enabling LDAP Authentication for Users” on 
page 99.

LICENSE_ARCHIVE_
PERIOD

The time interval in days during which license 
usage is archived. License usage information before 
this period is removed from the archive. 

By default, the value is set to 365 days. If you set the 
value to -1, the license archive period is unlimited. 

LOCK_TIMEOUT The maximum number of hours that 
Quality Center objects can remain locked. After this 
time, the lock is removed. By default, the value is 
set to 10 hours. 

MAIL_FORMAT The format Quality Center uses to send e-mail. By 
default, the format is set to “HTML”. To instruct 
Quality Center to send e-mail as plain text, change 
the value to “Text”. Quality Center uses e-mail to 
send defects, requirements, tests, and test set 
notifications to Quality Center users. 

MAIL_INTERVAL The time interval in minutes for sending defect 
e-mail according to your mail configuration 
settings. By default, the value is set to 10 minutes. 
Note that this applies only if you select Send defect 
e-mail messages automatically in the Site Projects 
tab. For more information, see Chapter 12, 
“Configuring Automail”.

MAIL_MESSAGE_
CHARSET

The character set used by Quality Center to send 
e-mail to users. By default, the value is set to UTF-8.

Parameter Description
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REPORT_QUERY_
RECORDS_LIMIT

The maximum number of records that can be 
retrieved from the database for an Excel report. If 
you set the value to -1, the number is unlimited.

REPORT_QUERY_
TIMEOUT

The maximum length of time in seconds that the 
Quality Center server waits for an SQL query for an 
Excel report to be executed. If the query takes 
longer than this time to be executed, the query is 
cancelled.

SITE_ANALYSIS If this parameter is set to "Y" (default), you can track 
Quality Center license usage over time from the 
Site Analysis tab. If this parameter is set to "N", the 
Site Analysis tab is unavailable. For more 
information, see Chapter 7, “Analyzing Site Usage”.

VC If this parameter is set to “Y”, version control is 
enabled. If you enable version control, you can 
create a version control database for any project. 

If it is set to “N” (default), version control is 
disabled. 

Note: To work with version control, you must 
install a supported version control tool and the 
Quality Center Version Control Add-in on your 
Quality Center server. For more information on 
Quality Center add-ins, refer to the 
HP Quality Center Installation Guide.

WAIT_BEFORE_
DISCONNECT

The time interval in minutes that the 
Quality Center client can be inactive before it is 
disconnected from the Quality Center server. 
Disconnecting the client enables the license to be 
used by another Quality Center user. By default, the 
value is set to 600 minutes. For performance 
reasons, it is recommended to set a value of at least 
60 minutes. If you set the value to -1, 
Quality Center is not disconnected, regardless of 
how long the client is inactive.

Parameter Description
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Optional Quality Center Parameters
You can add the following optional Quality Center configuration 
parameters:

Parameter Description

ALLOW_MULTIPLE_
VALUES

This parameter determines whether the Allow 
Multiple Values check box is visible in the Project 
Entities page in Project Customization.

If this parameter is set to “N”, then the Allow 
Multiple Values check box is unavailable. If this 
parameter does not exist or is set to “Y”, then the 
Allow Multiple Values check box is available. 

For more information on the Allow Multiple Values 
check box, see “Allow Multiple Values” on page 203.

ALLOW_REQ_COVERAGE_
BY_TEST_INSTANCE

This parameter determines whether the option to 
create coverage between requirements and test 
instances is available.

If the parameter does not exist, is empty, or is set to 
“N”, then this option is unavailable. If the parameter 
is set to “Y”, you can create and view coverage 
between requirements and test instances from the 
following locations:

➤ In the Requirements module, in the Requirement 
Details view, in the Test Coverage tab

➤ In the Test Plan module, in the Test Instance 
Properties dialog box, in the Linkage and 
Coverage view
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AUTO_MAIL_SUBJECT_
FORMAT

(formerly SAQFORMAT)

This parameter enables you to customize the subject 
line of defect e-mail sent automatically to users.

For example, you can define a subject line such as 
Defect no. 4321 has changed by providing the value 
Defect no. ?BG_BUG_ID has changed, where Defect 
no. and has changed are strings, and BG_BUG_ID is a 
Quality Center field name.

To customize the subject line for a specific project, 
see “Customizing the Subject of Defect Mail” on 
page 222.

Note: The former parameter name is supported for 
purposes of backward compatibility.

AUTO_MAIL_USER_
NOTIFICATION

This parameter enables you to prevent 
Quality Center sending automatic e-mail 
notification to project administrators when users are 
assigned or removed from a project in Site 
Administration. 

If this parameter is set to “N”, then automatic 
notification is not sent to project administrators. If 
this parameter does not exist, is empty, or is set to 
“Y”, then automatic notification is sent. 

For more information on assigning users to projects, 
see “Assigning Users to Projects” on page 46.

BACKWARD_SUPPORT_
ALL_DOMAINS_PROJECTS

This parameter enables the use of DomainsList and 
ProjectsList properties for the purposes of backward 
compatibility. If this parameter is set to “Y”, then 
the DomainsList and ProjectsList properties are 
supported. If the parameter does not exist or is 
empty, the default value is “N”, and these properties 
are not supported.

Parameter Description
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BACKWARD_SUPPORT_
SA_DEFAULT_USER

This parameter enables the use of the old connection 
method to Site Administration for the purposes of 
backward compatibility. To work with scripts that 
use the old connection method (where the site 
administrator only required a password to log in), a 
user should be defined, and this user’s password is 
used during login. The value of this parameter is a 
user name, whose password is used. If the parameter 
does not exist or is empty, an empty string is used.

COPY_CHANGES_
USER_FIELDS

(formerly COPY_PASTE_
CHANGES_OWNER)

This parameter enables you to specify that the user 
who copies a record is listed in the specified User List 
fields of the copy. For more information on fields 
that have User List as their Field Type, see 
“Customizing Project Entities” on page 199.

The value of this parameter is a comma-separated list 
of User List fields.

For example, set the value of the parameter to 
BG_DETECTED_BY. Assume defect 10 is detected by 
user Cecil_qc, and user Shelly_qc copies defect 10. 
Quality Center creates a copy of the defect with 
Shelly_qc as the user who detected the defect, not 
Cecil_qc. 

CREATE_DB_
REPOSITORY_VISIBILITY

This parameter enables you to hide the option to 
store project data in the database when creating a 
new project. If this parameter is set to “N”, the Store 
project’s repository in the database check box is not 
displayed in the Create Project dialog box. If this 
parameter does not exist, is empty, or is set to “Y”, 
the check box is displayed.

Note: The option to store project data in the 
database is available only if the 
SHOW_REPOSITORY_OVER_DB parameter is set to 
“Y”. For more information, see 
“SHOW_REPOSITORY_ OVER_DB” on page 138.

Parameter Description
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DISABLE_COMMAND_
INTERFACE

If this parameter is set to “Y” (default), only users 
belonging to the TDAdmin group can use the OTA 
Command object.

If it is set to “N”, any user can use it.

For more information, refer to the HP Quality Center 
Open Test Architecture API Reference.

DISABLE_CONSOLE_
DEBUG_INFO

This parameter enables you to disable access to the 
Quality Center or Site Administration debug info 
console page (access to it is enabled by default).

If this parameter exists and is set to “Y”, the debug 
info console page cannot be accessed. Note that the 
Quality Center server must be restarted to activate 
the parameter, since the parameter is read at startup.

DISABLE_EXTENDED_
STORAGE

This parameter controls user access to the OTA 
ExtendedStorage object. This is a security feature 
that can be used to limit access to the file system of 
the project.

If this parameter is set to "Y" (default), the 
ExtendedStorage object cannot be accessed from 
TDConnection. Users can access the object from a 
specific entity for read-only, but no changes can be 
made.

If it is set to "N", the ExtendedStorage object can be 
accessed by all users, from a specific entity or from 
TDConnection.

For more information about the ExtendedStorage 
object, refer to the HP Quality Center Open Test 
Architecture API Reference.

FAVORITES_DEPTH Defines the number of most recently used favorite 
views displayed on the Favorites menu. By default, 
Quality Center displays the four most recently used 
views on the menu. To hide the list of recently used 
views completely, set the parameter to “0”.

For more information on favorite views, refer to the 
HP Quality Center User’s Guide.

Parameter Description
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HEBREW If this parameter is set to “Y”, it indicates that the 
Quality Center server is Hebrew-enabled. On a per 
project basis, you can then enable Hebrew by 
selecting Allow Hebrew language in the Site Projects 
tab. When users work in a Hebrew-enabled project, 
they can toggle between English and Hebrew by 
choosing Tools > Reading Order > Right to Left.

LDAP_IMPORT_
ATTRIBUTE_MASK

This parameter enables you to define a regular 
expression that can be used to distinguish between 
different values for an LDAP attribute when 
importing users from an LDAP directory. When 
importing users, Quality Center chooses a value for 
the attribute that matches the regular expression.

The parameter should be of the format:
<LDAP attribute name> = <regular expression>, 
where <LDAP attribute name> is the name of the 
LDAP attribute whose value you want to choose, and 
<regular expression> is a regular expression. This 
regular expression should conform to the standard 
Java syntax for regular expressions.

For example, a parameter value uid=^\D\w+$ would 
choose values for the LDAP attribute uid consisting 
of a non-digit followed by any number of word 
characters (letters, numerals or the underscore 
character).

For more information on importing users from an 
LDAP directory, see “Importing Users from LDAP” 
on page 88.

LDAP_TIMEOUT

(formerly 
DIRECTORY_TIME_LIMIT_
CONSTRAINT)

The length of time, in seconds, that Quality Center 
waits before canceling an LDAP operation.

The time limit on LDAP operations prevents a 
situation where LDAP encounters a problem and 
causes Quality Center to wait indefinitely. The 
default timeout value is 10 minutes (600 seconds).

For more information about using LDAP, see 
Chapter 4, “Managing Quality Center Users”.

Parameter Description
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LR DIRECTFILEACCESS This parameter applies if you are integrating with 
HP LoadRunner. If set to “Y”, it enables the direct 
accessing of scripts located within the same LAN as 
your Quality Center client/server.

Note: In a UNIX or Linux environment, you must 
also set the UNIX_SERVER parameter.

MIGRATION_MAX_
NUMBER_OF_PROJECTS

The maximum number of projects that can be 
migrated from TestDirector to Quality Center at one 
time. By default, you can migrate up to 50 projects at 
a time.

For more information on migration, see “Migrating 
TestDirector Projects to Quality Center” on page 70.

NEWREQTYPE This parameter determines whether the Create New 
Requirement dialog box is displayed when adding a 
requirement.

If the parameter does not exist, is empty, or is set to 
“Y”, then the Create New Requirement dialog box is 
displayed when adding a requirement. If the 
parameter is set to “N”, the Create New Requirement 
dialog box is unavailable and the New Requirements 
dialog box is opened directly. 

NLS_SEARCH_LOCALE The language used by the Find Similar Defects 
command to tokenize the defect summary. This 
parameter is needed only if the default locale on the 
server does not match the language in which the 
defect summary is written, in terms of whether 
spaces are used to separate words.

The value should be a string value that matches a 
language code listed in ISO 639 
(http://www.w3.org/WAI/ER/IG/ert/iso639.htm). 

For example, if the default locale is English and the 
text is in Japanese, which does not use spaces to 
separate words, set NLS_SEARCH_LOCALE=ja. 

If this parameter is not defined or is invalid, the 
default locale of the server is used.

Parameter Description

http://www.w3.org/WAI/ER/IG/ert/iso639.htm
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REPLACE_TITLE This parameter enables you to change the names of 
Quality Center modules across all your projects. 

Rename one or more modules by entering the 
following parameter value: 
<original title1 [singular]>;<new title1 [singular]>;
<original title1 [plural]>;<new title1 [plural]>;
<original title2 [singular]>;<new title2 [singular]>;...

For example, if you want to change the name of the 
Defects module to Bugs, and the Requirements 
module to Goals, enter the following: 
Defect;Bug;Defects;Bugs;Requirement;Goal; 
Requirements;Goals

Note: To rename the Defects module for a specific 
project only, see “Renaming the Defects Module for 
a Project” on page 60.

REQ_SHOW_
NUMERATION

This parameter determines whether the option to 
display numeration is available in the Requirements 
module and in the requirements coverage grid.

If the parameter does not exist, is empty, or is set to 
“N”, then this option is unavailable. If the parameter 
is set to “Y”, you can display numeration in the 
following ways:

➤ Requirements Module. Select View > Numeration.

➤ Requirements coverage grid. Right-click the 
coverage grid and choose Numeration.

Note that the numeration of the requirements is 
correct only if you do not sort or filter in the 
requirements tree. In addition, you cannot view the 
icons for requirement types in the requirements tree 
if numeration is displayed.

REQUIREMENT_
REVIEWED_FIELD_
AUTOMATIC_UPDATE

If this parameter is set to “Y” (default), then any 
change to a requirement field automatically sets the 
Reviewed (RQ_REQ_REVIEWED) field to “Not 
Reviewed”. 

If it is set to “N”, then a change to a requirement 
field does not affect the value of the Reviewed field. 

Parameter Description
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RESTRICT_SERVER_
FOLDERS

This parameter enables you to access 
restricted-access server directories using the OTA 
ExtendedStorage.ServerPath property. 

If this parameter does not exist, or is set to “Y”, you 
can only use the ExtendedStorage.ServerPath 
property to access the following directories:

➤ the Site Administration (SA) directory

➤ the root directory for a project

➤ the attach subdirectory for a project

➤ the components subdirectory for a project

➤ the script_templates subdirectory for a project

➤ the StyleSheets subdirectory for a project

➤ the tests subdirectory for a project

For the project-related directories, this only applies if 
your project repository is stored in the file system.

If this parameter is set to “N”, you can access all 
server directories using the 
ExtendedStorage.ServerPath property.

For more information on this property, refer to the 
HP Quality Center Open Test Architecture API Reference. 
For more information about Quality Center project 
structure, see “Understanding the Quality Center 
Project Structure” on page 27.

SECURED_QC_URL When Quality Center generates e-mail, it includes a 
link to Quality Center in the e-mail. 

If this parameter is set to “Y”, the Quality Center 
URL uses an SSL connection (starting with https:).
If it is set to “N” (default), SSL is not used. 

Parameter Description
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SELECT_FS_OVER_DB This parameter enables you to set the Store project’s 
repository in the database check box as preselected 
when creating new projects. If this parameter is set 
to “Y”, the Store project’s repository in the database 
check box is selected by default in the Create Project 
dialog box. If this parameter does not exist, is empty, 
or is set to “N”, the check box is not selected.

Note: The option to store project data in the 
database is only available if the 
SHOW_REPOSITORY_OVER_DB parameter is set to 
“Y”. For more information, see 
“SHOW_REPOSITORY_ OVER_DB” on page 138.

SHOW_REPOSITORY_
OVER_DB

This parameter enables you to use the repository 
over database option to store project data in the 
project’s database. 

If the parameter does not exist, is empty, or is set to 
“N”, the option to store project data in the project’s 
database is not available when creating or upgrading 
a project, and you cannot export or import 
Quality Center projects.

If this parameter exists and is set to “Y”, you can 
store project data in the project’s database when 
creating or upgrading a project. You can also export 
Quality Center projects, and create new projects by 
importing data from an exported Quality Center 
project file. When this parameter is enabled, you can 
use the following additional parameters:

➤ CREATE_DB_ REPOSITORY_VISIBILITY (see 
page 132) to hide the Store project’s repository in 
the database option when creating a new project.

➤ SELECT_FS_OVER_DB (see page 138) to set the 
Store project’s repository in the database option 
as preselected.

For more information, see “Storing Project Data in 
the Project’s Database” on page 363.

Parameter Description
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SQL_QUERY_
VALIDATION_ENABLED

By default, Quality Center checks SQL queries in 
Excel reports to ensure that they are valid and do not 
alter the project database. For more information on 
this validation, see the HP Quality Center User’s 
Guide.

If this parameter is set to “N”, this validation is not 
performed. If this parameter does not exist, is empty, 
or is set to “Y”, this validation is performed.

SQL_QUERY_
VALIDATION_BLACK_LIST

By default, Quality Center checks that SQL queries 
for an Excel reports do not include any of the 
following commands: INSERT, DELETE, UPDATE, 
DROP, CREATE, COMMIT, ROLLBACK, ALTER, EXEC, 
EXECUTE, MERGE, GRANT, REVOKE, SET, INTO, or 
TRUNCATE. This ensures that you do not 
inadvertently modify or delete records in the project 
database.

You can modify which commands are on this list by 
adding this parameter. The parameter’s value must 
be a comma-separated list of SQL commands that 
Quality Center should verify are not included in SQL 
queries for an Excel report.

Note that this verification is not performed if the 
SQL_QUERY_VALIDATION_ENABLED parameter 
exists and is set to “N”.

Parameter Description
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Setting Quality Center Parameters
You can add, modify, and delete parameters in the Site Configuration tab. 
You can also export parameters to a text file. 

Notes: 

➤ You cannot add or delete default parameters, you can only modify them.

➤ You must reconnect to any open projects to work with the new settings.

UNIX_SERVER If this parameter is set to “Y”, it enables direct file 
access from a testing tool on a Windows machine to 
a UNIX based repository. 

You must then add a new parameter for each 
directory on the UNIX server machine you want to 
be able to access externally and specify the 
corresponding Windows path, as follows:

➤ Parameter name is FOLDER_MAPPING_n where n 
is an identifying number. For example, 
FOLDER_MAPPING_1

➤ Parameter value is in the format 
UNIXpath->Windowspath 
For example, 
/opt/Mercury/repository/qc/->\\netapp\qc\repository\

Note: This parameter applies to the following testing 
tools: HP WinRunner and HP LoadRunner.

WR DIRECTFILEACCESS This parameter applies if you are integrating with 
HP WinRunner. If set to “Y”, it enables the direct 
accessing of scripts located within the same LAN as 
your Quality Center client/server.

Note: In a UNIX or Linux environment, you must 
also set the UNIX_SERVER parameter.

Parameter Description
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To set Quality Center parameters:

 1 In Site Administration, click the Site Configuration tab.

 2 To add a new parameter to the list, click the New Parameter button. The 
New Parameter dialog box opens. Type a name, value, and description for 
the parameter you want to add. Click OK.

 3 To delete a parameter from the list, select it and click the Delete Parameter 
button. Click Yes to confirm.

 4 To edit a parameter, select it from the list and click the Edit Parameter 
button. The Edit Parameter dialog box opens. Type a new value and value 
description, and click OK.

 5 To export parameters from the site configuration grid to a text file, click the 
Export button. The Export Data To File dialog box opens. Select the 
directory where you want to save the parameters, and enter a name for the 
file in the File name box. Click Save.

 6 You can click the Refresh Parameters List button to refresh the parameter 
list.
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Setting the Quality Center Mail Protocol

Quality Center uses e-mail to send project information to users. You can 
select the mail service to be used by all the server nodes in your 
Quality Center site. Quality Center supports the SMTP mail protocols.

For more information on setting the Quality Center mail protocol, refer to 
the HP Quality Center Installation Guide.

To set the Quality Center mail protocol:

 1 In Site Administration, click the Site Configuration tab.

 2 Click the Settings button and choose Set Mail Protocol. The Set Mail 
Protocol dialog box opens.

 3 Select one of the following options:

➤ None. Quality Center does not send e-mail.

➤ SMTP Server. Quality Center sends e-mail from an SMTP server on the 
network. Type the address of an SMTP server available on your local area 
network.

➤ Microsoft IIS SMTP Service. Quality Center sends e-mail from the 
Quality Center server machines. This option is available if you installed 
Microsoft IIS SMTP Service on your Quality Center server machines 
during IIS installation.

 4 Click Test to send a test e-mail to your mailbox. The Test Mail dialog box 
opens. Type your e-mail address and click Send. A pop-up message confirms 
whether the mail was sent successfully.

 5 Click OK to close the Set Mail Protocol dialog box.
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7
Analyzing Site Usage

In Site Administration, you can track the number of licensed users that have 
connected to your Quality Center site at specific points over a period of 
time. You can also analyze Quality Center usage by filtering the number of 
licensed users by projects or users.

About Analyzing Site Usage

You use the Site Analysis tab in Site Administration to monitor license usage 
for each time interval displayed. You can specify the time interval displayed 
along the x-axis. You can also specify what information appears in the graph 
by filtering the graph content by projects or users. 

For example, you may want to charge each department in your organization 
according to license usage. You can filter by projects in a specific department 
to view license usage for the department. You can also view license usage for 
a specific group of users by filtering according to selected users.

This chapter describes: On page:

About Analyzing Site Usage 143

Monitoring Site Usage 144

Filtering Site Usage 146

Exporting Site Analysis Data to a File 147

Customizing the Site Analysis Line Chart Graph 148
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If the Site Analysis tab is not displayed, you can make it available by 
changing the SITE_ANALYSIS parameter in the Site Configuration tab. For 
more information, see “SITE_ANALYSIS” on page 129.

Monitoring Site Usage 

You can monitor the number of licensed users that have connected to a 
Quality Center site over a period of time. You can view site usage for the last 
seven days, the last five weeks, the last twelve months, or for all days that 
users were connected to a Quality Center server. 

You can also monitor usage of different license types. Users with Full 
Licenses can access all modules in a specific project. Users with Defect 
Licenses can access only the Defects module. This data can be displayed in 
line graphs or data grids.

In addition, you can filter records by projects or users, refresh and clear filter 
settings, and save data to a file.

Note: You can monitor the users currently connected to a Quality Center 
server. For more information, see Chapter 5, “Managing User Connections 
and Licenses.”
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To monitor site usage:

 1 In Site Administration, click the Site Analysis tab.

 2 In the Type box, select a display type:

➤ Line Chart. Displays the data as a line graph.

➤ Data Grid. Displays the data as a grid.

 3 In the right pane under Period, select the period of time you want the line 
graph or data grid to show.

 4 Click the Filter button to open the Set Filter dialog box and filter the graph 
contents. For more information, see “Filtering Site Usage” on page 146.

 5 To customize the appearance of a Line Chart graph, see “Customizing the 
Site Analysis Line Chart Graph” on page 148.

 6 If you chose Data Grid, you can save the contents of a data grid as a text file, 
Microsoft Excel spreadsheet, Microsoft Word document, or HTML 
document. To save, click the Save As button. For more information, see 
“Exporting Site Analysis Data to a File” on page 147.

 7 To refresh data in the graph, click the Refresh button.
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Filtering Site Usage

You can analyze the number of users that have connected to your 
Quality Center site at specific points over time by filtering by projects or 
users.

To filter site usage:

 1 Click the Filter button. The Set Filter dialog box opens.

 2 Under Filter by, select the category that you want to filter:

➤ Projects. Displays all the Quality Center domains and projects.

➤ Users. Displays all the Quality Center site users.

 3 Click the items you want to include in the filter.

➤ For Projects, double-click the domain folder to display the domain’s 
projects, and select the projects you want to include. To filter all projects 
in the domain, select the domain folder.

➤ For Users, select the users you want to include.

 4 To clear the selected projects or users in a filter, click the Clear button.

 5 Click OK to apply the filter and close the Set Filter dialog box. The new line 
chart or data grid is displayed.
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Exporting Site Analysis Data to a File 

You can export site analysis data in a Data Grid as a text file, Microsoft Excel 
spreadsheet, Microsoft Word document, HTML document, or XML 
document.

To export Site Analysis data to a file:

 1 In Site Administration, click the Site Analysis tab.

 2 In the Type field, select the Data Grid display type.

 3 Select the graph period and filter.

 4 Click Save as, and select one of the following formats:

➤ Text Format. Saves the data as a Text file.

➤ Excel Sheet. Saves the data as an Excel sheet.

➤ Word Document. Saves the data as a Word document.

➤ HTML Document. Saves the data as an HTML document.

 5 In the Save in box, choose a location for the file.

 6 In the File name box, type a name for the file.

The Save as type box is automatically filled according to the format you 
selected.

 7 Click Save.
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Customizing the Site Analysis Line Chart Graph

You can determine how information appears in the Line Chart graph using 
the line chart toolbar. The toolbar includes the following buttons:

Show Total Values. Toggles between displaying and hiding a total value in 
the graph.

Scroll to the Left. Scrolls the graph to the left. (This button is enabled when 
the Zoom In and Zoom Out buttons are in use.)

Scroll to the Right. Scrolls the graph to the right. (This button is enabled 
when the Zoom In and Zoom Out buttons are in use.)

Show All. Returns the graph to its normal size. (This button is enabled when 
the Zoom In and Zoom Out buttons are in use.)

Zoom In. Increases the magnification of the selected portion of the graph.

Zoom Out. Decreases the magnification of the selected portion of the graph.

Rotate Bottom Labels. Toggles between displaying the text on the x-axis 
vertically and horizontally.

Set 2D/3D Graph. Toggles the graph from two to three dimensions.

Copy Graph to Clipboard. Copies the graph to the Clipboard.

Print Graph. You can choose to print the graph in portrait or landscape view.
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8
Project Customization at a Glance

As a Quality Center project administrator, you use Project Customization to 
control access to a project by defining the users who can access the project 
and by determining the types of tasks each user can perform. You can also 
customize a project to meet the specific requirements of your testing team. 
Non-project administrators can also use Project Customization, however, 
the customization functions available are limited depending on the user 
group to which they belong.

Starting Project Customization 

You can customize your Quality Center projects using the Project 
Customization window.

Note: Users belonging to the Viewers group cannot view or change any 
settings in the Project Customization window.

You can also open the Project Customization window without logging in to 
a Quality Center project, if necessary. For more information, see “Starting 
Project Customization Without Logging In to a Project” on page 155.

This chapter describes: On page:

Starting Project Customization 151

Understanding the Project Customization Window 156
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To start project customization:

 1 Open your Web browser and type your Quality Center URL
http://<Quality Center server name>[<:port number>]/qcbin. The Quality Center 
Options window opens.

 2 Click the Quality Center link.

The first time you run Quality Center, files are downloaded to your 
workstation. Subsequently, Quality Center carries out a version check. If 
there is a newer version on the server, updated files are downloaded to your 
workstation. 

Note: To download files to your computer, you must log in with 
administrator privileges. This applies if you are running Quality Center for 
the first time, upgrading to a newer version, or applying a service pack.
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After the Quality Center version has been checked and files have been 
updated if necessary, the Quality Center Login window opens.

 3 In the Login Name box, type your user name. 

If you type a user name that does not have administrator privileges for a 
particular project, you are restricted to the customization functions available 
for that user group. For more information, see “About Managing User 
Groups and Permissions” on page 166.
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 4 In the Password box, type your password. 

After you log in to Quality Center, you can change your password from the 
Project Customization window. For more information, refer to the 
HP Quality Center User’s Guide. In addition, site administrators can change 
their password from Site Administration. For more information, see 
“Changing Passwords” on page 97.

 5 Select the Automatically log in to my last domain and project on this 
machine check box if you want Quality Center to automatically log in to the 
last project in which you were working.

 6 Click Authenticate. Quality Center verifies your user name and password 
and determines which domains and projects you may access. If you 
specified automatic login, Quality Center opens.

 7 In the Domain list, select a domain. By default, the last domain in which 
you were working is displayed.

 8 In the Project list, select a project. By default, the last project in which you 
were working is displayed.

 9 Click Login. Quality Center opens and displays the module (Releases, 
Requirements, Test Plan, Test Lab, and Defects) in which you last worked 
during your previous session.

 10 Choose Tools > Customize on the upper-right corner of the window. The 
Project Customization window opens and displays the customization 
functions available for the user group to which the user belongs. For more 
information, see “Understanding the Project Customization Window” on 
page 156.

 11 To exit the Project Customization window and return to your 
Quality Center project, click the Return button located on the upper-right 
corner of the window.
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Starting Project Customization Without Logging In to a 
Project
You can open the Project Customization window without logging in to a 
Quality Center project. This can be useful when a workflow script prevents 
you logging in to a project and you need to access Project Customization to 
fix the workflow script. You can only access the customization functions 
available for the user group to which you belong.

To start Project Customization without logging in to a project:

 1 Type the following URL in your Web browser: 

testdirector:[server name]:[port number]/qcbin,[domain],[project],
[username];13:[ignore_workflow_parameter]

 2 To bypass workflow events, set the value of ignore_workflow_parameter to 
“1”. Otherwise, workflow events are triggered. Only users belonging to the 
TDAdmin group can activate this option to bypass workflow events.

For example, suppose that you have user name alex_qc. You want to 
customize the project MyProject in the domain MyDomain on the server 
MyServer. To start Project Customization without triggering workflow 
events, type the following URL:

testdirector:MyServer:8080/qcbin,MyDomain,MyProject,alex_qc;13:1

 3 When the Quality Center Login window opens, type the password and click 
Authenticate.
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Understanding the Project Customization Window

As a Quality Center project administrator, you can customize a project to 
meet the specific requirements of your testing team in the Project 
Customization window.

The Project Customization window contains the following links:

➤ User Properties. Non-project administrators can use this option to change 
their user properties and password. For more information, refer to the 
HP Quality Center User’s Guide. 

In Site Administration, a site administrator can override and change a user’s 
properties and password from the Site Users tab. For more information, see 
“Updating User Details” on page 96, and “Changing Passwords” on page 97.

➤ Project Users. You can add and remove users from a Quality Center project. 
You can also assign users to user groups to restrict user access privileges. For 
more information, see Chapter 9, “Managing Users in a Project.”

Note that you create Quality Center users and define user properties from 
Site Administration. For more information, see Chapter 4, “Managing 
Quality Center Users.”



Chapter 8 • Project Customization at a Glance

157

➤ Groups. You can assign privileges to user groups by specifying permission 
settings. This includes specifying transition rules and hiding data. For more 
information, see Chapter 10, “Managing User Groups and Permissions.”

➤ Module Access. You can control the modules that each user group can 
access. By preventing users from accessing unnecessary modules, you can 
better utilize your Quality Center licenses. For more information, see 
“Customizing Module Access for User Groups” on page 194.

➤ Project Entities. You can customize your Quality Center project to suit your 
testing environment. A project can contain system fields and user-defined 
fields. System fields can be modified. User-defined fields can be added, 
modified, and deleted. For more information, see “Customizing Project 
Entities” on page 199.

➤ Requirement Types. You can add requirement types to your Quality Center 
project and define which fields are available and which fields are required 
for each requirement type. For more information, see “Customizing Project 
Requirement Types” on page 208.

➤ Risk-Based Quality Management. You can customize criteria and criterion 
values for risk-based testing, and customize default testing efforts and 
testing levels. For more information, see Chapter 13, “Customizing Risk-
Based Quality Management.”

➤ Project Lists. You can add customized field lists to a project. A field list 
contains values that the user can enter in system or user-defined fields. For 
more information, see “Customizing Project Lists” on page 213.

➤ Automail. You can set up automatic mail notification rules to inform users 
via e-mail about defect repair activity. For more information, see 
Chapter 12, “Configuring Automail.”

➤ Alert Rules. You can activate alert rules for your project. This instructs 
Quality Center to create alerts and send e-mail when changes occur in the 
project. For more information, see Chapter 14, “Setting Alert Rules.”

➤ Workflow. You can generate scripts to perform commonly needed 
customizations on the fields of the Defects module dialog boxes. For more 
information, see Chapter 15, “Generating Workflow Scripts.”

➤ In addition, you can write scripts to customize dialog boxes in any module, 
and to control the actions that users can perform. For more information, see 
Chapter 16, “Workflow Customization at a Glance.”
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9
Managing Users in a Project

As a Quality Center project administrator, you can control access to a 
project by defining the users who can log in to the project and by specifying 
the types of tasks each user may perform.

About Managing Users in a Project

For each Quality Center project, you must select a list of valid users from the 
overall Quality Center users list. (The users list is created in Site 
Administration. For more information, see Chapter 4, “Managing 
Quality Center Users.”) 

You then need to assign each project user to a user group. Each group has 
access to certain Quality Center tasks. 

This chapter describes: On page:
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Adding a User to a Project 160

Assigning Users to a User Group 162

Removing a User from a Project 164
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Adding a User to a Project 

You add new users to a Quality Center project.

To add a user to a project:

 1 In the Project Customization window, click the Project Users link. The 
Project Users page opens.

You can click the User Name column to change the sort order from 
ascending to descending user names. You can also click the Full Name 
column to sort according to full names instead of user names.
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 2 Click the Add User button. The Add User to Project dialog box opens.

 3 Add users to the project using one of the following options:

➤ To add an existing user by user name, select Add user by user name and 
type the user name. Click OK.

➤ To create a new user in the Site Users list and add the user to the project, 
select Create new user and click OK. In the New User dialog box, type the 
details for the new user and click OK. If this option is not available, you 
can enable it by setting the ADD_NEW_USERS_FROM_PROJECT 
parameter in Site Administration. For more information, see 
“ADD_NEW_USERS_FROM_ PROJECT” on page 126.

➤ To add existing users from the Site Users list, select Add user from list of 
site users and click OK. In the Add User to Project dialog box that opens, 
select the users you want to add to the project and click OK.

The users are added to the Project Users list and the user details are 
displayed. User details are defined in Site Administration. For more 
information, see “Updating User Details” on page 96.

 4 Click Save to save your changes to the Project Users page.
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Assigning Users to a User Group 

After you add a user to the project, you can assign the user to one or more 
user groups. By default, new users are assigned to the project as members of 
the Viewer user group. You can assign a user to a default user group, or to a 
customized user group. For more information on customizing a user group, 
see Chapter 10, “Managing User Groups and Permissions.” You can change 
the access privileges for existing users at any time by changing the user 
group to which they are assigned.

To assign a user to a user group:

 1 In the Project Customization window, click the Project Users link. The 
Project Users page opens.

 2 In the Project Users list, select the user you want to assign to a user group. 
The user properties are displayed (name, e-mail, phone, and description). 

The e-mail information is important as it enables a user to receive defects, 
tests, requirements, and test set notifications directly to their mailbox.
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The user details are defined in Site Administration. For more information, 
see “Updating User Details” on page 96.

 3 To assign the selected user to a user group, click a user group name in the 
Not Member Of list and click the left arrow button.

 4 To remove the user from the currently selected user group, click a user group 
name in the Member Of list and click the right arrow button. 

Note: The Member of list can never be empty. A user must always belong to 
at least one user group.

 5 To move all the user groups from one list to the other, click the double arrow 
buttons.

 6 Click Save to save your changes to the Project Users page.
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Removing a User from a Project 

To ensure the security of a project, remove any users who are no longer 
working on the project. Removing a user from a project does not delete the 
user from the Quality Center users list in Site Administration.

To remove a user from a project:

 1 In the Project Customization window, click the Project Users link. The 
Project Users page opens.

 2 In the Project Users list, select the user you want to remove and click the 
Remove User button.

 3 Click OK to confirm. The user is removed from the Project Users list.

 4 Click Save to save your changes to the Project Users page.
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Managing User Groups and Permissions

You can control access to Quality Center projects and modules by defining 
the user groups that can enter them, and by determining the types of tasks 
each user group performs.

This chapter describes: On page:

About Managing User Groups and Permissions 166

Adding User Groups 168

Setting User Group Permissions 169

Setting Transition Rules 173

Hiding Data for a User Group 176

Assigning Existing Sets of Permissions to User Groups 179

Renaming User Groups 179

Deleting User Groups 180

Understanding the Permission Settings Tasks 180

Customizing Module Access for User Groups 194
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About Managing User Groups and Permissions

To enable team members to do their jobs and protect a project from 
unauthorized access, Quality Center lets you assign each member to a 
specific user group. Quality Center includes predefined user groups with 
default privileges. Each group has access to certain Quality Center tasks.

User Group Permissions

TDAdmin (Project 
Administrator)

Group members have full privileges in a Quality Center 
project and in Project Customization.

Project Manager ➤ Group members have full privileges in the following 
modules: Releases, Requirements, Test Plan, Test Lab, 
and Defects. 

➤ In Project Customization, the group has privileges to 
change user properties and password, customize project 
lists, and set alert rules.

QATester ➤ Group members have full privileges in the following 
modules: Releases, Requirements, Test Plan, and Test 
Lab. 

➤ In the Defects module, the group can add and modify 
defects and defect links. 

➤ In Project Customization, the group has privileges to 
change user properties and password, customize project 
lists, and set alert rules.
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When a project requires that certain user groups have privileges that are 
outside the scope of their default permissions, you can add your own 
customized user groups and assign each group a unique set of privileges.

After you set user group permissions, you can also define the Quality Center 
modules to which you want to give a user group access. When a user group 
member logs in to a project, only the authorized modules are displayed.

Developer ➤ Group members have full privileges in the Releases 
module.

➤ Group members are limited to modifying attachments 
or specified record fields in the following 
Quality Center modules: Requirements, Test Plan, and 
Test Lab. 

➤ In the Defects module, the group can add and modify 
defects, and add defect links.

➤ In Project Customization, the group has privileges to 
change user properties and password.

Viewer ➤ Group members have read-only privileges in a 
Quality Center project.

➤ In Project Customization, the group has privileges to 
change user properties and password.

User Group Permissions
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Adding User Groups

If you determine that the default user groups do not meet the needs of your 
project, you can create additional user groups for your project.

To add a user group:

 1 In the Project Customization window, click the Groups link. The Groups 
page opens.

 2 Click the New button. The New Group dialog box opens.
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 3 In the Name box, type a name for the group.

 4 In the Create As list, assign the new group the privileges of an existing user 
group. 

Tip: Choose an existing user group that has similar access privileges to the 
new user group you want to create. This minimizes the level of 
customization you need to do.

 5 Click OK. 

 6 Click Yes to confirm. The new group name is added to the Groups list in the 
Groups page.

 7 Click Save to save your changes to the Groups page.

Setting User Group Permissions

Every user group has a set of privileges, or permissions, which are defined by 
the Quality Center project administrator. You generally set the permissions 
for custom user groups at the beginning of the project, but you can modify a 
user group’s permissions at any time. 

For example, suppose a group of users called DOC has Viewer permissions. 
In order to work more effectively on the project, they need to add, modify, 
and delete defects. As the Quality Center project administrator, you can 
assign these privileges to the DOC group by specifying permission settings.

Note: You cannot modify the privileges of a default user group. To view 
permissions for a default user group, in the Groups page, select the user 
group in the Groups list and click the View button. For more information, 
see “Understanding the Permission Settings Tasks” on page 180.
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To set user group permissions:

 1 In the Project Customization window, click the Groups link. The Groups 
page opens.

 2 In the Groups list, choose the user group for which you want to set 
permissions. 

 3 Click the Change button. The Permission Settings dialog box opens.
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 4 Click a permission tab. For example, click Defects. The tab displays the tasks 
available in the Defects module. 

 5 Select the tasks that the selected user group can use. For more information 
on the available tasks, see “Understanding the Permission Settings Tasks” on 
page 180.

 6 When you select a task with a sublevel, a list of associated fields appears 
below. Select the check boxes of the fields that the selected user group can 
use.

 7 To limit the capabilities of modifying a field, do any of the following:

➤ To ensure that only the person who originally created the entry can 
change that value, select Can be modified by owner only. For more 
information, see the following section, “Owning Quality Center 
Objects”.

➤ To limit the values a user group can select from a lookup list type field, 
set transition rules of permissible field values. For more information, see 
“Setting Transition Rules” on page 173.
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 8 For deleting tasks, you can ensure that only the person who originally 
created the entry can delete the value by selecting Can be deleted by owner 
only. For more information, see the following section, “Owning 
Quality Center Objects”.

 9 You can click the Data-Hiding Filter link to hide data from the current user 
group in the Requirements, Test Plan, Test Lab, and Defects modules. For 
more information, see “Hiding Data for a User Group” on page 176.

 10 Click OK to close the Permission Settings dialog box.

 11 Click Save to save your changes to the Groups page.

Owning Quality Center Objects
When setting group permissions, you can limit the capabilities of modifying 
or deleting a field value, so that only the person who originally created the 
entry can change or delete the value. The following table describes the 
objects in Quality Center and the users that are defined as the default 
owners of the objects.

Note: You can change the owner of a Quality Center object by modifying 
the value of TB_OWNER_FIELD_NAME in the Tables table. For more 
information on the Tables table, refer to the HP Quality Center Database 
Reference.

Quality Center Object Owner

Requirement The Author field (RQ_REQ_AUTHOR).

Test in the Test Plan module The Designer field (TS_RESPONSIBLE).

Test in the Test Lab module The Responsible Tester field 
(TC_TESTER_NAME).

Test run in the Test Lab 
module

The Tester field (RN_TESTER_NAME).

Defect The Assigned To field (BG_RESPONSIBLE).
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Setting Transition Rules 

You can limit a group’s modifying privileges by setting transition rules for 
modifying values in fields. These rules determine the values that the group 
can modify in fields that you specify. Note that transition rules can be set 
only for lookup and user list fields.

For example, when modifying defect information, you can limit the items a 
user group can select in the Status field of a defect record. You can set a 
transition rule that only allows a user group to edit the Status field from 
“Fixed” to “Closed”.

Note: When Workflow has been used to change a list of values for a field 
that is set with transition rules, the field may only be modified in a way that 
satisfies both the workflow script and the transition rules. For more 
information, see Chapter 18, “Workflow Event Reference.”

To set transition rules:

 1 In the Project Customization window, click the Groups link. The Groups 
page opens.

 2 In the Groups list, choose the user group for which you want to set 
permissions. 

 3 Click the Change button. The Permission Settings dialog box opens.

 4 Click a permission tab. For example, click Defects. The tab displays the tasks 
available in the Defects module.

 5 Select a task. For example, select Modify Defect. The task expands and lists 
available fields.

For more information on the available tasks, see “Understanding the 
Permission Settings Tasks” on page 180.
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 6 Under the selected task, select a field. For example, select Status. The 
Transition Rules grid appears on the right pane of the Permission Settings 
dialog box. 

 7 Click Add to add a transition rule. The Transition Rules Editor dialog box 
opens. 
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 8 Under From, you can: 

➤ Select $ANY to allow a user group to modify the field, irrespective of the 
currently displayed value. 

➤ Select a value from the list. A user group is able to modify the selected 
field only when the field displays the value you select. For example, to 
allow a user group to edit the Status field of a defect only if “Fixed” is the 
current value, select Fixed.

 9 Under To, you can:

➤ Select $ANY to allow a user group to change the field to any value. 

➤ Select a value from the list. A user group is able to change the value of the 
selected field to only the value that you specify. For example, to allow a 
user group to change the value of the Status field only to “Closed”, select 
Closed.

 10 Click OK to save and close the Transition Rules Editor dialog box. The new 
rules are displayed in the Transition Rules grid. 

 11 To modify a transition rule, select a rule from the Transition Rules grid and 
click the Edit button. In the Transition Rules Editor dialog box, modify the 
rule. Click OK.

 12 To delete a transition rule, select a rule from the Transition Rules grid and 
click the Delete button. Click OK to confirm.

 13 Click OK to close the Permission Settings dialog box.

 14 Click Save to save your changes to the Groups page.
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Hiding Data for a User Group 

You can instruct Quality Center to hide specific records that a user group 
can view in the Requirements, Test Plan, Test Lab, and Defects modules. This 
includes the following options:

➤ Filtering Data. You can set filters for specific fields, limiting the records that 
the user group can view. For example, you can set the filter for the field 
Assigned To to “[CurrentUser]”. This instructs Quality Center to allow only 
the current user to view specific records that are assigned to him or her.

For more information on filtering, refer to the HP Quality Center User’s Guide. 

➤ Defining Visible Fields. You can select which fields in a module the user 
group can see and which should be hidden. This can help in simplifying the 
volume of data displayed. Users belonging to a specific user group need to 
view only data that relates to their work. For example, in the Test Plan tab, 
you may want to hide the Path field from user groups that should not be 
able to access test scripts from the file system. Note that you cannot hide 
required fields.

To hide data:

 1 In the Project Customization window, click the Groups link. The Groups 
page opens.

 2 In the Groups list, choose the user group for which you want to set 
permissions. 

 3 Click the Change button. The Permission Settings dialog box opens.

 4 Click a permission tab. For example, click Defects. The tab displays the tasks 
available in the Defects module.



Chapter 10 • Managing User Groups and Permissions

177

 5 Click the Data-Hiding Filter link located at the bottom left corner of the 
dialog box. For example, in the Defects tab, click the Defects Data-Hiding 
Filter. The Defects Data-Hiding Filter dialog box opens and displays the 
Filter tab.

 6 Set one or more filters. The filter set determines the records that a user group 
can view in Quality Center. For more information, refer to the 
HP Quality Center User’s Guide.
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 7 Click the Visible Fields tab. 

 8 Select or clear the appropriate fields.

 9 Click OK to close the Data-Hiding Filter dialog box.

 10 Click OK to close the Permission Settings dialog box.

 11 Click Save to save your changes to the Groups page.



Chapter 10 • Managing User Groups and Permissions

179

Assigning Existing Sets of Permissions to User Groups

During the course of a project, you can assign one user group another user 
group’s permissions.

To assign an existing set of permissions to a user group:

 1 In the Project Customization window, click the Groups link. The Groups 
page opens.

 2 In the Groups list, select a group name. 

 3 Click the Set As button. The Set Group As dialog box opens. 

 4 In the Set As list, select a group name.

 5 Click OK.

Renaming User Groups

You can rename a user group. Note that all customization performed on the 
group remains.

To rename a user group:

 1 In the Project Customization window, click the Groups link. The Groups 
page opens.

 2 In the Groups list, select a group name. 

 3 Click the Rename button. The Rename Group dialog box opens.

 4 Type a new name for the group.

 5 Click OK to save your changes.
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Deleting User Groups

You can delete user groups that were added to a Quality Center project.

To delete a user group:

 1 In the Project Customization window, click the Groups link. The Groups 
page opens.

 2 In the Groups list, select a group name. 

 3 Click the Delete button.

 4 Click OK to confirm.

Understanding the Permission Settings Tasks

You can display the permissions of user groups in the Permission Settings 
dialog box. You can modify the permissions of custom user groups at any 
time. You cannot modify the permissions of the default user groups 
(TDAdmin, QATester, Project Manager, Developer, and Viewer). 

To display permissions for a custom user group, in the Groups page, select 
the user group in the Groups list, and click the View or Change button. For a 
default user group, click the View button. The Permission Settings dialog 
box opens. 

The Permission Settings dialog box contains the following tabs: Releases, 
Requirements, Test Plan, Test Lab, Defects, Analysis, and Administration. If 
you use HP Business Process Testing, refer to the HP Business Process Testing 
Module User’s Guide.
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Releases Tasks
The Releases tab displays the tasks available in the Releases module.

The Releases tab includes the following tasks:

Task Description

Add Release User group can add releases to release folders in the 
releases tree. By default, the user group can also 
modify releases.

Modify Release User group can modify releases in release folders. 
This task enables you to specify the fields that the 
selected user group can modify. 

Delete Release User group can delete releases and cycles from the 
releases tree. 

Add Release Folder User group can add release folders to the releases 
tree. By default, the user group can also modify 
release folders.
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Requirements Tasks
The Requirements tab displays the tasks available in the Requirements 
module.

Modify Release Folder User group can modify release folders in the releases 
tree. This task enables you to specify the fields that 
the selected user group can modify. 

Delete Release Folder User group can delete release folders, releases, and 
cycles from the releases tree. 

Add Cycle User group can add cycles to the releases tree. By 
default, the user group can also modify cycles.

Modify Cycle User group can modify cycles in the releases tree. 
This task enables you to specify the fields that the 
selected user group can modify. 

Delete Cycle User group can delete cycles from the releases tree. 

Task Description
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The Requirements tab includes the following tasks:

Task Description

Add Requirement User group can add requirements to the 
requirements tree.

Modify Requirement User group can modify requirements in the 
requirements tree. Note that this task enables you to 
specify the fields that the selected user group can 
modify. To ensure that only the owner of the 
requirement can modify it, click the Can be 
modified by owner only check box.

Delete Requirement User group can delete requirements from the 
requirements tree. To ensure that only the owner of 
the requirement can delete it, click the Can be 
deleted by owner only check box.

Add Tests to Coverage User group can add tests coverage to a requirement 
and requirements coverage to a test.

Remove Tests from 
Coverage

User group can remove tests coverage from a 
requirement and requirements coverage from a test.

Add Requirement 
Traceability

User group can add traceability links to a 
requirement.

Modify Requirement 
Traceability

User group can modify traceability links for a 
requirement. Note that this task enables you to 
specify whether the user group can modify the 
comment for a traceability link. To ensure that only 
the owner of the requirement can modify the 
traceability link, click the Can be modified by 
owner only check box.
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Remove Requirement 
Traceability

User group can remove traceability links from a 
requirement. To ensure that only the owner of the 
requirement can remove the traceability link, click 
the Can be removed by owner only check box.

Risk-Based Quality 
Management

Enables you to specify permission settings for the 
following risk-based quality management tasks:

➤ Assess Business Criticality. User group can assess 
the Business Criticality and override calculated 
analysis results of a requirement.

➤ Assess Failure Probability. User group can assess 
the Failure Probability and override calculated 
analysis results of a requirement.

➤ Analyze. User group can perform risk-based 
quality management analysis on a requirement 
and its children.

For more information on risk-based quality 
management, see the HP Quality Center User’s Guide.

Task Description
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Test Plan Tasks
The Test Plan tab displays the tasks available in the Test Plan module. 
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The Test Plan tab includes the following tasks:

Task Description

Add Test User group can add tests to the test plan tree. 

Modify Test User group can modify tests in the test plan tree. 
Note that this task enables you to specify the fields 
that the selected user group can modify. To ensure 
that only the owner of the test can modify it, click 
the Can be modified by owner only check box.

Delete Test User group can delete tests from the test plan tree. 
To ensure that only the owner of the test can delete 
it, click the Can be deleted by owner only check 
box.

Add Design Step User group can add design steps in the Design Steps 
tab. 

Modify Design Step User group can modify design steps in the Design 
Steps tab. Note that this task enables you to specify 
the fields that the selected user group can modify. 

Delete Design Step User group can delete design steps from the Design 
Steps tab. To ensure that only the owner of the 
design step can delete it, click the Can be deleted by 
owner only check box.

Add Folder User group can add folders to the test plan tree.

Modify Folder User group can modify folders in the test plan tree. 
Note that this task enables you to specify the fields 
that the selected user group can modify. 

Delete Folder User group can delete folders from the test plan tree.

Move Folder User group can move folders in the test plan tree.

Copy Folder User group can copy folders in the test plan tree.

Generate Script User group can convert the test steps of a manual 
test, displayed in the Design Steps tab, into an 
automated test.
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Test Lab Tasks
The Test Lab tab displays the tasks available in the Test Lab module.

The Test Lab tab includes the following tasks:

Task Description

Add Test Set User group can add test sets. 

Modify Test Set User group can modify test sets. Note that this task 
enables you to specify the fields that the selected 
user group can modify.

Delete Test Set User group can delete test sets. 

Move Test Set User group can move test sets to different folders in 
the test sets tree.

Copy Test Set User group can copy test sets to folders in the test 
sets tree.

Add Folder User group can add folders to the test sets tree.
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Modify Folder User group can modify folders in the test sets tree. 
Note that this task enables you to specify the fields 
that the selected user group can modify.

Delete Folder User group can delete folders in the test sets tree.

Move Folder User group can move folders in the test sets tree.

Copy Folder User group can copy folders in the test sets tree.

Add Tests to Test Set User group can add tests to a test set.

Modify Test in Test Set User group can modify tests in a test set. Note that 
this task enables you to specify the fields that the 
selected user group can modify. To ensure that only 
the owner of the test set can modify it, click the Can 
be modified by owner only check box.

Remove Test from Test Set User group can remove tests from a test set. 

Run Test User group can run tests. 

Modify Run User group can modify test run information. Note 
that this task enables you to specify the fields that 
the selected user group can modify. To ensure that 
only the owner of the run can modify it, click the 
Can be modified by owner only check box. 

Delete Run User group can delete test run information. To 
ensure that only the owner of the run can delete it, 
click the Can be deleted by owner only check box.

Reset Test Set User group can clear all runs in a test set. 

Add Hosts User group can add hosts for running tests.

Modify Hosts User group can modify host information.

Delete Hosts User group can delete hosts.

Add Host Group User group can add host groups for running tests.

Modify Host Group User group can modify host group information.

Delete Host Group User group can delete host groups.

Task Description
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Defects Tasks
The Defects tab displays the tasks available in the Defects module.

The Defects tab includes the following tasks:

Task Description

Add Defect User group can add defects to the Defects Grid. Note 
that you can customize the fields that appear in the 
Add Defect dialog box. Under Visible Fields in Add 
Defect Dialog Box, select the fields you want to be 
visible. Fields that are marked in red are mandatory 
if they are visible.

Modify Defect User group can modify defects in the Defects Grid. 
Note that this task enables you to specify the fields 
that the selected user group can modify. To ensure 
that only the owner of the defect can modify it, 
click the Can be modified by owner only check box.
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Analysis Tasks
The Analysis tab displays the tasks available in the Analysis module.

Delete Defect User group can delete defects from the Defects Grid. 
To ensure that only the owner of the defect can 
delete it, click the Can be deleted by owner only 
check box.

Add Defect Link User group can add defect links to the 
Quality Center entities.

Modify Defect Link User group can modify defect links. This task 
enables you to specify the fields that the selected 
user group can modify. To ensure that only the 
owner of the defect link can modify it, click the Can 
be modified by owner only check box.

Remove Defect Link User group can remove defect links from the 
Quality Center entities. To ensure that only the 
owner of the defect link can remove it, click the Can 
be removed by owner only check box.

Task Description
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The Analysis tab includes the following tasks:

Administration Tasks
The Administration tab displays the administrative tasks available in 
Quality Center.

Task Description

Design Excel Report User group can design Excel reports from the 
Analysis module.

Generate Excel Report User group can generate Excel reports from the 
Analysis module. If a user does not have Design 
Excel Report permissions, the Query, Post-
processing, and Generation Settings tabs in the 
Analysis module are not visible, and the settings in 
the General tab cannot be modified.
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The Administration tab includes the following tasks:

Task Description

Add Public Favorite Views User group can add public favorite views. 

Modify Public Favorite 
Views

User group can modify public favorite views.

Delete Public Favorite Views User group can delete public favorite views.

Add Private Favorite Views User group can add private favorite views.

Modify Private Favorite 
Views

User group can modify private favorite views.

Delete Private Favorite 
Views

User group can delete private favorite views.

Clear History User group can clear the information displayed in 
the History table. For instructions on clearing 
history, refer to the HP Quality Center User’s Guide.

Change User Properties & 
Password

User group can change their properties and 
password, using the User Properties link in the 
Project Customization window.

Set Up Project Users User group can add and remove users from a 
Quality Center project, using the Project Users link 
in the Project Customization window.

Set Up Groups User group can assign privileges to user groups and 
specify permission settings, using the Groups link in 
the Project Customization window.

Customize Module Access User group can decide the type of access a user 
group can have for Quality Center, using the 
Module Access link in the Project Customization 
window.

Customize Project Entities User group can customize fields in a Quality Center 
project, using the Project Entities link in the Project 
Customization window. 

Customize Requirement 
Types

User group can customize requirement types in a 
Quality Center project, using the Requirement 
Types link in the Project Customization window.
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Customize Risk-Based 
Quality Management

User group can customize criteria and default 
settings for risk-based testing using the Risk-Based 
Quality Management link in the Project 
Customization window.

Customize Project Lists User group can add their own customized lists to a 
project, using the Project Lists link in the Project 
Customization window.

Configure Automail User group can set up a mailing configuration to 
routinely inform users about defect repair activity, 
using the Automail link in the Project 
Customization window.

Set Up Alert Rules User group can set up alert rules, using the Alert 
Rules link in the Project Customization window.

Set Up Workflow User group can write and/or generate scripts that 
dynamically change the user interface in the 
Quality Center modules, using the Workflow link in 
the Project Customization window.

Task Description
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Customizing Module Access for User Groups 

For each Quality Center project, you can control the modules that each user 
group can access. By preventing users from accessing unnecessary modules, 
you can better utilize your Quality Center licenses. For example, if a user 
group uses Quality Center only to add defects to a project, you can limit the 
group’s access to the Defects module only.

You can specify module access for a user group as follows:

➤ the Defects module only

➤ all Quality Center modules excluding the Business Components module

➤ all Quality Center modules including the Business Components module

Note: If access to the Business Components module is not enabled for a user 
group, those users can still view existing business process tests in read-only 
mode. For more information, refer to the HP Business Process Testing Module 
User’s Guide.

You can monitor how many users are currently connected to a project, the 
time the users first logged in to the project, the time of the last action, and 
the type of access. For more information, see “Monitoring User 
Connections” on page 106. You can also determine the total number of 
Quality Center licenses in use. For more information, see “Managing 
Quality Center Licenses” on page 109.
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To customize module access for user groups:

 1 In the Project Customization window, click the Module Access link. The 
Module Access page opens.

The  icon indicates the modules that the user group can access.

To select or clear a cell in the table, double-click the cell, or select the cell 
and press the space bar.

 2 To select the Defects module only, select the Defects Module column. This 
clears the Quality Center column and the Business Process Testing column.

 3 To select the Quality Center modules, select the Quality Center column. 
This clears the Defects Module column.

 4 To select the Business Components module, select the Business Process 
Testing column. This selects the Quality Center column and clears the 
Defects Module column.

 5 Click Save to save your changes.
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11
Customizing Quality Center Projects 

As a Quality Center project administrator, you can customize a project to 
meet the specific needs of your testing team. For example, you can add or 
customize fields, customize requirement types, and create categories and 
lists that reflect the needs of your testing project.

About Customizing Quality Center Projects

Before you begin a project, you can customize your project to reflect your 
unique testing requirements. As a project progresses, you can further adjust 
the project to meet its changing needs.

Quality Center contains system fields in which you enter information about 
a requirement, test, test step, test set, test run, or defect. You can modify the 
behavior of these fields by restricting users to selecting values only from 
associated lists, by making entry in certain fields mandatory, and by 
preserving a history of values entered in the field. In addition, you can 
include data unique to your project by creating user-defined fields. You can 
associate these fields with Quality Center system and user-defined lists.

This chapter describes: On page:

About Customizing Quality Center Projects 197

Customizing Project Entities 199

Customizing Project Requirement Types 208

Customizing Project Lists 213
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For example, if you are running tests on several builds of an application, you 
can add a Detected in Build field to the Add Defect dialog box. You can then 
create a selection list containing the values Build1, Build2, and Build3, and 
associate the list with the Detected in Build field.

In the Requirements module, you can also assign each requirement to a 
requirement type. A requirement type defines which fields are available and 
which fields are required for a requirement of that type. This enables you to 
make available for a requirement only the fields relevant to the type to 
which it is assigned.
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Customizing Project Entities 

Using the Project Entities page, you can customize your Quality Center 
project to suit your testing environment. 

Each Quality Center project is divided into project entities. Entities contain 
data entered by users for a specific testing process and the data is stored in 
tables.
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The following entities are available:

Each entity contains system fields and user-defined fields:

➤ System fields. These are Quality Center default fields. You cannot add or 
delete system fields, you can only modify them.

➤ User fields. These are fields that you can define and include in a 
Quality Center project to customize for your specific project needs. You can 
add, modify, and delete user-defined fields. 

For detailed information on Quality Center entities and fields, refer to the 
HP Quality Center Database Reference.

Entity Description

Cycle Cycle data in the Releases module.

Defect Defect data in the Defects module.

Release Release data in the Releases module.

Release Folder Release folder data in the Releases module.

Requirement Requirement data in the Requirements module.

Run Test run data in the Test Lab module.

Test Test data in the Test Plan module.

Test Instance Test instance data in the Test Lab module.

Test Set Test set data in the Test Lab module.

Test Step Design step data in the Test Plan module, and test step 
data in the Test Lab module.
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The Field Settings section displays the field properties. The following 
properties are available:

Properties Description

Field Name Indicates the field name used in the Quality Center 
database table. 

Field Label Indicates the field name as it is displayed in 
Quality Center. You can type a new name or use the 
default name.

Field Type Specifies the type of data that the user can enter in the 
field. It includes the following types:

➤ Number. Enables integer entry only.

➤ String. Enables the entry of any character string.

➤ Date. Enables the selection of a date.

➤ Lookup List. Displays the Lookup List area and enables 
the selection from a drop-down list. 

➤ User List. Enables the selection of a user name from 
your Quality Center users list.

➤ Memo. Enables the entry of blocks of data. Note that 
you can add up to 5 memo fields to each 
Quality Center entity.

Field Length Indicates the field size. (Available only when the String 
type is selected.) 

Note: The maximum field length is 255 characters.

History Preserves a log of values entered in the selected field.

Required Indicates that a user must enter a value for the field.

Note: If you set a field as required in a project that 
already contains data, users do not need to enter a value 
for the field when they modify an existing record if the 
field is already empty.

Masked Indicates the input data mask for the field. (Available 
only when the String type is selected.) For more 
information, see “Defining Input Masks” on page 205.
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Searchable Indicates a searchable field. (Available only when the 
Text Search option is enabled in the DB Servers tab. For 
more information, see “Defining Searchable Fields” on 
page 124.)

Lookup List Includes a list of predefined lists. (Available only when 
the Lookup List type is selected.) To associate a field with 
a predefined list, select a list from the Lookup List box. To 
view or modify the selected list, click the Goto List 
button.

New List Creates a new list. (Available only when the Lookup List 
type is selected.) To associate a field with a new list, click 
the New List button. The Project Lists dialog box opens. 
For more information on customizing a list, see 
“Customizing Project Lists” on page 213. 

Goto List Displays a predefined list. (Available only when the 
Lookup List type is selected.) To open a predefined list, 
select a list from the Lookup List box. Click the Goto List 
button. The Project Lists dialog box opens. For more 
information on customizing a list, see “Customizing 
Project Lists” on page 213. 

Properties Description
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Adding User-Defined Fields
You can customize a Quality Center project by adding up to 99 user-defined 
fields to each Quality Center entity. 

To add a user-defined field:

 1 In the Project Customization window, click the Project Entities link. The 
Project Entities page opens.

 2 Under Project Entities, expand an entity.

 3 Click the User Fields folder.

Verify Value Limits the user to select a value only from the items that 
are listed in the list box. (Available only when the 
Lookup List type is selected.)

Allow Multiple Values For user-defined fields, this option allows the user to 
select more than one value in any field that is associated 
with a predefined lookup list. (It is only available when 
the Lookup List type is selected.) 

For example, if you create a Language user field in the 
Defect entity and enable the Allow Multiple Values 
option, a user can select English, French, and German 
language values at the same time when entering this 
field’s value.

Note: 

➤ This option is not available in the TEST STEP entity. 

➤ If you group a data grid or summary graph by a field 
containing multiple values, the information in each 
value is grouped as its entire value. This value is the 
category for grouping. For example, a value with 
English and French is grouped once as English;French, 
and not as part of separate English and French 
categories. 

For more information on customizing a list, see 
“Customizing Project Lists” on page 213.

Properties Description
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 4 To add a user-defined field, you can:

➤ Click the New Field button to add a number, string, date, or list type 
field.

➤ Click the New Field arrow and choose New Memo Field to add a memo 
field. You can add up to 5 memo fields to each Quality Center entity. 

 5 In the Field Settings section, set properties for the field. For more 
information, see the “Field Settings” section on page 201.

 6 Click Save to save your changes to the Project Entities page.

Modifying System and User-Defined Fields
You can modify the properties of system and user-defined fields in your 
Quality Center project.

Note: You can modify only the following properties for system fields: Field 
Label, History, Required, and Verify Value. For more information, see the 
“Field Settings” section on page 201.

To modify a system or user-defined field:

 1 In the Project Customization window, click the Project Entities link. The 
Project Entities page opens.

 2 Under Project Entities, expand an entity.

 3 Expand the System Fields folder or the User Fields folder.

 4 Click the field that you want to customize. The settings for that field appear 
under Field Settings.

 5 Modify the properties for the selected field. For more information, see the 
“Field Settings” section on page 201.

 6 Click Save to save your changes to the Project Entities page.
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Deleting User-Defined Fields
You can delete user-defined fields from your Quality Center project.

To delete a user-defined field:

 1 In the Project Customization window, click the Project Entities link. The 
Project Entities page opens.

 2 Under Project Entities, expand an entity.

 3 Expand the User Fields folder.

 4 Click the field that you want to delete and click the Remove Field button. 

 5 Click OK to confirm. The field is removed from the User Fields folder.

 6 Click Save to save your changes to the Project Entities page.

Defining Input Masks
The input mask option is used to prompt users for data input using a mask 
pattern. If the user attempts to enter a character that conflicts with the 
input mask, an error occurs. For example, to prompt the user to enter a 
phone number, you can define the following input mask:

!\(000\)000-0000

This input mask limits the user to numeric characters only. It is displayed in 
an edit box as follows:

(___) ___ - ____

Note: You can define input masks for string type fields only.
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To define an input mask:

 1 In the Field Settings section, select Masked. For more information, see the 
“Field Settings” section on page 201.

 2 Under Masked Edit Attributes, click the Define button. The Input Mask 
Editor dialog box opens.

 3 In the Input Mask box, type an input mask or select a predefined mask. 

You can use the following characters when defining input masks:

Mask 
Character

Description

! A space for a leading or trailing blank.

# A digit.

. A decimal. 

: A time separator. 

/ A date separator.

\ Treats the next character in the mask string as a literal. For 
example, you can include the (, ), #, &, A, and ? characters in the 
mask.

> Converts all the characters that follow to uppercase.
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 4 In the Test Input box, you can test the input mask.

 5 Click OK to close the Input Mask Editor dialog box.

 6 Click Save to save your changes to the Project Entities page.

< Converts all the characters that follow to lowercase.

A An alphanumeric character (entry required). For example: a – z, 
A – Z, or 0 – 9.

a An alphanumeric character (entry optional). For example: a – z, 
A – Z, or 0 – 9.

C A character (entry required). Valid values are ANSI characters in 
the following ranges: 32-126 and 128-255.

c A character (entry optional). Valid values are ANSI characters in 
the following ranges: 32-126 and 128-255.

L An alphabetic character or space (entry required). For example: a 
– z or A – Z.

l An alphabetic character or space (entry optional). For example: a 
– z or A – Z.

0 A digit (entry required). For example: 0 – 9.

9 A digit (entry optional). For example: 0 – 9.

_ Inserts spaces. When the user types characters in the field box, 
the cursor skips the _ character.

Mask 
Character

Description
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Customizing Project Requirement Types

Using the Requirement Types page, you can create requirement types for 
your project, and customize their properties.

You can assign each requirement in the Requirements module to a 
requirement type. A requirement type defines for requirements of the type 
which fields are optional, and which user-defined fields are available. This 
enables you to create user-defined fields specifically for a particular 
requirement type, that are only available for requirements of that type. 

For example, you might create a requirement type Security Requirement for 
requirements connected to security. You could then create a user-defined 
field Security Hazards containing a list of possible security hazards a 
requirement might cover. This field is not relevant for requirements of types 
other than Security Requirement, so you would not make it available for any 
type except for Security Requirement.
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Each requirement type has an associated icon, which is displayed next to 
the requirement in Requirements module tree views, enabling you to easily 
identify to which type a requirement belongs. In addition, for each 
requirement type you can determine whether test coverage and risk-based 
quality management are available.

Creating Requirement Types
You can create a requirement type.

Note: Quality Center provides the default requirement types Business, 
Folder, Functional, Group, Testing, and Undefined. For more information 
on these types, see the HP Quality Center User’s Guide.

To create a requirement type:

 1 In the Project Customization window, click the Requirement Types link. 
Requirement Types page opens.

 2 Click the New button. The New Type dialog box opens.

 3 In the Name box, type a name for the type.

 4 In the Create As list, assign the new type properties of an existing 
requirement type.

Tip: Choose an existing requirement type that has similar properties to the 
new type you want to create. This minimizes the level of customization you 
need to do.
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 5 Click OK. The New Type dialog box closes and the new type is added to the 
Types list.

 6 Click Save to save your changes to the Requirement Types page.

Customizing Requirement Types
You can customize a requirement type by changing its icon, determining 
whether requirements of the type can have test coverage and risk analysis, 
and defining which fields are available and which are required for 
requirements of the type.

To customize a requirement type:

 1 In the Project Customization window, click the Requirement Types link. 
The Requirement Types page opens.

 2 Under Types, select a requirement type.

 3 To change which icon is displayed next to requirements of the type in 
Requirements module tree views, under Properties, click the Replace 
button. The Change Image for Type dialog box opens displaying available 
icons for the type. Select an icon and click OK. The Change Image for Type 
dialog box closes and the icon is changed.

Note: You cannot change the icon for the default requirement types Folder 
and Group.

 4 Under Properties, in the Risk-Based Quality Management box, you can 
select whether to Perform Analysis or Perform Assessment for risk-based 
quality management on requirements of the type. You can select None if 
you do not want to enable risk-based quality management for requirements 
of the type. For more information on risk-based quality management, see 
the HP Quality Center User’s Guide.
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 5 Under Properties, in the Test Coverage box, you can select whether to 
enable adding test coverage to requirements of the type. The following 
options are available:

➤ Has Coverage. You can add test coverage to requirements of this type.

➤ None. You cannot add test coverage to requirements of this type.

Note: You cannot select the None option for a requirement type, if there are 
requirements of that type which already have test coverage. To clear the 
Testing Coverage check box for the type, you must either delete the 
requirements of that type with test coverage, remove the test coverage from 
those requirements, or change their type.

 6 Under User Fields, you can choose which user fields are available for 
requirements of the type, and which available fields are required:

➤ To determine which user-defined fields are available, select one or more 
fields from the Not In Type or In Type lists, and click the arrow buttons (> 
and <) to move the fields from one list to the other. You can click the 
double arrow buttons (>> and <<) to move all the fields from one list to 
the other. For more information on user-defined fields, see “Customizing 
Project Entities” on page 199.

➤ To make a user-defined field that is available for the type a required field, 
in the In Type list, select the check box in the Required column for the 
field.

 7 To make a system field a required field for the type, under System Fields, 
select the check box in the Required column for the field. Note that all 
system fields are automatically included in every type, and that some system 
fields cannot be set as optional.

 8 Click Save to save your changes to the Requirement Types page.
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Renaming Requirement Types
You can rename a requirement type.

To rename a requirement type:

 1 In the Project Customization window, click the Requirement Types link. 
The Requirement Types page opens.

 2 Under Types, select a requirement type.

 3 Click the Rename button. The Rename Type dialog box opens.

 4 Type a new name for the requirement type.

 5 Click OK to close the Rename Type dialog box. The requirement type’s name 
is updated.

 6 Click Save to save your changes to the Requirement Types page.

Deleting Requirement Types
You can delete a requirement type.

Notes: 

➤ You cannot delete the default requirement types Folder and Undefined.

➤ You cannot delete a type if there are requirements of the type in your 
project. To delete a type, you must first delete all requirements of the 
type, or change their types.

To delete a requirement type:

 1 In the Project Customization window, click the Requirement Types link. 
The Requirement Types page opens.

 2 Under Type, select a requirement type.

 3 Click the Delete button.

 4 Click OK to confirm. The requirement type is deleted.

 5 Click Save to save your changes to the Requirement Types page.
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Customizing Project Lists 

Using the Project Lists page, you can create, rename, and delete user-defined 
lists. 

A list contains items, which are values that you can enter in a field. For 
example, the selection list for the Languages user-defined field may contain 
the items English and European Languages. 

The list can also contain several levels of sub-items. For example, the item 
English can contain a sublist with the sub-items English (Australia), English 
(Canada), English (Great Britain), and English (US).
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You can allow the user to select more than one value from a list by enabling 
the Allow Multiple Values option for the relevant field in the Project Entities 
page. For more information, see “Allow Multiple Values” in the Field 
Settings table on page 203. 

Note: To associate a list with a field, see “Customizing Project Entities” on 
page 199.

Creating Lists
You can create a list to be assigned to one or more fields.

To create a list:

 1 In the Project Customization window, click the Project Lists link. The 
Project Lists page opens. 

 2 Click the New List button. The New List dialog box opens.

 3 Type a name for the new list (maximum length 255 characters) and click 
OK. The list name appears in the Lists box.

 4 To add an item to the new list or to an existing list, select the list name in 
the Lists box and click the New Item button. The New Item dialog box 
opens. Type a name for the item and click OK.

Note: You should not use a semi-colon (“;”) as part of any list item if the list 
is to be used in a multiple value field. For more information on multiple 
value fields, see “Allow Multiple Values” in the Field Settings table on page 
203.

 5 To create a sub-item, select an item in List Items and click the New Sub-Item 
button. The New Sub-Item dialog box opens. Type a name for the sub-item 
and click OK. 

 6 Click Save to save your changes to the Project Lists page. 
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Renaming Lists, Items, or Sub-Items
You can rename user-defined lists, and system and user-defined items or 
sub-items.

Note: You cannot change some system list items. For example, the Y and N 
in the YesNo list. For more information on system items that cannot be 
changed, refer to the Mercury Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 7165.

To rename a list: 

 1 In the Project Customization window, click the Project Lists link. The 
Project Lists page opens. 

 2 In the Lists box, select a list. 

 3 Click the Rename List button. The Rename List dialog box opens. 

 4 Type a new name for the list.

 5 Click OK to close the Rename List dialog box.

 6 Click Save to save your changes to the Project Lists page.

To rename an item or sub-item: 

 1 In the Project Customization window, click the Project Lists link. The 
Project Lists page opens. 

 2 In the Lists box, select a list. 

 3 Under List Items, select an item.

 4 Click the Rename Item button. The Rename List Item dialog box opens.

 5 Type a new name for the item. Click OK.

 6 Click Save to save your changes to the Project Lists page.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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Deleting Lists, Items, or Sub-Items
You can delete user-defined lists, and system and user-defined items or 
sub-items. 

Note: 

➤ You cannot delete a user-defined list that is being used as a lookup list for 
a field.

➤ You cannot delete some system list items. For example, the Y and N in 
the YesNo list. For more information on system items that cannot be 
deleted, refer to the Mercury Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 7165.

To delete a list: 

 1 In the Project Customization window, click the Project Lists link. The 
Project Lists page opens.

 2 In the Lists box, select a user-defined list name. 

 3 Click the Delete List button. 

 4 Click Yes to confirm. 

 5 Click Save to save your changes to the Project Lists page.

To delete an item or sub-item: 

 1 In the Project Customization window, click the Project Lists link. The 
Project Lists page opens. 

 2 In the Lists box, select a list name. 

 3 Under List Items, select a list item.

 4 Click the Delete Item button.

 5 Click Yes to confirm. 

 6 Click Save to save your changes to the Project Lists page. 

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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12
Configuring Automail

As a Quality Center project administrator, you can routinely inform your 
personnel about defect repair activity. You determine the conditions for 
sending defect messages to each recipient by defining a mailing 
configuration. 

About Setting Automail

Quality Center enables you to automatically notify users through e-mail 
each time changes are made to specified defect fields. Configuring mail for a 
Quality Center project involves the following steps:

➤ Click the Automail link to define the defect fields and specify the users and 
conditions. See “Designating Automail Fields” on page 219, and “Defining 
Automail Conditions” on page 220.

➤ In Site Administration’s Site Projects tab, enable the mail configuration for a 
project by selecting the Send mail automatically check box. Note that this 
check box must be selected for your mail configuration to work. For more 
information, see “Updating Project Details” on page 42.

This chapter describes: On page:

About Setting Automail 217

Designating Automail Fields 219

Defining Automail Conditions 220

Customizing the Subject of Defect Mail 222



Chapter 12 • Configuring Automail

218

➤ In Site Administration’s Site Configuration tab, you can edit the 
MAIL_INTERVAL parameter, which defines the time interval for sending 
defect e-mail in all projects. You can also set parameters to define the format 
and character set of mail, and whether attachments or history are included 
in the mail. For more information, see “Setting Quality Center 
Configuration Parameters” on page 126.

➤ You can customize the subject line of defect e-mail for all projects or for a 
specific project. For more information, see “Customizing the Subject of 
Defect Mail” on page 222.

➤ In Site Administration’s Site Users tab, make sure you have specified the 
e-mail addresses of the users who should receive defect messages. For more 
information, see “Updating User Details” on page 96.
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Designating Automail Fields

When you designate a field as a mail field, any changes made to that field 
cause Quality Center to send an e-mail message in the next time interval. 
For example, suppose you designate Status as a mail field and then update 
the Status field for a particular defect. In the next time interval, the details 
of the defect, including the updated status information, are sent to 
designated users.

To designate Automail fields:

 1 In the Project Customization window, click the Automail link. The Automail 
page opens.

Available Defect Fields contains the names of the fields that appear in the 
Defects Grid. Mail On Change Of contains the names of the fields currently 
assigned as mail fields.
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 2 Choose one or more fields and click the arrow buttons (> and <) to move the 
fields from one list to the other. Click the double arrow buttons (>> and <<) 
to move all the fields from one list to the other.

 3 Click Save to save your changes.

Defining Automail Conditions

Mail conditions determine when various users receive defect messages. For 
each user, you can define separate mail conditions. For example, you can 
specify that a user receives messages only for defects assigned an urgent 
priority.

To define Automail conditions:

 1 In the Project Customization window, click the Automail link. The Automail 
page opens.
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 2 Click the Condition tab.

 3 Choose a name from the Users list.

In addition, you can choose Detected By or Assigned To. Select these items 
to notify users when defects that they detected or are responsible for 
repairing are modified. 

 4 Select the All Defects check box to notify the selected user of every change 
to a defect.

 5 Alternatively, click the Condition button to define a filter under which the 
selected user receives mail. If you define multiple filters, the selected user 
only receives mail if all of the conditions are met. For more information on 
filtering, refer to the HP Quality Center User’s Guide.

 6 Click Save to save your changes.
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Customizing the Subject of Defect Mail

You can customize the subject line of defect e-mail sent automatically to 
users, for all projects or for a specific project. For example, you can define a 
subject line such as the following:

Defect # 4321 has been created or updated - Buttons on print dialog are not 
aligned

The line can contain the values of Quality Center fields. To include a field 
value from the defect that is being sent, prefix the field name with a 
question mark (?). Field names must be upper-case. For example:

Defect # ?BG_BUG_ID has been created or updated - ?BG_SUMMARY

To customize the subject of defect mail for all projects:

You can customize the subject line for all your projects by adding the 
AUTO_MAIL_SUBJECT_ FORMAT parameter in the Site Configuration tab. 
For more information, see “AUTO_MAIL_SUBJECT_ FORMAT” on page 131.

To customize the subject of defect mail for a specific project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, double-click the project for which you want to customize 
the e-mail subject line.

 3 Select the DATACONST table.

 4 In the SQL pane, type an SQL INSERT statement to insert a row into the 
table with the following values:

➤ In the DC_CONST_NAME column, insert the parameter name 
AUTO_MAIL_SUBJECT_FORMAT.

➤ In the DC_VALUE column, insert the strings and the names of fields to be 
placed in the subject line.

For example, type the following SQL statement into the SQL pane:

insert into dataconst values ('AUTO_MAIL_SUBJECT_FORMAT',
’DEFAULT.TESTPROJ - Defect # ?BG_BUG_ID has been created or updated - 
?BG_SUMMARY’)
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The subject line you define is specific to the project, so you can include the 
project name in the line.

For more information on modifying project tables, see “Querying Project 
Tables” on page 51.

 5 Click the Execute SQL button. The row is added to the DATACONST table to 
set the e-mail subject.
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13
Customizing Risk-Based Quality 
Management

This chapter describes how to customize the criteria used to determine the 
Business Criticality and Failure Probability of a requirement, and how to 
define the default values for constants used in risk-based quality 
management.

This chapter describes: On page:

About Customizing Risk-Based Quality Management 226

Customizing Risk-Based Quality Management Criteria 227

Customizing Risk-Based Quality Management Constants 233
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About Customizing Risk-Based Quality Management

You use risk-based quality management to determine at which Testing Level 
to test each requirement in the Requirements module. Quality Center then 
calculates the total estimated Testing Time for an analysis requirement based 
on the Testing Levels of its child assessment requirements. You compare this 
with the resources you have available to test the analysis requirement, and if 
necessary make adjustments to the Testing Levels for the requirement and 
its children. This enables you to plan the testing strategy for your 
requirements. For more information on risk-based quality management, see 
the HP Quality Center User’s Guide.

The Testing Level used to test a requirement is based on the requirement’s 
Business Criticality and Failure Probability. These factors together comprise 
the Risk Category for the requirement. You determine values for these 
factors by assigning values to a series of criteria associated with each factor. 
Each criterion has a number of possible values. You can customize these 
criteria and values and how Quality Center uses these to determine the 
Business Criticality and Failure Probability. For more information, see 
“Customizing Risk-Based Quality Management Criteria” on page 227.

You can also customize what Testing Time is associated by default with each 
Testing Level and Failure Probability. In addition, you can customize how 
Quality Center determines the Testing Level with which to test a 
requirement based on the requirement’s Business Criticality and Failure 
Probability. For more information, see “Customizing Risk-Based Quality 
Management Constants” on page 233.

In addition, you can customize for each requirement type whether 
requirements of the type enable risk assessment, risk analysis, or do not 
enable risk-based quality management. For more information, see 
“Customizing Requirement Types” on page 210.
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Customizing Risk-Based Quality Management Criteria

You can customize the criteria used to determine the Risk Category of a 
requirement, the possible values for each criterion and the weight assigned 
to each value. You can then define how the total of these weights 
determines the Risk Category. 

Note: If you already calculated the Risk Category for a requirement, 
modifying these criteria does not automatically recalculate the 
requirement’s Risk Category. To recalculate the Risk Category, you must 
reassess the requirement and change at least one of its criterion values.

Customizing Criteria and Values
You can customize the criteria, criterion values, and weights used by 
Quality Center to determine the Risk Category for each requirement.

Note: Quality Center provides a default set of criteria when you create a new 
project. You can delete these criteria if you do not want to use them.

To customize criteria and values:

 1 In the Project Customization window, click the Risk-Based Quality 
Management link. The Risk-Based Quality Management page opens.

 2 Click one of the following tabs:

➤ To customize criteria for determining Business Criticality, click the 
Business Criticality tab. 

➤ To customize criteria for determining Failure Probability, click the Failure 
Probability tab.
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The Business Criticality tab and Failure Probability tab display criteria used 
to determine Business Criticality and Failure Probability.

 3 To add a new criterion, select the Criterion list and click the New button. A 
new row is added to the end of the Criterion list. Type a name for the 
criterion in the new row.

 4 To add a description for a criterion, select the criterion from the Criterion 
list and type the description in the Description box. This description is 
displayed in the Risk tab of the Requirements module when a user assesses 
Business Criticality and Failure Probability. It is recommended that you 
provide a full description of each criterion, including an explanation of its 
available values, as this helps the user decide which value to assign to each 
criterion for a requirement. 
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 5 To add a value for a criterion, select the criterion from the Criterion list and 
select the Value list. Click the New button. A new row is added to the Value 
list. Type a name for the value in the new row.

Note: Each value for a criterion must be unique.

 6 To assign a weight to a criterion value, select the criterion from the Criterion 
list and then select the value from the Value list. In the Weight column for 
the value, type the weight to assign to the value.

When Quality Center calculates the Business Criticality or Failure 
Probability of a requirement, it checks the values assigned to each criterion 
and calculates the sum of the corresponding weights for each value. This 
sum determines the Business Criticality or Failure Probability. For more 
information, see “Customizing Weight Boundaries” on page 230.

 7 You can delete a criterion or a value for a criterion:

➤ To delete a criterion, select the criterion from the Criterion list and click 
the Delete button. The criterion is deleted

➤ To delete a criterion’s value, select the criterion from the Criterion list 
and the value from the Value list. Click the Delete button. The value is 
deleted.

Note: Business Criticality and Failure Probability must each have at least one 
associated criterion defined. In addition, each criterion must have at least 
one possible value.

 8 To change the order in which criteria are displayed in the Criterion list, 
select a criterion and click the Move Up or Move Down buttons. Note that 
values for a criterion are automatically ordered by their weights.

 9 Click Save to save your changes to the Risk-Based Quality Management 
page.
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Customizing Weight Boundaries
You can customize how Quality Center uses the values assigned to risk-based 
quality management criteria to determine the Business Criticality and 
Failure Probability for a requirement.

Customizing Weight Boundaries for Business Criticality

For each requirement, Quality Center calculates the total of the weights 
(TW) of the values assigned to each of the Business Criticality criteria. 
Quality Center then uses this total to categorize the Business Criticality of 
the requirement as either C- Nice to Have, B - Important, or A - Critical. 
Quality Center automatically calculates the highest and lowest possible total 
weight and uses these to define the upper boundary of the Critical category 
and the lower boundary of the Nice to Have category. You define the 
boundaries between the Nice to Have and Important categories, and 
between the Important and Critical categories.

For example, suppose there are two criteria for Business Criticality, each 
with three possible values whose weights are 20, 60, and 100. The minimum 
total weight is therefore 40 (if both criteria are assigned the value with 
weight 20) and the maximum total weight is 200 (if both criteria are 
assigned the value with weight 100). Quality Center automatically calculates 
these totals and uses them to determine the lower and upper boundaries for 
the categories. You determine the boundaries between the categories by 
typing 100 in the Nice to Have box and 160 in the Critical box.

In this example, Quality Center determines the Business Criticality for a 
requirement as follows:

➤ If the sum of the weights of each of the criteria for a requirement is less than 
or equal to 100, the requirement will have Nice to Have Business Criticality. 
This could happen, for example, if the criteria have values with weights 20 
and 60 so the total weight is 80.
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➤ If the sum is greater than 100 but less than 160, the requirement will have 
Important Business Criticality. This could happen, for example, if the criteria 
have values with weights 60 and 60 so the total weight is 120.

➤ If the sum is greater than or equal to 160, the requirement will have Critical 
Business Criticality. This could happen, for example, if the criteria have 
values with weights 100 and 60 so the total weight is 160.

To customize weight boundaries for Business Criticality:

 1 In the Project Customization window, click the Risk-Based Quality 
Management link. The Risk-Based Quality Management page opens.

 2 Click the Business Criticality tab. The Business Criticality tab displays criteria 
used to determine Business Criticality.

 3 Under Total Weight Boundaries between Business Criticality values, define 
the boundaries between different Business Criticality values. To define these 
boundaries, type the relevant values in the Nice to Have and Critical boxes.

 4 Click Save to save your changes to the Risk-Based Quality Management 
page.

Customizing Weight Boundaries for Failure Probability

For each requirement, Quality Center calculates the total of the weights 
(TW) of the values assigned to each of the Failure Probability criteria. 
Quality Center then uses this total to categorize the Probability of the 
requirement as either 3 - Low, 2 - Medium, or 1- High. Quality Center 
automatically calculates the highest and lowest possible total weight and 
uses these to define the upper boundary of the High category and the lower 
boundary of the Low category. You define the boundaries between the Low 
and Medium categories, and between the Medium and High categories.
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For example, suppose there are two criteria for Failure Probability, each with 
three possible values whose weights are 20, 60, and 100. The minimum total 
weight is therefore 40 (if both criteria are assigned the value with weight 20) 
and the maximum total weight is 200 (if both criteria are assigned the value 
with weight 100). Quality Center automatically calculates these totals and 
uses them to determine the lower and upper boundaries for the categories. 
You determine the boundaries between the categories by typing 100 in the 
Low box and 160 in the High box.

In this example, Quality Center determines the Failure Probability for a 
requirement as follows:

➤ If the sum of the weights of each of the criteria for a requirement is less than 
or equal to 100, the requirement will have Low Failure Probability. This 
could happen, for example, if the criteria have values with weights 20 and 
60 so the total weight is 80.

➤ If the sum is greater than 100 but less than 160, the requirement will have 
Medium Failure Probability. This could happen, for example, if the criteria 
have values with weights 60 and 60 so the total weight is 120.

➤ If the sum is greater than or equal to 160, the requirement will have High 
Failure Probability. This could happen, for example, if the criteria have 
values with weights 100 and 60 so the total weight is 160.

To customize weight boundaries for Failure Probability:

 1 In the Project Customization window, click the Risk-Based Quality 
Management link. The Risk-Based Quality Management page opens.

 2 Click the Failure Probability tab. The Failure Probability tab displays criteria 
used to determine Failure Probability.

 3 Under Total Weight Boundaries between Failure Probability values, define 
the boundaries between different Failure Probability values. To define these 
boundaries, type the relevant values in the Low and High boxes.

 4 Click Save to save your changes to the Risk-Based Quality Management 
page.
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Customizing Risk-Based Quality Management Constants

You can define the default estimated Testing Times required to test a 
requirement with each Failure Probability value at each Testing Level. You 
can also define the default Testing Level used with each Risk Category. If the 
user does not enter different values for a requirement in the Requirements 
module, Quality Center uses these default values when calculating the 
estimated Testing Time for the requirement during the risk analysis.

Note: Modifying these criteria does not automatically affect the results of 
existing risk analyses. To update the results of a risk analysis, you must 
perform the analysis again.

To customize risk-based quality management constants:

 1 In the Project Customization window, click the Risk-Based Quality 
Management link. The Risk-Based Quality Management page opens.
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 2 Click the Risk Constants tab. The Risk tab displays constants used by default 
when calculating the Testing Time and Testing Level for a requirement.

 3 In the Units used to measure Testing Effort box, select the unit of 
measurement that you want Quality Center to display when measuring 
Testing Time. The available units are Hours, Days, Weeks, and Months.

Note: If you change the units of measurement for a project, the Testing Time 
values are not updated automatically. For example, if a requirement has 
Testing Time 48 hours and you change the units of measurement from Hours 
to Days, the requirement has Testing Time 48 days and not 2 days.

 4 Under Testing Time (full) per Failure Probability, for each Failure Probability 
value, type the estimated time required to fully test a requirement with the 
Failure Probability value. The Calculated Testing Time grid is updated to 
reflect these changes.
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 5 Under Testing level, in the Partial and Basic boxes, type the default Testing 
Time required for partial testing and basic testing of a requirement. This 
should be expressed as a percentage of the time required for full testing. The 
Calculated Testing Time grid is updated to reflect these changes.

 6 In the Default Testing Policy grid, you can define the default Testing Level 
for testing a requirement with Risk Category. 

 7 To define the default Testing Levels, click the arrow next to the cell in the 
grid corresponding to a particular Business Criticality and Failure Probability 
value. Select a Testing Level from the available Testing Levels. The available 
Testing Levels are Full, Partial, Basic, and None. Next to each Testing Level, 
you can see the estimated resources needed to test a requirement at that 
level, based on the default Testing Times and Testing Levels you defined.

 8 Click Save to save your changes to the Risk-Based Quality Management 
page.
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14
Setting Alert Rules

As a Quality Center project administrator, you can activate alert rules for 
your project. This instructs Quality Center to create alerts and send e-mail to 
notify those responsible when changes occur in your project that may 
impact the testing process.

About Setting Alert Rules

You can keep track of your requirements, tests and defects as you perform 
your project testing process. When an entity changes, you can instruct 
Quality Center to notify those responsible for any associated entities.

The alert rules you can activate are based on the following associations you 
can create in Quality Center:

➤ You can associate a test in the test plan tree with a requirement. This is 
performed by creating requirements coverage in the Test Plan module, or by 
creating tests coverage in the Requirements module.

➤ You can link a test with a defect. This is performed by adding a defect during 
a manual test run.

➤ You can create traceability links between requirements in the Requirements 
module.

This chapter describes: On page:

About Setting Alert Rules 237

Setting Alert Rules 239
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After you have established associations in your project, you can then track 
changes using these associations. When an entity in your project changes, 
Quality Center alerts you of any associated entities that may be impacted by 
the change. 

Notification involves two steps. Quality Center flags the associated entity, 
which can be seen by all users, and then sends e-mail to the user responsible 
for the entity.

There are four alert rules you can activate:

For more information on alerts, refer to the HP Quality Center User’s Guide.

Rule Change Made Entities Flagged User Notified

1 Requirement has any 
change, excluding 
changes in the Direct 
Cover Status field and 
the risk-based quality 
management fields.

Tests covering the 
requirement

Test designer. Note that 
only the test designer can 
delete the alert.

2 Defect status changes 
to “Fixed”.

Test instances 
associated with the 
defect

Responsible tester for the 
test instance.

3 Test run status 
changes to “Passed”.

Defects linked to 
the test instance

User assigned the defect.

4 Requirement is 
deleted or has any 
change, excluding 
changes in the Direct 
Cover Status field and 
the risk-based quality 
management fields.

The requirement’s 
child requirements 
and traced to 
requirements 

Author of the requirement.
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Setting Alert Rules

You can activate four alert rules.

To set alert rules:

 1 In the Project Customization window, click the Alert Rules link. The Alert 
Rules page opens.

 2 Select Alert Associated Entity to activate a rule. This instructs Quality Center 
to flag the entity when the associated entity changes. 

 3 Select Send E-mail To to instruct Quality Center to send notification e-mail 
to the specified user when the associated entity changes.

 4 Click Save to save your changes.
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15
Generating Workflow Scripts

Quality Center provides script generators to enable you to perform 
commonly needed customizations on the Defects module dialog boxes.

For information on writing workflow scripts to customize the user interface 
and to control user actions in any Quality Center module, see Part III, 
“Workflow Customization”.

This chapter describes: On page:

About Generating Workflow Scripts 242

Customizing Defects Module Field Lists 243

Customizing Defects Module Dialog Boxes 246
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About Generating Workflow Scripts

The Workflow page provides links to script generators and a script editor. 
You can use the script generators to perform customizations on the input 
fields of the Defects module dialog boxes. You can use the script editor to 
create scripts to control the workflow in any Quality Center module.

To open the Workflow page, click the Workflow link in the Project 
Customization window. 

The Workflow page contains the following links:

➤ Script Generator - List Customization for Defects Module. Enables you to 
customize the field lists displayed for fields on the dialog boxes and in the 
Defects Grid of the Defects module. For more information, see 
“Customizing Defects Module Field Lists” on page 243.

➤ Script Generator - Add Defect Field Customization. Enables you to modify 
the appearance of the New Defect dialog box. For more information, see 
“Customizing Defects Module Dialog Boxes” on page 246.
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➤ Script Generator - Defect Details Field Customization. Enables you to 
modify the appearance of the Defect Details dialog box. For more 
information, see “Customizing Defects Module Dialog Boxes” on page 246.

➤ Script Editor. Enables you to write VBScript code to customize the 
Quality Center workflow in any module. You place your code in the 
appropriate Quality Center event so that the script is triggered when the 
relevant user action takes place. You can also use the script editor to modify 
scripts created by the script generators. For more information, see 
Chapter 16, “Workflow Customization at a Glance”.

Customizing Defects Module Field Lists

A field list is a list of values displayed in a drop-down list, from which the 
user can choose a value for the field.

You can specify that a different field list be used for a Defects module field, 
depending on the value of another field. For example, you can set the 
Detected in Versions list to change depending on the value in the Project 
field.

Note: This script generator can be used to customize field lists in the Defects 
module only.

To customize a field list, you must define the following rules:

➤ Primary/Secondary Rule. Select the primary and secondary fields. When a 
primary field value is changed, the list of values in the secondary field 
changes automatically. For example, you could select Project as the primary 
field and Detected in Versions as the secondary field.

➤ List Match Rule. Select the list that you want to display in the secondary 
field for each value of the primary field.
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Note: When workflow customization has been used to change a list of 
values for a field that has transition rules defined, the field may only be 
modified in a way that satisfies both the workflow script and the transition 
rules. For more information, see “Setting Transition Rules” on page 173.

To customize a field list:

 1 In the Project Customization window, click the Workflow link. The 
Workflow page opens.

 2 Click the Script Generator - List Customization for Defects Module link. The 
Script Generator - List Customization dialog box opens. 
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 3 Under Primary/Secondary Rule, select the primary field and the secondary 
field:

➤ To set a rule, click <select primary> and select a field name. Click <select 
secondary> and select a field name.

➤ To add a new rule, click the Add Primary/Secondary Rule button. Select 
field names for <select primary> and <select secondary>.

➤ To delete a rule, select the rule and click the Delete Primary/Secondary 
Rule button. Click Yes to confirm.

 4 Under Primary/Secondary Rule, select the primary/secondary rule for which 
you want to set list match rules.
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 5 Under List Match Rule, select the field list to be used in the secondary field 
for specific values entered into the primary field:

➤ To set a rule for a defined primary field value, click <select list> and select 
a list name. 

➤ To set a rule for an undefined primary field value, click <enter value> and 
type a primary field value. Press Enter. Click <select list> and select a list 
name. 

➤ To add a new list match rule, click the Add List Match Rule button. Click 
<enter value> and type a primary field value. Click <select list> and select 
a list name. 

➤ To delete a list match rule, select the rule and click the Delete List Match 
Rule button. Click Yes to confirm.

 6 To save your changes, do one of the following:

➤ Click the Apply Script Changes button to save your changes and close 
the script generator.

➤ Click the Apply & View button to save your changes and view the 
generated script in the Script Editor. 

If you use the Script Editor to modify a script that was created by a script 
generator, your modifications are overwritten the next time you run that 
script generator. It is recommended that you rename the generated script 
before you modify it. For more information on the Script Editor, see 
Chapter 17, “Working with the Workflow Script Editor”.

Customizing Defects Module Dialog Boxes

You can modify the appearance of the New Defect and Defect Details dialog 
boxes by setting different fields to be visible for each user group. You can 
also sort the order in which the fields are displayed on the dialog box for 
each user group.

For example, you may want the Assigned To and Priority fields to appear 
only for a user that has developer privileges. Also, you can customize the 
Assigned To field so that it is displayed before the Priority field for this user 
group.
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To perform a customization for all user groups, you can use the script editor 
to write a script. For more information, see “Example: Customizing a Defects 
Module Dialog Box” on page 307.

Note: These script generators can be used to customize dialog boxes in the 
Defects module only.

To customize Defects module dialog boxes by user group:

 1 In the Project Customization window, click the Workflow link. The 
Workflow page opens.

 2 To modify the appearance of the New Defect dialog box, click the Script 
Generator - Add Defect Field Customization link. The Script Generator - Add 
Defect Field Customization dialog box opens.
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To modify the appearance of the Defect Details dialog box, click the Script 
Generator - Defect Details Field Customization link. The Script Generator - 
Defect Details Field Customization dialog box opens. 

Available Fields contains the names of all the fields you can display. Visible 
Fields contains the names of the fields that can currently be seen by the 
selected user group, and their sorting priority. 

 3 From the User Group list, select the user group to which the customizations 
are to apply.

 4 Choose field names and click the arrow buttons (> and <) to move a name 
between Available Fields and Visible Fields. Click the double arrow buttons 
(>> and <<) to move all the names from one list to the other. You can also 
drag the field names between lists.

 5 In Visible Fields, to set a field as a required field, select the check box next to 
it. For a required field, a value is mandatory. Its title is displayed in red in 
the Add Defect or Defect Details dialog box.
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 6 You can set the order in which fields are displayed for the selected user 
group by using the up and down arrows. You can also drag the field names 
up or down.

 7 You can set the Add Defect and Defect Details dialog boxes to include one or 
more input pages. By default, all fields are displayed on one page. Use the up 
and down arrows to move fields to the appropriate page.

 8 To save your changes, do one of the following:

➤ Click the Apply Script Changes button to save your changes and close 
the script generator.

➤ Click the Apply & View button to save your changes and view the 
generated script in the Script Editor.

If you use the Script Editor to modify a script that was created by a script 
generator, your modifications are overwritten the next time you run that 
script generator. It is recommended that you rename the generated script 
before you modify it. For more information on the Script Editor, see 
Chapter 17, “Working with the Workflow Script Editor”.
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16
Workflow Customization at a Glance

You can write workflow scripts to customize the Quality Center user 
interface, and to control the actions that users can perform.

To customize workflow:

 1 In the Project Customization window, click the Workflow link. The 
Workflow page opens.
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 2 To perform commonly-needed customization of a Defects module dialog 
box, click the appropriate Script Generator link on the Workflow page. You 
need not be familiar with VBScript, or with Quality Center events and 
objects to use this feature. For more information, see Chapter 15, 
“Generating Workflow Scripts”.

 3 To write or modify scripts by entering code into the appropriate event 
procedures, open the Script Editor. To create workflow scripts, you must be 
familiar with VBScript. You can open the Script Editor either from a script 
generator or directly:

➤ To write a script that is similar to a script created by a script generator, 
click the relevant Script Generator link and set the customization you 
want to perform. Click the Apply & View button on the script generator 
dialog box. The Script Editor opens to display the scripts that were 
generated.

➤ To create your own scripts, click the Script Editor link. The Script Editor 
opens to display a Scripts Tree that lists the existing event procedures.

For more information on the Script Editor, see Chapter 17, “Working with 
the Workflow Script Editor”.

 4 Decide which Quality Center event should trigger your script. You must 
place your code in the procedure of the appropriate module and event so 
that it is invoked for the relevant user action. For more information, see 
Chapter 18, “Workflow Event Reference”.

 5 Decide which Quality Center objects your script must access. Your script 
performs customizations based on information obtained from the relevant 
objects. You customize the workflow by using the methods and properties of 
the objects. For more information, see Chapter 19, “Workflow Object and 
Property Reference”.
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 6 Examine the sample scripts to find one that can be adapted for your use. 
Sample scripts are provided in this guide and in the Mercury Support 
Knowledge Base. Scripts generated by the workflow script generators can 
also be used as a basis for your scripts.

➤ For examples of common customizations that can be performed by using 
workflow scripts, see Chapter 20, “Workflow Examples”.

➤ For an index to Knowledge Base articles that provide examples of 
workflow scripts, refer to the Mercury Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 29497.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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17
Working with the Workflow Script Editor

You can use the Script Editor to create workflow scripts to customize the user 
interface, and to control user actions.

About Working with the Workflow Script Editor

You can use the Script Editor to create workflow scripts and to add a toolbar 
button to the window of a Quality Center module.

The Script Editor dialog box contains two tabs:

➤ Script Editor tab. You use the Script Editor tab to create and edit workflow 
scripts. The Script Editor assists you in placing your code in the appropriate 
Quality Center event procedure. For more information on using the Script 
Editor, see “Creating a Workflow Script” on page 261.

➤ Toolbar Button Editor tab. You use the Toolbar Button Editor tab to add a 
toolbar button to the window of a Quality Center module. For more 
information, see “Adding a Button to a Toolbar” on page 264.

This chapter describes: On page:

About Working with the Workflow Script Editor 257

The Script Editor 258

Creating a Workflow Script 261

Adding a Button to a Toolbar 264

Setting the Properties of the Script Editor 267
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The Script Editor

You can use the Script Editor to modify scripts that have been generated by a 
script generator, or to create a user-defined workflow script. For information 
on opening the Script Editor, see Chapter 16, “Workflow Customization at a 
Glance”. 

The Script Editor tab contains the following elements:

➤ Script Editor toolbar. Contains buttons used when creating scripts. For more 
information, see “Understanding the Script Editor Commands” on 
page 259.

➤ Scripts Tree. Lists the event procedures to which you can add code. The 
event procedures are grouped by the module in which they are triggered. For 
more information, see Chapter 18, “Workflow Event Reference”.

➤ Scripts pane. Displays the code of the selected event procedure. To create or 
modify a script, you add VBScript code to the event procedure. For more 
information, see “Creating a Workflow Script” on page 261.
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➤ Messages pane. Displays any syntax errors encountered when you save or 
validate a script.

Understanding the Script Editor Commands
The Script Editor toolbar, menu bar, and right-click menu contain the 
following buttons and menu commands:

Save. Saves the changes made to scripts in the selected module.

Print. Prints the displayed script.

Undo. Reverses the last command or deletes the last entry you typed.

Redo. Reverses the action of your last Undo command.

Cut. Removes the selected text and places it on the Clipboard.

Copy. Copies the selected text to the Clipboard.

Paste. Inserts the contents of the Clipboard at the insertion point.

Delete. Deletes the selected text.

Find. Searches for specified text in the scripts of the selected module.

Find Next. Finds the next occurrence of the text specified in the Find Text 
dialog box.

Replace. Replaces the specified text with replacement text.

Synchronize Tree with Script. Refreshes the Scripts Tree to reflect procedures 
you have added, deleted or renamed.

Field Names. Displays a list of field names in the project that you can insert 
into your script.

Code Complete. Displays a list of objects, properties, methods, or field 
names that you can insert into your script.

Code Template. Displays a list of templates for commonly used VBScript 
statements that you can insert into your script.
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List Value. Opens the Select Value From List dialog box, to enable you to 
choose an item from a project list.

Syntax Check. Validates the syntax of your script and displays any messages 
in the Messages pane.

Show/Hide Scripts Tree. Displays or hides the Scripts Tree. If you have 
opened the Script Editor from a script generator, this is not available.

Show/Hide Messages Pane. Displays or hides the Messages pane.

Properties. Opens the Properties dialog box, enabling you to change the 
properties of the Script Editor. For more information, see “Setting the 
Properties of the Script Editor” on page 267.

Save All. To save script changes in all modules, choose File > Save All.

Revert to Saved. To return to a saved version of a module, select a changed 
module and choose File > Revert to Saved.

Select All. To select all text in the scripts pane, choose Edit > Select All.

Expand All. To expand all nodes in the Scripts Tree, choose View > Expand 
All.

Collapse All. To collapse all nodes in the Scripts Tree, choose View > Collapse 
All.

Go to Line Number. To jump to a specific line in the Script Editor, choose 
Search > Go to Line Number.

Clear Messages. To clear syntax messages displayed in the messages pane, 
choose Tools > Clear Messages.

Sort Field Names by Field Labels. When you choose the Field Names option, 
the Script Editor sorts the list by the field name used in the Quality Center 
database table (for example, BG_BUG_ID). To sort the fields by the field label 
(for example, Defect ID) right-click the script pane and choose Sort Field 
Names by Field Labels.

VBScript Home Page. To get help for the VBScript language, choose Help > 
VBScript Home Page.



Chapter 17 • Working with the Workflow Script Editor

261

Creating a Workflow Script

You use the Script Editor to add VBScript code to a Quality Center event 
procedure, or to create user-defined procedures that can be called from a 
Quality Center event procedure.

To create a workflow script:

 1 Click the Script Editor link on the Workflow window. The Script Editor 
opens.

For more information on the Script Editor window, see “The Script Editor” 
on page 258.

 2 Select a module name in the Modules list box to expand the node of the 
module for which you need to customize the workflow.
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The Scripts Tree contains the Common script node in addition to the nodes 
for specific modules. When you create user-defined procedures that must be 
accessible from several modules, place them under the Common script 
node. To declare a global variable that can be used across all modules, 
declare the variable under the Common script node, outside of any 
function.

 3 In the Events list box, select the event procedure to which you need to add 
code, depending on when you want your code to be triggered. The existing 
script for this event procedure is displayed in the Scripts pane.

For a description of Quality Center event procedures, see Chapter 18, 
“Workflow Event Reference”.

 4 Add your VBScript code to the script.

Note: A red indicator  next to a module name in the Scripts Tree indicates 
that there are unsaved script changes in that module.

 5 To use the code complete feature instead of typing in the names of 
Quality Center objects, properties, methods, and fields, place the insertion 
point at the location where you want to insert an object name and click the 
Code Complete button. For information about Quality Center objects, see 
Chapter 19, “Workflow Object and Property Reference”.

 6 To use the code template feature instead of typing in commonly used 
VBScript statements, place the insertion point where you want to insert the 
code and click the Code Template button. Choose one of the following 
items from the code template list:

Template Code Added to Script

FVal: Fields value access Fields.Field("").Value

List: Quality Center list access Lists.List()

IfAct: Action “switch” If Block If ActionName = "" Then

End IF

Act: Actions access Actions.Action("")
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 7 To insert an item from a field list defined in the project, place the insertion 
point at the location where you want to add the item. Click the List Value 
button. In the Lists box of the Select Value From List dialog box, choose the 
name of the list. In the List Items box, select the list value.

 8 To insert a Quality Center field name, place the insertion point at the 
location where you want to add the field name. Click the Field Names 
button. Select a name from the list of system and user-defined fields in the 
Quality Center project.

 9 To validate the syntax of the script, click Syntax Check. Any messages are 
displayed in the Messages pane.

 10 Click the Save button to save the script.

 11 Close the Script Editor.

Func: Function template Function
On Error Resume Next

On Error GoTo 0
End Function

Sub: Sub Template Sub
On Error Resume Next

On Error GoTo 0
End Sub

Err: Error Handler On Error Resume Next

Template Code Added to Script
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Adding a Button to a Toolbar

You can use the Toolbar Button Editor to define a toolbar button to be 
displayed on the window of a Quality Center module, or on the Manual 
Runner dialog box.

To add a button to a toolbar:

 1 In the Script Editor, click the Toolbar Button Editor tab.
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 2 From the Command bar list, select the toolbar to which you want to add a 
button:

 3 Click Add. A default command name for the button is added to the 
Commands list.

 4 In the Caption box, type a new command name for the button, or use the 
default name.

 5 In the Hint box, type a tooltip for the button.

 6 In the Action Name box, type a new action name for the button, or use the 
default name.

 7 Under Images, select an icon for the button.

 8 Click Apply to apply your changes.

 9 To delete a button that you have created, select its command name in the 
Commands list, and click Remove.

 10 Click the Save button to save the new button definition.

 11 Click the Script Editor tab.

 12 In the Scripts Tree of the Script Editor, select the _ActionCanExecute event 
procedure for the module you selected from the Command bar list.

Option Toolbar Location

Requirements Requirements module window

TestPlan Test Plan module window

TestLab Test Lab module window

ManualRun Manual Runner dialog box

Defects Defects module window
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 13 In the procedure displayed in the scripts pane of the Script Editor, add 
statements to be performed if the user initiates an action with the action 
name you defined for the button. Set the return value to True or False.

For example, the following code opens a message box when the user clicks 
the Requirements_Action1 button on the tool bar of the Requirements 
module:

Function ActionCanExecute(ActionName)
On Error Resume Next
ActionCanExecute = True

If ActionName = "Requirements_Action1" Then
MsgBox "You clicked the Action1 button." 

End If
On Error GoTo 0

End Function

For more information, see “Example: Adding Button Functionality” on 
page 321.

 14 Click the Save button to save the script.
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Setting the Properties of the Script Editor

You can customize the behavior of the Script Editor.

To set the properties of the Script Editor:

 1 In the Script Editor, click the Properties button or choose Options > Editor 
Properties. The Properties dialog box opens.

 2 In the Editor tab, you can set the following options:

Option Description

Auto indent mode Places the cursor under the first non-blank character 
of the preceding non-blank line when you press 
Enter.

Smart tab Tabs to the first non-blank character in the 
preceding non-blank line. If Use tab character is 
selected, this option is cleared.
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Use tab character Inserts a tab character. If cleared, inserts space 
characters. If Smart tab is selected, this option is 
cleared.

Backspace unindents Aligns the insertion point to the previous 
indentation level when you press Backspace, if the 
cursor is on the first non-blank character of a line.

Show line numbers Displays line numbers. If this option is selected, 
Show line numbers on gutter is enabled.

Show line numbers on 
gutter

Displays line numbers in the gutter instead of in the 
left margin. If Show line numbers is selected, this 
option is enabled.

Group undo Reverses your last editing command and any 
subsequent editing commands of the same type, if 
you press Alt+Backspace or choose Edit > Undo.

Cursor beyond EOF Enables you to place the insertion point after the 
last line of code.

Cursor beyond EOL Enables you to position the cursor after the end of 
the line.

Selection beyond EOL Enables you to select characters beyond the end of 
the line.

Keep trailing blanks Keeps any blank spaces you have at the end of a 
line.

Persistent blocks Keeps marked blocks selected, even when the cursor 
is moved using the arrow keys, until a new block is 
selected.

Overwrite blocks Replaces a marked block of text with new text. If 
Persistent Blocks is also selected, text you enter is 
appended following the currently selected block.

Double click line Highlights the line when you double-click any 
character in the line. If disabled, only the selected 
word is highlighted.

Option Description
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 3 In the Display tab, you can set the following options:

Find text at cursor Places the text at the cursor into the Text To Find list 
box in the Find Text dialog box when you choose 
Search > Find. 

Force cut and copy 
enabled

Enables the Cut and Copy commands, even when 
there is no text selected.

Use syntax highlight Displays script elements according to colors and 
attributes defined in the Display tab and Colors tab. 

Overwrite cursor as block Controls the appearance of the caret when using 
the Overwrite mode. 

Disable dragging Disables dragging and dropping text.

Block indent Specifies the number of spaces to indent a marked 
block.

Tab stops Specifies the locations to which the cursor moves 
when you press Tab.

Keymapping Sets the keyboard mappings in the Script Editor. 
Supports the following keyboard mappings: Default, 
Classic, Brief, Epsilon, and Visual Studio.

Option Description

Editor gutter Enables you to set the visibility, width, color, and 
style of the gutter.

Editor margin Enables you to set the visibility, width, color, style, 
and position of the right margin.

Use mono font Displays only monospaced screen fonts, such as 
Courier, in the Editor font box.

Editor font Lists the available text fonts.

Editor color Lists the available background colors. 

Size Lists font sizes.

Option Description
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 4 In the Colors tab, you can set the following options:

Use Read-Only Color Enables you to select a color for displaying 
read-only text from the Read-Only Color box.

Draw Special Symbols Sets special characters for displaying end-of-file, 
end-of-line, space, and tab characters.

Option Description

Color SpeedSetting Enables you to configure the Script Editor display 
using predefined color combinations.

Element Specifies syntax highlighting for a particular code 
element.

Foreground color Sets the foreground color for the selected code 
element.

Background color Sets the background color for the selected code 
element.

Use defaults for Displays the code element using default system 
colors for the foreground, background, or both.

Text attributes Specifies format attributes for the code element.

Open Loads a color scheme from your computer.

Save Saves a color scheme to your computer.

Option Description
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18
Workflow Event Reference

You can write workflow scripts to customize the actions that Quality Center 
users can perform, and the fields that are available to users in dialog boxes. 
To write a workflow script, you add VBScript code to event procedures that 
are triggered by user actions.

About Quality Center Events

During a Quality Center user session, as the user initiates various actions, 
Quality Center triggers event procedures. You can place code in these 
procedures to customize the execution of the associated user actions.

The Script Editor lists the event procedures for each Quality Center module, 
and allows you to add your code to the appropriate procedure. For more 
information, see Chapter 17, “Working with the Workflow Script Editor”.

The code you add to the event procedures can access Quality Center objects. 
For more information, see Chapter 19, “Workflow Object and Property 
Reference”.

This chapter describes: On page:

About Quality Center Events 271

Naming Conventions for Quality Center Event Procedures 273

Reference for Quality Center Events 274
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Event procedures can be functions or subroutines:

➤ Event functions. These procedures are triggered by Quality Center to check 
whether the user’s action should be performed. You can place code in these 
functions to determine whether Quality Center may execute the user’s 
request. If your code returns a value of False, Quality Center does not 
proceed with the action.

For example, when a user clicks the Submit button on the Add Defect dialog 
box, Quality Center invokes the function Bug_CanPost before posting the 
defect to the database on the server. You can add code to the Bug_CanPost 
function to control whether Quality Center posts the defect. For example, 
you can ensure that a user cannot reject a defect without adding a 
comment. For example, see “Example: Object Validation” on page 315.

➤ Event subroutines. These procedures are triggered to perform actions when 
an event takes place. 

For example, when a user opens the Add Defect dialog box, Quality Center 
invokes the subroutine Bug_New. You can add code to the Bug_New 
subroutine to perform actions that should be performed when a user opens 
the dialog box. For example, you can change the value of the Detection 
Mode field to BTW if the user is not in the QA Tester user group. For 
example, see “Example: Changing a Field Based on the User Group” on 
page 314.
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Naming Conventions for Quality Center Event Procedures

The naming convention for an event procedure is as follows:

<entity>_<event>

Note that some event procedure names do not include an entity name.

Notes: 

➤ For backwards compatibility, the previous naming convention including 
the module name is still supported.

➤ You cannot access global variables from the Manual Runner event 
procedures. A workaround for passing a value to or from Manual Runner 
is to use the Settings object. For example, see “Example: Storing the Last 
Values Entered” on page 327.

Entity
Entity can be one of the following:

Entity Description

Req Requirement data

Test Test data

DesignStep Design step data

TestSet Test set data

TestSetTests Test instance data

Run Test run data

Bug Defect data

Step Test run step data
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Event
The Event can be either a function name or a subroutine name. The event 
names are listed in “Reference for Quality Center Events” on page 274.

Reference for Quality Center Events

This section contains an alphabetical reference of the Quality Center event 
functions and subroutines. It includes the event name, description, syntax, 
type (Function or Sub), the value returned by a function, and the entities for 
which the event procedure is available.

For information on the naming conventions for event procedures, see 
“Naming Conventions for Quality Center Event Procedures” on page 273.

The following event functions are available:

Function Name When the Function is Triggered

“ActionCanExecute” on page 276 before performing a user action

“Attachment_CanDelete” on 
page 277

before deleting an attachment 

“Attachment_CanOpen” on page 278 before opening an attachment

“Attachment_CanPost” on page 278 before posting an attachment

“CanAddTests” on page 279 before adding tests to a test set

“CanCustomize” on page 279 before opening Customization window

“CanDelete” on page 280 before deleting an object from the server

“CanLogin” on page 281 before a user logs in to the project

“CanLogout” on page 281 before a user logs out of the project

“CanPost” on page 282 before posting an object to the server

“CanRemoveTests” on page 282 before removing tests from a test set

“DefaultRes” on page 283 before resetting project defaults

“FieldCanChange” on page 285 before changing a field value
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The following event subroutines are available:

“GetDetailsPageName” on page 287 before displaying Defect Details dialog 
box

“GetNewBugPageName” on page 287 before displaying Add Defect dialog box

Subroutine Name When the Subroutine is Triggered

“AfterPost” on page 277 an object has been posted to the server

“Attachment_New” on page 279 an attachment is added

“DialogBox” on page 283 a dialog box is opened or closed

“EnterModule” on page 284 user switches modules

“ExitModule” on page 284 user exits a module

“FieldChange” on page 286 a field value changes

“MoveTo” on page 288 user changes focus

“MoveToFolder” on page 288 user clicks a folder in the test sets tree

“MoveToSubject” on page 289 user clicks a subject in the test plan tree

“New” on page 289 an object is added

“RunTests” on page 290 user clicks Run in the Test Lab module

“RunTestSet” on page 291 user clicks Run Test Set in the Test Lab 
module

“RunTestsManually” on page 291 user clicks Run > Run Manually in the 
Test Lab module

Function Name When the Function is Triggered
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ActionCanExecute
This event is triggered before Quality Center performs an action that has 
been initiated by the user, to check whether the action can be executed.

You can add code to this event procedure to perform actions when the user 
has initiated a particular action, or to prevent the action from being 
executed in specific cases. For example, see “Example: Controlling User 
Permissions” on page 320.

Syntax ActionCanExecute(ActionName)

where ActionName is the action that the user has initiated

Type Function

Returns True or False

Availability ActionCanExecute
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AfterPost
This event is triggered after an object has been posted to the server.

Project fields should not be changed after they have been posted, because 
then the new value is not stored in the database.

Attachment_CanDelete
This event is triggered before Quality Center deletes an attachment from the 
server, to check whether that attachment can be deleted.

Syntax <entity>_AfterPost

Type Sub

Availability ➤ Req_AfterPost
➤ Test_AfterPost
➤ TestSet_AfterPost
➤ Bug_AfterPost
➤ Step_AfterPost
➤ Run_AfterPost

Syntax Attachment_CanDelete(Attachment)

where Attachment is the IAttachment interface. For more 
information, refer to the HP Quality Center Open Test Architecture 
API Reference.

Type Function

Returns True or False

Availability Attachment_CanDelete
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Attachment_CanOpen
This event is triggered before Quality Center opens an attachment from the 
server, to check whether the attachment can be opened.

Attachment_CanPost
This event is triggered before Quality Center posts an attachment to the 
server, to check whether the attachment can be posted.

Syntax Attachment_CanOpen(Attachment)

where Attachment is the lAttachment interface. For more 
information, refer to the HP Quality Center Open Test Architecture 
API Reference.

Type Function

Returns True or False

Availability Attachment_CanOpen

Syntax Attachment_CanPost(Attachment)

where Attachment is the lAttachment interface. For more 
information, refer to the HP Quality Center Open Test Architecture 
API Reference.

Type Function

Returns True or False

Availability Attachment_CanPost
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Attachment_New
This event is triggered when an attachment is added to Quality Center.

CanAddTests
This event is triggered before Quality Center adds tests to a test set, to check 
whether the specified tests can be added.

CanCustomize
This event is triggered when a user attempts to open the Customization 
window, to check whether the specified user can customize the specified 
project.

Syntax Attachment_New(Attachment)

where Attachment is the lAttachment interface. For more 
information, refer to the HP Quality Center Open Test Architecture 
API Reference.

Type Sub

Availability Attachment_New

Syntax <entity>_CanAddTests(Tests)

where Tests is an array of Test IDs.

Type Function

Returns True or False

Availability TestSet_CanAddTests

Syntax CanCustomize(DomainName, ProjectName, UserName)

where DomainName is the domain name, ProjectName is the 
project name, and UserName is the user name.

Type Function

Returns True or False

Availability CanCustomize
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CanDelete
This event is triggered before Quality Center deletes an object from the 
server, to check if the object can be deleted. 

It applies to the following objects: requirements, tests or subject folders (in 
the Test Plan module), test sets or test set folders (in the Test Set module), 
and defects. The syntax is different for different objects.

➤ For requirements and defects:

➤ For tests or test subject folders:

Syntax <entity>_CanDelete

Type Function

Returns True or False

Availability ➤ Req_CanDelete
➤ Bug_CanDelete

Syntax <entity>_CanDelete(Entity, IsTest)

where:

➤ Entity is the test or subject folder.

➤ If IsTest is True, Entity refers to an ITest object.
If IsTest is False, Entity refers to an ISubjectNode object. For 
more information on ITest and ISubjectNode, refer to the HP 
Quality Center Open Test Architecture API Reference.

Type Function

Returns True or False

Availability Test_CanDelete
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➤ For test sets or test set folders:

CanLogin
This event is triggered to check whether the specified user can log in to the 
specified project.

CanLogout
This event is triggered to check whether the current user can log out of the 
current project.

Syntax <entity>_CanDelete(Entity, IsTestSet)

where:

➤ Entity is the test set or test set folder.

➤ If IsTestSet is True, Entity refers to an ITestSet object. 
If IsTestSet is False, Entity refers to an ITestSetFolder object. 
For more information on ITestSet and ITestSetFolder, refer to 
the HP Quality Center Open Test Architecture API Reference.

Type Function

Returns True or False

Availability TestSet_CanDelete

Syntax CanLogin(DomainName, ProjectName, UserName)

where DomainName is the domain name, ProjectName is the 
project name, and UserName is the user name.

Type Function

Returns True or False

Availability CanLogin

Syntax CanLogout

Type Function

Returns True or False

Availability CanLogout
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CanPost
This event is triggered before Quality Center posts an object to the server, to 
check whether the object can be posted.

You can add code to this event procedure to prevent an object from being 
posted in specific cases. For example, see “Example: Object Validation” on 
page 315.

CanRemoveTests
This event is triggered to check whether the specified tests can be removed 
from a test set.

Syntax <entity>_CanPost

Type Function

Returns True or False

Availability ➤ Req_CanPost
➤ Test_CanPost
➤ TestSet_CanPost
➤ TestSetTests_CanPost (does not appear in the Scripts Tree)

➤ Run_CanPost
➤ Bug_CanPost
➤ Step_CanPost

Syntax <entity>_CanRemoveTests (Tests)

where Tests is an array of Test IDs.

Type Function

Returns True or False

Availability TestSet_CanRemoveTests
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DefaultRes
This event is triggered when a user attempts to reset the defaults for 
Quality Center events. If the function returns False, the defaults are not 
reset.

DialogBox
This event is triggered when a dialog box is opened or closed.

Syntax DefaultRes

Type Function

Returns True or False

Availability DefaultRes

Syntax DialogBox(DialogBoxName, IsOpen)

where DialogBoxName is the name of the dialog box, and 
IsOpen indicates whether the dialog box is open.

Type Sub

Availability DialogBox
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EnterModule
This event is triggered when the user switches to this Quality Center 
module.

You can add code to this event procedure to perform an action whenever 
the user switches to the specified module. For example, see “Example: 
Detecting an Empty Password” on page 324.

ExitModule
This event is triggered when the user exits the specified module.

Syntax EnterModule

Type Sub

Availability EnterModule

Syntax ExitModule

Type Sub

Availability ExitModule
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FieldCanChange
This event is triggered before Quality Center changes a field value, to 
determine whether the field can be changed.

You can add code to this event procedure to prevent a field from being 
changed in specific cases. For example, see “Example: Field Validation” on 
page 316.

The code for hiding a field that depends on another field should be placed 
in the FieldChange event procedure (not in the FieldCanChange event 
procedure).

Syntax <entity>_FieldCanChange(FieldName, NewValue)

where FieldName is the name of the field and NewValue is the 
field value.

Type Function

Returns: True or False

Availability ➤ Req_FieldCanChange
➤ Test_FieldCanChange
➤ DesignStep_FieldCanChange
➤ TestSet_FieldCanChange
➤ TestSetTests_FieldCanChange
➤ Bug_FieldCanChange
➤ Step_FieldCanChange
➤ Run_FieldCanChange
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FieldChange
This event is triggered when the value of the specified field changes.

Every change of value triggers the field change event when the field loses 
focus.

You can add code to this event procedure to perform an action when the 
value of a particular field is changed. For example, you can hide or display 
one field depending on the value the user enters into another field. For 
example, see “Example: Changing One Field Based on Another Field” on 
page 313.

When a user changes a field value using the Find/Replace command, 
workflow events are not triggered. If restrictions implemented in workflow 
scripts are critical, consider disabling the Replace command for specific user 
groups, to ensure that your restrictions cannot be bypassed.

Syntax <entity>_FieldChange(FieldName)

where FieldName is the name of the field.

Type Sub

Availability ➤ Req_FieldChange
➤ Test_FieldChange
➤ DesignStep_FieldChange
➤ TestSet_FieldChange
➤ TestSetTests_FieldChange
➤ Bug_FieldChange
➤ Step_FieldChange
➤ Run_FieldChange
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GetDetailsPageName
This event is triggered by Quality Center to retrieve the name of the Defect 
Details dialog box page (tab) that has the index number specified in 
PageNum.

You can add code to this event procedure to customize the tab names on the 
Defect Details dialog box. For example, see “Example: Changing Tab 
Names” on page 311.

GetNewBugPageName
This event is triggered by Quality Center to retrieve the name of the Add 
Defect dialog box page (tab) that has the index number specified in 
PageNum.

You can add code to this event procedure to customize the tab names on the 
Add Defect dialog box. For example, see “Example: Changing Tab Names” 
on page 311.

Syntax GetDetailsPageName(PageName, PageNum)

where PageName is the default page name (for example, Page 1) 
and PageNum is the page number.

Type Function

Returns String containing the page name

Availability GetDetailsPageName

Syntax GetNewBugPageName(PageName, PageNum)

where PageName is the default page name (for example, Page 1) 
and PageNum is the page number.

Type Function

Returns String containing the page name

Availability GetNewBugPageName
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MoveTo
This event is triggered when the user changes focus from one object to 
another. 

You can add code to this event procedure to perform actions when the user 
changes the focus. For example, see “Example: Presenting a Dynamic Field 
List” on page 317.

MoveToFolder
This event is triggered when the user moves to the specified test set folder in 
the test sets tree.

Syntax <entity>_MoveTo

Type Sub

Availability ➤ Req_MoveTo
➤ Test_MoveTo
➤ DesignStep_MoveTo
➤ TestSet_MoveTo
➤ TestSetTests_MoveTo
➤ Run_MoveTo

➤ Bug_MoveTo
➤ Step_MoveTo

Syntax MoveToFolder(Folder)

where Folder is the ISysTreeNode interface. For more 
information, refer to the HP Quality Center Open Test Architecture 
API Reference.

Type Sub

Availability MoveToFolder
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MoveToSubject
This event is triggered when the user moves to the specified subject in the 
test plan tree.

New
This event is triggered when an object is added to Quality Center.

You can add code to this event procedure to perform an action when a new 
object is added. For example, see “Example: Customizing a Defects Module 
Dialog Box” on page 307.

 

Syntax MoveToSubject(Subject)

where Subject is the ISysTreeNode interface. For more 
information, refer to the HP Quality Center Open Test Architecture 
API Reference.

Type Sub

Availability MoveToSubject

Syntax <entity>_New

Type Sub

Availability ➤ Req_New
➤ Test_New
➤ DesignStep_New
➤ TestSet_New
➤ Bug_New
➤ Step_New
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RunTests
This event is triggered when the user clicks the Run button to run tests in 
the Test Lab module.

Syntax RunTests(Tests)

where Tests is an array of Test IDs.

Type Sub

Availability RunTests
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RunTestSet
This event is triggered when the user clicks the Run Test Set button to run a 
test set in the Test Lab module.

RunTestsManually
This event is triggered when the user clicks the Run arrow and chooses Run 
Manually to run tests in the Test Lab module.

Syntax RunTestSet(Tests)

where Tests is an array of Test IDs.

Type Sub

Availability RunTestSet

Syntax RunTestsManually(Tests)

where Tests is an array of Test IDs.

Type Sub

Availability RunTestsManually



Chapter 18 • Workflow Event Reference

292



293

19
Workflow Object and Property Reference

Workflow scripts can reference Quality Center objects to obtain information 
and to change project values. They can also use properties that return 
information about the current module and dialog box. This chapter lists the 
Quality Center objects and properties that are available to workflow scripts.

About Quality Center Objects and Properties

Workflow scripts can obtain information, make decisions based on that 
information, and change values in the project based on those decisions.

You can obtain information such as the user group to which the current user 
belongs, and the value of a field, by accessing objects such as the User object 
or the Field object. 

This chapter describes: On page:

About Quality Center Objects and Properties 293

Actions Object 295

Action Object 296

Fields Objects 298

Field Object 299

Lists Object 301

TDConnection Object 302

User Object 302

Quality Center Properties 303
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You can also obtain information about the active module and active dialog 
box using workflow properties. For more information on these properties, 
see “Quality Center Properties” on page 303.

Your script can change the value of a field, or field list. To do so, the script 
modifies the Value property or the List property of the appropriate Field 
object.

For information on the event procedures in which you place VBScript code 
to create workflow scripts, see Chapter 18, “Workflow Event Reference”.

The following table lists the Quality Center objects that are available when 
you write a script.

Object Description

Actions The list of actions that are available for the following 
modules: Project, Requirements, Test Plan, Test Lab, 
Defects, and the Manual Runner dialog box. See “Actions 
Object” on page 295.

Action The Action object is handled by the Actions object. See 
“Action Object” on page 296.

Fields The following objects provide access to specific fields:

➤ Req_Fields. The Requirements module. 

➤ Test_Fields. Tests in the Test Plan module. 

➤ DesignStep_Fields. Design steps in the Test Plan 
module.

➤ TestSet_Fields. Test sets in the Test Lab module. 

➤ TestSetTest_Fields. Tests in the Test Lab module. 

➤ Bug_Fields. Defects in the Defects module and the 
Manual Runner dialog box. 

➤ Step_Fields. Steps in the Manual Runner dialog box. 

➤ Run_Fields. Test runs in the Manual Runner dialog box. 

See “Fields Objects” on page 298.

Field The Field object is handled by the Fields objects. See “Field 
Object” on page 299.
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Note: In some cases, a function returns the object itself instead of the ID 
property of the object. For example, after the following statement has been 
executed, testsetf is a reference to a TestSetFolder object: 
Set testsetf = TestSet_Fields("CY_FOLDER_ID").Value.

For information on the Script Editor used to write workflow scripts, see 
Chapter 17, “Working with the Workflow Script Editor”.

For each Quality Center object, this chapter lists the properties of the object. 
The list includes the property name, a description, and the data type of the 
property. It indicates whether the property is read-only (R) or whether your 
script can modify it (R/W).

Actions Object

You can use the Actions object to manipulate toolbar buttons, menu 
commands, and dialog boxes.

The Actions object has the following property:

Lists Includes the lists that are available in a Quality Center 
project. See “Lists Object” on page 301.

TDConnection Provides access to open test architecture (OTA) objects. 
See “TDConnection Object” on page 302.

User Includes the properties of the current user. This object is 
available in all modules. See “TDConnection Object” on 
page 302.

Property R/W Type Description

Action R Object Allows access to every action in a list. The 
index for this property is the action name.

Object Description
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Action Object

You can use the Action object to verify whether a button or command is 
enabled, checked, or visible. You can also use it to execute actions.

For example, to set the Defect Details dialog box to open automatically 
when the user moves from one defect to another in the Defects Grid, place 
the following code in the Bug_MoveTo event procedure:

NewDefectAction=Actions.Action(“DefectDetailsAction1”)
NewDefectAction.Execute

To obtain the name of an action, add the following lines to the 
ActionCanExecute event procedure, perform the action, and note the action 
name that is printed in the message:

Sub ActionCanExecute(ActionName)
On Error Resume Next
MsgBox “You have performed an action named: “ & ActionName
On Error GoTo 0

End Sub

This object has the following properties:

Property R/W Type Description

Checked R/W Boolean Indicates whether an action is checked in 
Quality Center. 

Enabled R/W Boolean Indicates whether an action is enabled. A 
disabled action cannot be invoked by the 
user, but can be invoked from the 
workflow script.

Visible R/W Boolean Indicates whether an action is visible in 
Quality Center. 
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The Action object includes the following method:

When a workflow script invokes an action using the Execute method of the 
Action object, the workflow events that would be triggered if a user initiated 
the action from a dialog box are by default not triggered. Therefore, when 
using Action.Execute, you must ensure that you do not bypass the site 
policies you are enforcing with workflow events.

To enable workflow events to be triggered from within a dialog box, set the 
value of the AllowReentrancy flag to true. To restore the default settings, so 
that these events are not triggered, set the value of the AllowReentrancy flag 
to false. For example, to set the Add Defect dialog box to open automatically 
when a user enters the Defects module, place the following code in the 
EnterModule event procedure:

AllowReentrancy=true
NewDefectAction=Actions.Action(“DefectDetailsAction1”)
NewDefectAction.Execute
AllowReentrancy=false

If the value of the AllowReentrancy flag is set to false, the dialog box opens 
as usual, but you cannot submit the defect as the workflow event to submit 
the defect is not triggered.

Important: Consider carefully the implications of setting the value of this 
flag to true. If you set the value of the flag to true, you enable a function to 
call another function which may call the original function. This can cause 
an endless loop. This can also occur when functions call internal functions 
which call the original function.

Method Description

Execute Executes the action.
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Fields Objects

You can use the following objects in workflow scripts to access the fields of 
Quality Center modules: 

For example, to set a certain property for all fields in the Req_Fields object, 
you can refer to each field by its ID number (Req_Fields.FieldById). To set all 
fields to be visible (IsVisible) in a dialog box, you can use the following code:

For i = 1 to Req_Fields.Count
Req_Fields.FieldById(i).IsVisible = True

Next

Object Description

Req_Fields Provides access to the fields of the Requirements module.

Test_Fields Provides access to the fields of tests in the Test Plan 
module.

DesignStep_Fields Provides access to the fields of the design steps in the Test 
Plan module.

TestSet_Fields Provides access to the fields of the test sets in the Test Lab 
module.

TestSetTest_Fields Provides access to the fields of the tests in the Test Lab 
module.

Bug_Fields Provides access to the fields of the defects in the Defects 
module and the Manual Runner dialog box.

Step_Fields Provides access to the fields of the steps in the Manual 
Runner dialog box.

Run_Fields Provides access to the fields of the test runs in the Manual 
Runner dialog box.
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These objects have the following properties:

Field Object

You can use the Field object to access the properties of an entity field.

For example, to display a message box when a user does not have 
permission to change a value in the Status field, you can use the following 
code:

Msgbox "You do not have permission to change 
<" & _Bug_Fields.Field("BG_STATUS").FieldLabel & "> field."

Property R/W Type Description

Count R Long Returns the number of fields in the current 
object.

Field
(FieldName)

R Object Accesses the fields by field name or field 
label. 

FieldById
(FieldID)

R Object Accesses the fields by the field ID number.
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The Field object has the following properties:

Property R/W Type Description

FieldLabel R String The displayed label of the field.

FieldName R String The logical name of the field.

IsModified R Boolean Specifies whether the value was modified.

IsMultiValue R Boolean Specifies whether the field can contain 
multiple values from a lookup list. 

IsNull R Boolean Specifies whether the field value is absent. 

IsReadOnly R/W Boolean Specifies whether the field is read-only. 

IsRequired R/W Boolean Specifies whether a field value is required. 
This enables you to override field 
customization information. To modify the 
IsRequired property of a field, the IsVisible 
property must be True. Changes to 
IsRequired are ignored if the field is not 
visible. 

Users must always enter a value for a field 
that is set as required by the workflow. This 
applies whether they are modifying an 
existing record or adding a new record, and 
even if the field is already empty.

Note: This property cannot be used with 
the Run_Fields object to set the fields of a 
run as required.

IsVisible R/W Boolean Specifies whether the field is displayed. 

List R/W List Sets or retrieves the field list attached to a 
field of type lookup list.

PageNo R/W Integer Sets or retrieves the page (tab) on which 
the field is displayed in the Add Defect and 
Defect Details dialog boxes. 
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Lists Object

You can use the Lists object to limit field input to a specific list of values.

For example, to set the list in the Planned Closing Version field, depending 
on the Project field value, you can use the following code:

If Bug_Fields.Field("BG_PROJECT").Value = "Project 1" Then
Bug_Fields.Field("BG_PLANNED_CLOSING_VER").List _
= Lists("All Projects")
...

End If

For more information, see “Example: Presenting a Dynamic Field List” on 
page 317.

The Lists object has the following properties:

Note: When workflow customization has been used to change a list of 
values for a field that has transition rules defined, the field may only be 
modified in a way that satisfies both the workflow script and the transition 
rules. For more information, see “Setting Transition Rules” on page 173.

Value R/W Variant Sets or retrieves the value of the field. 

ViewOrder R/W Integer Sets or retrieves the order in which the 
field appears in the Add Defect and Defect 
Details dialog boxes. 

Property R/W Type Description

List R ISysTreeNode Accesses the Quality Center lists.

Property R/W Type Description
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TDConnection Object

In workflow scripts, the only objects that are available are the objects of the 
module in which the code is written and a limited number of global objects. 
One of the global objects is the TDConnection object. TDConnection 
provides access to the open test architecture (OTA) objects.

You can use the TDConnection object to access objects from other modules, 
and to access general session parameters. You can access TDConnection 
properties in any procedure, from any module. 

For more information about the TDConnection object, and a list of 
TDConnection properties, refer to the HP Quality Center Open Test Architecture 
API Reference.

For examples of using the TDConnection object in workflow scripts, see 
Chapter 20, “Workflow Examples”.

User Object

You can access the User object to retrieve the user name of the current user 
and to check whether the user belongs to a particular user group. You can 
retrieve or modify the first and last name of the user.

For example, to have a message box open when the user has project 
administrator permissions, use the following code:

If User.IsInGroup("TDAdmin") Then
MsgBox "The user " & User.FullName & _
" has administrative permissions for this project."

End If

For more information, see “Example: Changing a Field Based on the User 
Group” on page 314, and “Example: Controlling User Permissions” on 
page 320.

To access user properties such as the user password, that cannot be accessed 
by the User object, you can use the TDConnection object of the 
Quality Center open test architecture (OTA). For more information, see 
“Example: Detecting an Empty Password” on page 324.
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The User object has the following properties:

Quality Center Properties

You can use the ActiveModule and ActiveDialogName properties to obtain 
information about the active module and dialog box.

ActiveModule Property
The ActiveModule property returns the name of the active Quality Center 
module. For example, to open a message box displaying the module name 
when you move to a new module, use the following code:

Sub EnterModule
On Error Resume Next
msgbox "You have just entered the " & ActiveModule & ” module.”
On Error GoTo 0

End Sub

Property R/W Type Description

FullName R/W String Sets or retrieves the first and last name of 
the current user.

IsInGroup 
(GroupName)

R Boolean Checks whether or not the current user is 
a member of a predefined/user-defined 
group. 

UserName R String Returns the user name used when logging 
in to Quality Center.
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ActiveDialogName Property
The ActiveDialogName property returns the name of the active dialog box. 
For example, to open a message box displaying the dialog box name when 
you open a new dialog box, use the following code:

Sub DialogBox(DialogBoxName, IsOpen)
On Error Resume Next
msgbox "You have just opened the " & ActiveDialogName " dialog box."
On Error GoTo 0

End Sub
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20
Workflow Examples

This chapter provides the following examples of workflow scripts:

This chapter describes: On page:

About the Workflow Examples 306

Example: Customizing a Defects Module Dialog Box 307

Example: Changing Tab Names 311

Example: Adding a Template to a Memo Field 312

Example: Changing One Field Based on Another Field 313

Example: Changing a Field Based on the User Group 314

Example: Object Validation 315

Example: Field Validation 316

Example: Presenting a Dynamic Field List 317

Example: Changing Field Properties when a Field Changes 319

Example: Controlling User Permissions 320

Example: Adding Button Functionality 321

Example: Error Handling 321

Example: Obtaining the Session Context 323

Example: Obtaining Session Properties 323

Example: Detecting an Empty Password 324

Example: Sending Mail 325
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About the Workflow Examples

The workflow examples presented in this chapter perform several types of 
task. The following table lists the examples that illustrate each type of task.

Example: Storing the Last Values Entered 327

Example: Copying Field Values to Another Object 330

Workflow Task See Examples

dialog box 
customization

Example: Customizing a Defects Module Dialog Box

Example: Changing Tab Names

field value 
automation

Example: Adding a Template to a Memo Field

Example: Changing One Field Based on Another Field

Example: Changing a Field Based on the User Group

data validation Example: Object Validation

Example: Field Validation

dynamic field 
customization

Example: Presenting a Dynamic Field List

Example: Changing Field Properties when a Field Changes

user permission 
control

Example: Controlling User Permissions

functionality Example: Adding Button Functionality

error handling Example: Error Handling

using OTA to obtain 
session parameters

Example: Obtaining the Session Context

Example: Obtaining Session Properties

Example: Detecting an Empty Password

sending mail Example: Sending Mail

This chapter describes: On page:
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Example: Customizing a Defects Module Dialog Box

This example shows how you can customize the field layout and other field 
properties in the Add Defect dialog box. You can create similar code to 
arrange the layout of the Defect Details dialog box.

This example illustrates a solution that customizes field properties for all 
user groups. You can also use the script generators to customize the layout of 
the Defects module dialog boxes. If you use the script generators, you must 
perform customization separately for each user group. For information on 
these script generators, see “Customizing Defects Module Dialog Boxes” on 
page 246.

This example involves the following two procedures:

➤ SetFieldApp is a general purpose procedure that receives a field name and 
its properties as parameters, and assigns the properties to the field. See 
“SetFieldApp” on page 308.

➤ FieldCust_AddDefect calls SetFieldApp for each field in the Add Defects 
dialog box, to set the properties of the field. For some of the fields, 
FieldCust_AddDefect checks the user group to which the current user 
belongs, and customizes the field properties accordingly. A call to 
FieldCust_AddDefect is placed in the Bug_New event procedure. See 
“FieldCust_AddDefect” on page 309.

the Settings object Example: Storing the Last Values Entered

copying values 
between modules

Example: Copying Field Values to Another Object

Workflow Task See Examples
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Note: To implement this example, you can run the Add Defect Field 
Customization script generator and then modify the resulting scripts.

➤ Rename the generated function WizardFieldCust_Add to 
FieldCust_AddDefect and modify it as necessary. (Before you modify a 
generated script, you must rename it so that it is not overwritten the next 
time you run the script generator.)

➤ The script generator places a call to WizardFieldCust_Add in the event 
procedure Bug_New. Change this to FieldCust_AddDefect.

➤ The function SetFieldApp is generated when you run the script generator. 
You do not need to rename or modify this function.

SetFieldApp
The function SetFieldApp receives a field name and its properties as 
parameters, and assigns the properties to the field.

The function assigns the following field properties: field visibility, whether 
the field is required, the number of the page (tab) on which the field should 
be displayed, and the view order (from left to right and from top to bottom).

Add a call to the function SetFieldApp in the user-defined function 
FieldCust_AddDefect.

Sub SetFieldApp(FieldName, Vis, Req, PNo, VOrder)
On Error Resume Next
With Bug_Fields(FieldName)

.IsVisible = Vis

.IsRequired = Req

.PageNo = PNo

.ViewOrder = VOrder
End With
PrintError “SetFieldApp”
On Error GoTo 0

End Sub
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FieldCust_AddDefect
The user-defined function FieldCust_AddDefect calls the function 
SetFieldApp.

The function first sets all fields to be invisible, not required, and to appear 
on page 100 at location 0. This ensures that if you add a new field using the 
Project Entities link on the Project Customization window, the layout will 
not be changed.

Add a call to FieldCust_AddDefect in the Bug_New event procedure so that it 
will be triggered when a user adds a new defect:

Sub Bug_New
FieldCust_AddDefect

End Sub

First, the code handles the fields that are common to all user groups. It uses 
conditional statements for the fields that will appear in the dialog box only 
for specific user groups, or that will have different properties for different 
users.

Sub FieldCust_AddDefect
On Error Resume Next
For i= 0 To Bug_Fields.Count

SetFieldApp Bug_Fields.FieldByID(i), False, False, 100, 0
Next

ViewNum = 0
PageNum = 0

SetFieldApp "BG_BUG_ID", True, True, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_DESCRIPTION", True, False, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_SUMMARY", True, True, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_DETECTED_BY", True, True, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_DETECTION_DATE", True, True, PageNum, ViewNum
ViewNum = ViewNum + 1
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SetFieldApp "BG_DETECTION_VERSION", True, True, PageNum, _
ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_SEVERITY", True, True, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_PRIORITY", True, True, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_PROJECT", True, False, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_REPRODUCIBLE", True, False, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_STATUS", True, False, PageNum, ViewNum
ViewNum = ViewNum + 1

‘ Now handle fields that are different for different user groups 

If User.IsInGroup("Developer") Then
SetFieldApp "BG_PLANNED_CLOSING_VERSION", True, False, _
PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_PLANNED_FIX_TIME", True, False, PageNum, _
ViewNum
ViewNum = ViewNum + 1

End If

If User.IsInGroup("QATester") Then
PageNum = PageNum + 1
SetFieldApp "BG_USER_01", True, False, PageNum, ViewNum
ViewNum = ViewNum + 1
SetFieldApp "BG_USER_02", True, False, PageNum, ViewNum
ViewNum = ViewNum + 1

End If

SetFieldApp "BG_ACTUAL_FIX_TIME", True, False, PageNum, _
ViewNum
ViewNum = ViewNum + 1
:
PrintError “FieldCust_AddDefect”
On Error GoTo 0

End Sub
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Example: Changing Tab Names

You can change the names of the tabs on the Add Defect dialog box. This 
example sets the tabs to General, Environments, and Business Case.

Add the following code to the GetNewBugPageName event procedure, 
which is triggered before Quality Center opens the Add Defect dialog box. 
To change the tab names on the Defect Details dialog box, add similar code 
to the event procedure GetDetailsPageName.

Function GetNewBugPageName(PageName, PageNum)
On Error Resume Next
Select case PageNum

case "1"
GetNewBugPageName="General"

case "2"
GetNewBugPageName="Environments"

case else
GetNewBugPageName="Business Case"

End Select
PrintError “GetNewBugPageName”
On Error GoTo 0

End Function
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Example: Adding a Template to a Memo Field

You can use workflow scripts to add a default template to a memo field. This 
example adds text to a memo field called Business Case to display the 
following template:

Perform this customization by placing the HTML code for the text into the 
BG_USER_25 field when a defect is added. This example assumes that the 
user-defined field BG_USER_25 is used to store a business case string.

Add the code to the Bug_New event procedure, which is triggered when a 
user adds a new defect.

Sub Bug_New
On Error Resume Next
Bug_Fields("BG_USER_25").value = _
"<html><body><b>Step by step scenario:</b>" & _
"<br><br><br><b>How it affects the user:</b></body></html>"
PrintError “Bug_New”
On Error GoTo 0

End Sub
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Example: Changing One Field Based on Another Field

This example demonstrates how you can change a field value based on the 
value entered into another field.

For example, you can cause defects to be assigned to user alex_qc when 
UI Suggestion is entered into the Category field, and to user alice_qc when 
Security Issues is entered.

The example assumes that the user-defined field BG_USER_05 is used to 
store the category. When the Category field is changed in the Defects 
module, the BG_RESPONSIBLE field is assigned the appropriate value.

Add the code to the Bug_FieldChange event procedure so that it is triggered 
when a user changes a field value for a defect.

Sub Bug_FieldChange(FieldName)
On Error Resume Next
If FieldName = "BG_USER_05" then

Select case Bug_Fields("BG_USER_05").Value
case "UI Suggestion"

Bug_Fields("BG_RESPONSIBLE").value="alex_qc"
case "Security Issue"

Bug_Fields("BG_RESPONSIBLE").value="alice_qc"
End Select

End If
PrintError “Bug_FieldChange”
On Error GoTo 0

End Sub
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Example: Changing a Field Based on the User Group

This example demonstrates how you can change a field value according to 
the user group of the user entering the defect.

In this example, the user-defined field BG_USER_01 is a detection mode field 
in which the user who detected the defect can enter the way in which it was 
discovered. Possible values are Formal testing, Informal testing, and BTW.

The example sets the value of the detection mode field to BTW when a 
defect is opened by a user who is not in the QA Tester group.

Add the code to event procedure Bug_New, so that it is triggered when a 
defect is added.

Sub Bug_New
On Error Resume Next
If not User.IsInGroup("QATester") then

Bug_Fields("BG_USER_01").Value = "BTW"
End If
PrintError “Bug_New”
On Error GoTo 0

End Sub
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Example: Object Validation

This example demonstrates how you can perform validations of all fields by 
using the CanPost event procedure. For example, this code segment ensures 
that a user cannot reject a defect without adding a comment.

In this example, a user may not post a defect where the defect status 
(BG_STATUS) has been changed to Rejected unless some explanatory text 
has been entered in the R&D Comment field (BG_DEV_COMMENTS).

Add the code to the Bug_CanPost event procedure so that the check is 
performed when the user attempts to submit the defect.

Function Bug_CanPost
On Error Resume Next
If Bug_Fields("BG_STATUS").IsModified and _
Bug_Fields("BG_STATUS").Value = "Rejected" and _
not Bug_Fields("BG_DEV_COMMENTS").IsModified then

Bug_CanPost = False
msgbox "You must enter a comment when rejecting a defect."

Else
Bug_CanPost = True

End If
PrintError “Bug_CanPost”
On Error GoTo 0

End Function
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Example: Field Validation

This example demonstrates how to validate a single field value. For example, 
the following code segment shows how you can ensure that a user in a 
specific group cannot lower the priority of a defect.

In this example, if the user is in the QATester group and the BG_PRIORITY 
field is being modified, the new value of the BG_PRIORITY field cannot be 
lower than the current value. 

This example assumes that in the Priority field list for the project, lower 
priorities come first when the values are sorted in ascending order. For 
example, the list meets this requirement if the elements are as follows: 
1-Low, 2-Medium, 3-High.

Add the code to the Bug_FieldCanChange event procedure so that it is 
triggered when the user attempts to change a defect field value.

Function Bug_FieldCanChange(FieldName, NewValue)
On Error Resume Next
If User.IsInGroup("QATester") and FieldName ="BG_PRIORITY" Then

If NewValue < Bug_Fields("BG_PRIORITY").Value then
Bug_FieldCanChange = False
msgbox "You do not have permission to lower defect priority."

Else
Bug_FieldCanChange = True

End If
End If
PrintError “Bug_FieldCanChange”
On Error GoTo 0

End Function
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Example: Presenting a Dynamic Field List

This example demonstrates how you can present a different field list in a 
field, depending on the value of another field.

The user-defined function SW_SetLists_Environment checks the value of the 
Environment Specification field and assigns the appropriate field list to the 
Environment Type field.

This example assumes that the field lists have been defined in the project. 
For more information, see “Customizing Project Lists” on page 213.

Note: To use workflow scripts to change or create lists that can be assigned 
to fields, you must use the Open Test Architecture (OTA) interface.

Add code to the Bug_MoveTo event procedure so that the user-defined 
function SW_SetLists_Environment is called when the user changes focus in 
the defects module.

Sub Bug_MoveTo()
On Error Resume Next
SW_SetLists_Environment
PrintError “Bug_MoveTo”
On Error GoTo 0

End Sub

Add code to the Bug_FieldChange event procedure so that the user-defined 
function SW_SetLists_Environment is called when a user changes the value 
of the Environment Type field in the Defects module.

Sub Bug_FieldChange(FieldName)
On Error Resume Next
If FieldName = "BG_USER_01" then

SW_SetLists_Environment
End If
PrintError “Bug_FieldChange”
On Error GoTo 0

End Sub
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The user-defined function SW_SetLists_Environment checks the value of the 
Environment Specification field (BG_USER_02) and assigns the appropriate 
field list to the Environment Type field (BG_USER_01).

Sub SW_SetLists_Environment()
Dim listName
On Error Resume Next
Select Case Bug_Fields("BG_USER_01").Value
Case "Browser"

listName = "Browsers"
Case "Database Type"

listName = "Database Type"
Case "Operating System"

listName = "Platform"
Case "Web Server"

listName = "Web Server"
Case Else

listName = "Environment Specification"
End Select
Bug_Fields("BG_USER_02").List = Lists(listName)
PrintError ("Set Environment List")
On Error GoTo 0

End Sub
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Example: Changing Field Properties when a Field Changes

This example demonstrates how you can change the properties of a field 
when a different field is changed.

In this example, if the status of the defect (BG_STATUS) is changed to 
Closed, the user must provide a value in the field Closed in Build 
(BG_CLOSING_VERSION).

Add the code to the Bug_FieldChange event procedure, to make the Closed 
in Build field a required field if the status is changed to Closed.

Sub Bug_FieldChange(FieldName)
On Error Resume Next
If FieldName= "BG_STATUS" and _
Bug_Fields("BG_STATUS").value="Closed" then

Bug_Fields("BG_CLOSING_VERSION").IsRequired=True
End If
PrintError “Bug_FieldChange”
On Error GoTo 0

End Sub



Chapter 20 • Workflow Examples

320

Example: Controlling User Permissions

This example demonstrates how you can prevent members of specific user 
groups from performing an action.

The code allows a user to replace a defect field value only if the user belongs 
to the Admin user group.

Add the code to the ActionCanExecute event procedure so that the check is 
performed when a user attempts to execute an action.

Function ActionCanExecute(ActionName)
On Error Resume Next
If ActionName = "BugReplaceAction1" _

And Not User.IsInGroup("Admin") then
ActionCanExecute = False
msgbox "You do not have permission to perform this action"

Else
ActionCanExecute = True

End If
PrintError “ActionCanExecute”
On Error GoTo 0

End Function
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Example: Adding Button Functionality

This example opens a calculator when a user clicks a button defined with 
action name Calculator.

Add the code to the ActionCanExecute event procedure, so that it is triggered 
when a user initiates an action.

For information about the Wscript.Shell object, refer to the Microsoft 
documentation. To access help for the VBScript language, choose Help > 
VBScript Home Page in the Script Editor.

Function ActionCanExecute(ActionName)
On Error Resume Next
If ActionName = "Calculator" Then

Set shell = CreateObject("Wscript.Shell")
shell.Run "Calc"
set shell = Nothing

End If
ActionCanExecute = DefaultRes
PrintError “ActionCanExecute”
On Error GoTo 0

End Function

Example: Error Handling

This example demonstrates how you can display a standard error message. 
Error handling should be added to each workflow script that you write, 
because errors that are not detected by the workflow code can cause the 
user’s browser to crash.

The user-defined function PrintError receives the name of the calling 
procedure as a parameter. If an error has occurred, PrintError prints out the 
error number, description and severity, and the name of the procedure in 
which the error occurred.
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You do not need to create an Err object, because it is intrinsic to VBScript. 
For more information about the Err object, refer to the Microsoft 
documentation.

Sub PrintError(strFunctionName)
If Err.Number <> 0 Then

MsgBox "Error #" & Err.Number & ": " & Err.Description, _
vbOKOnly+vbCritical, _
"Workflow Error in Function " & strFunctionName

End If
End Sub

The following code segment illustrates how you can add error handling to 
your subroutines.

Sub <sub_name>()
On Error Resume Next
:
[Your code here]
:
PrintError "<sub_name>"

End Sub

The following code segment illustrates how you can add error handling to 
your functions.

Function <function_name>()
On Error Resume Next
:
[Your code here]
:
PrintError "<function_name>"

End Function
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Example: Obtaining the Session Context

You can use the TDConnection object in a workflow script to retrieve 
information about the session in which the user is working at the time that 
the script is executed. 

In the following example, the server time is displayed in a message box:

MsgBox "The current time on the server is: " & TDConnection.ServerTime

Example: Obtaining Session Properties

This example demonstrates how to use the TDConnection object to obtain 
the properties of the current session. Add the code to the procedure where 
these properties are needed. The properties do not depend on each other, so 
each of the properties can be retrieved separately.

The following are examples of session properties: 

TDConnection.ServerName
TDConnection.ServerTime
TDConnection.DomainName
TDConnection.ProjectName
TDConnection.Password
User.UserName

Note that there is no need to use TDConnection to retrieve the user name 
because the workflow has a predefined User object. For more information, 
see “TDConnection Object” on page 302.

The example below tests the first five characters of the server URL to 
determine whether the user is connected to the server using HTTP or HTTPS:

If Left(UCase(TDConnection.ServerName), 5) = "HTTPS" Then
MsgBox "You are currently connected to the server using SSL."

Else
MsgBox "You are not using SSL."

End If
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Example: Detecting an Empty Password

This example accesses TDConnection to retrieve the password of the current 
user. It prints a message if the user has an empty password.

The following user-defined function is added to the common script section 
so that it can be accessed from all modules. 

Function CheckPassword
On Error Resume Next
If isObject(TDConnection) Then

Set tdc = TDConnection
currentPwd = tdc.Password
If len(currentPwd) < 1 Then

MsgBox "Your password is empty (null).” & _ 
“Please change your password (Tools -> Change Password).", 0, _
"Your Password Is Empty"

End If
End If
On Error GoTo 0

End Function

Add the following lines to the EnterModule event procedure so that a user 
with an empty password receives a message when they enter a module.

Sub EnterModule
On Error Resume Next
CheckPassword
On Error GoTo 0

End Sub
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Example: Sending Mail

These examples demonstrate how to use the TDConnection object to send 
mail from the Defects module, and to send mail when a field value changes 
in the Test Plan module.

Sending Mail from the Defects Module
This example sends mail from the Defects module. 

Add a call to the SendDefect procedure in the Bug_AfterPost event 
procedure. 

Note: If the SendDefect procedure is called before the defect is submitted, 
the values that were changed in the current modification will not be 
included. The database is updated with the new values only after the defect 
is posted.

Sub SendDefect (iObjectId, strTo, strCc, strSubject, strComment)
On Error Resume Next
Dim objBugFactory, objBug
Set objBugFactory = TDConnection.BugFactory
Set objBug = objBugFactory.Item(iObjectId)
objBug.Mail strTo, strCc, 2, strSubject, strComment
Set objBug = Nothing
Set objBugFactory = Nothing
PrintError "SendDefect"
On Error Then GoTo 0

End Sub

The constant 2 in the call to objBug.Mail indicates that the history should be 
included with the mail. For a list of the constants that can be used to 
customize e-mail, refer to the tagTDMAIL_FLAGS enumeration in the HP 
Quality Center Open Test Architecture API Reference. In workflow scripts, use 
numeric constants and not the enumeration values.
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Sending Mail When a Test Plan Module Field Value 
Changes
The example below demonstrates how a similar function can be called when 
the value of the status field is changed in the Test Plan module.

The code is added to the Test_FieldChange event procedure. It constructs a 
subject and comment for the e-mail, and calls a user-defined function, 
SendTest. SendTest sends mail from the Test Plan module. You could code 
SendTest similarly to the SendDefect subroutine shown in “Sending Mail 
from the Defects Module” on page 325.

Sub Test_FieldChange(FieldName)
On Error Resume Next
Dim strSubject, strComment
If FieldName = "TS_STATUS" Then

strSubject = "Test Change Notification" & _
" for project " & TDConnection.ProjectName & _
" in domain " & TDConnection.DomainName

strComment = "The user " & User.FullName & _
" changed the status of the test " & _
Test_Fields("TS_NAME").Value & _
" to " & Test_Fields("TS_ STATUS").Value

SendTest Test_Fields("TS_TEST_ID").Value, _
Test_Fields("TS_RESPONSIBLE").Value, "[QA Testers]", _
strSubject, StrComment

End If
End Sub
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Example: Storing the Last Values Entered

This example shows how to use the TDConnection object to implement 
persistent data between actions. The lifetime of a variable in a routine is 
only for the routine run. Therefore, persistent data must be stored if it must 
be available later. It is recommended that you use the Quality Center API to 
store persistent data whenever possible instead of using external objects, 
files, or the registry.

In this example, a user-defined function SW_KeepLastValue uses the 
Settings object to save the values entered into the fields 
BG_DETECTION_VERSION, BG_USER_01, and BG_USER_03 when a user 
posts a defect. These values are retrieved and assigned as default values 
when this user adds a new defect.

The user-defined function is called with the SET action from Bug_CanPost, 
before a new defect is posted by the user. The values in the fields are stored.

Function Bug_CanPost() 
If Bug_Fields("BG_BUG_ID").Value = "" Then

SW_KeepLastValue ("SET")
End If

End Function

The function is called with the GET action from the Bug_New event 
procedure. When a user adds a new defect, the values stored in the fields for 
this user are entered into these fields.

Sub Bug_New()
SW_KeepLastValue ("GET")

End Sub 
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Depending on the action passed as a parameter, the user-defined function 
SW_KeepLastValue stores the values of the fields in the common settings 
table for the current user, or reads the values from the Settings object and 
assigns the values to the appropriate fields.

Sub SW_KeepLastValue(action)
Dim tdc, vals, flds
Dim uset, pairs, pair
Dim bld
On Error Resume Next

bld = ""
Set tdc = TDConnection
Set uset = tdc.UserSettings

If action = "SET" Then
flds = Array("BG_DETECTION_VERSION", _
"BG_USER_01", "BG_USER_03")
vals = ""
For i = 0 To UBound(flds)

If vals <> "" Then vals = vals & ";"
vals = vals & flds(i) & "=" & Bug_Fields(flds(i)).Value

Next
'Open category KeepLValueSetting
uset.Open ("KeepLValueSetting")
'Setting KeepValueFields in category KeepLValueSetting
uset.Value("KeepValueFields") = vals
uset.Close

End If ‘SET
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If action = "GET" Then
uset.Open ("KeepLValueSetting")
vals = uset.Value("KeepValueFields")
If vals <> "" Then

pairs = Split(vals, ";")
For i = 0 To UBound(pairs)

pair = Split(pairs(i), "=")
If UBound(pair) = 1 Then

Select Case pair(0)
Case "BG_USER_03"

bld = pair(1)
Case Else

If Bug_Fields(pair(0)).Value = "" Then
Bug_Fields(pair(0)).Value = pair(1)

End If
End Select
If Bug_Fields("BG_DETECTION_VERSION").Value <> "" _
And bld <> "" Then

SW_SetLists_VersionsBuilds _
"BG_DETECTION_VERSION", _
"BG_USER_03"
Bug_Fields("BG_USER_03").Value = bld
If Err.Number <> 0 Then Err.Clear

End If ‘Bug_Fields
End If ‘UBound(pair)

Next
End If ‘vals <> ""

End If ‘GET

uset.Close

PrintError ("Keep Last Value (" & action & ")")
On Error GoTo 0

End Sub
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Example: Copying Field Values to Another Object

This example shows how to use the TDConnection object to copy the value 
from the Build Number field of a Run (RN_USER_02) to the Last Ran On 
Build field of a Test in a Test Set (TC_USER_03). 

Add the code to the Run_AfterPost event procedure.

Sub Run_AfterPost
On Error Resume Next
Set TSFactory = TDConnection.TestSetFactory
Set TS = TSFactory.Item(Run_Fields("RN_CYCLE_ID").value)

Set TSTestFactory =TS.TSTestFactory
Set TSTest = TSTestFactory.Item(Run_Fields("RN_TEST_ID").Value)

TSTest.Field("TC_USER_03") = Run_Fields("RN_USER_02")
TSTest.Post

Set TSFactory = Nothing
Set TS = Nothing
Set TSTestFactory =Nothing
Set TSTest = Nothing

PrintError ("Run_AfterPost")
On Error GoTo 0

End Sub
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A
Verifying Quality Center Server 
Components

You can use the Quality Center Checker to perform component status 
checks and to verify that the main Quality Center server components are 
successfully installed.

About Verifying Quality Center Server Components

The Quality Center Checker is a diagnostic tool that tests many of the 
Quality Center server components that Quality Center uses. Running the 
Quality Center Checker can pinpoint the cause of many server side 
problems associated with accessing Quality Center.

Before you install Quality Center, you can use the Quality Center Checker 
to check that you have the required permissions and resources to perform 
the installation. For more information on installing the Quality Center 
Checker, see “Installing the Quality Center Checker” on page 334.

After you install Quality Center, you can use the Quality Center Checker to 
verify that the main Quality Center server components are successfully 
installed. You can also verify information such as directory paths, operating 
systems, permissions, resources, and port availability. For more information, 
see “Using the Quality Center Checker” on page 335.

This appendix describes: On page:

About Verifying Quality Center Server Components 333

Installing the Quality Center Checker 334

Using the Quality Center Checker 335
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Installing the Quality Center Checker

The Quality Center Checker is installed as part of the Quality Center 
installation. To use the Quality Center Checker before installing 
Quality Center, or to get the latest version of the Quality Center Checker, 
you can download the Quality Center Checker from the Mercury Customer 
Support Web site. 

To manually install the Quality Center Checker:

 1 Log in to the Quality Center server machine with administrator privileges.

 2 Download the latest version of the Quality Center Checker from the 
Customer Support Web site (http://support.mercury.com), and extract the files 
to a local directory on the server machine.

 3 Run the qcchecker.bat file from the <Quality Center Checker>\bin directory.

To install a newer version of the Quality Center Checker:

 1 Log in to the Quality Center server machine with administrator privileges.

 2 Find the location of the previous installation of the Quality Center Checker. 
If Quality Center Checker was installed in Quality Center 9.0, its directory is 
<Quality Center home directory>\qcchecker.

 3 Make a back up of the qcchecker folder.

 4 Download the latest version of the Quality Center Checker from the 
Customer Support Web site (http://support.mercury.com) and extract the files 
to <Quality Center home directory>\qcchecker.

 5 Update the params.properties file in <Quality Center home directory>\
qcchecker\tests with parameter information from the original 
params.properties file.

http://support.mercury.com
http://support.mercury.com
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Using the Quality Center Checker

The following components are verified by the Quality Center Checker:

To use the Quality Center Checker:

 1 Open the Quality Center Checker as follows:

➤ From Windows: Choose Start > Programs > HP Quality Center > 
Quality Center Checker. Alternatively, Run the qcchecker.bat file from 
the <Quality Center home directory>\qcchecker\bin directory.

➤ From Linux or Solaris: Run the qcchecker.sh file from the 
<Quality Center home directory>\qcchecker\bin directory.

Component Description

Computer Information Displays information about your computer, such as 
environment values, Java properties, and operating 
system data. It also displays data input in the 
Quality Center Checker parameter properties file.

<application server name> 
Application Server

Verifies information about your application server 
such as directory paths, operating system, ports, 
and service packs.

File System Verifies that sufficient disk space is available.

Site Administration 
Information

Verifies the configuration of the database server and 
the Site Administration database. Also verifies your 
Quality Center license.

Application 
Communication

Verifies the connection between Quality Center and 
Site Administration.

Other Validations Verifies the availability of server side resources 
required to perform the Quality Center installation. 
This includes port status, service user permissions, 
installation user permissions, database version, and 
database permissions.
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The Quality Center Checker window opens.

You can expand and collapse all branches in the components tree. To 
expand all branches, right-click any branch and choose Expand All. To 
collapse all branches, right-click any branch and choose Collapse All.

 2 To verify the status of the server components, you can:

➤ Select a branch and click the Run Selected button or choose Run > Run 
Selected. 

➤ Click the Run All button or choose Run > Run All to verify all 
components.
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 3 If a parameter value is required to run a component, the Required 
Parameters dialog box opens.

Click the Value box of the required parameter and type the value. Click 
Continue. The verification process continues.

Note that to view whether parameters are required before you start verifying 
a component, select the branch and choose Run > Required Parameter. If 
parameters are required the Required Parameters dialog box opens.

Tip: To avoid entering parameters each time you run the Quality Center 
Checker, you can type the information in the params.properties file in the 
<Quality Center home directory>\qcchecker\tests directory. To do so, open 
the params.properties file in a text editor, uncomment the parameter, and 
type the required parameter information.
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 4 In the right pane of the Quality Center Checker window, you can view a 
report of the verified components.

The report displays description, status, and information on each branch that 
was verified. To view additional report information, choose View > Show 
Properties.

The status bar indicates the status of the verified components. Passed 
components are displayed in green with a check mark. Failed components 
are displayed in red with an X. Components that may lead to problems and 
require the attention of the Quality Center site administrator are displayed 
in yellow with an exclamation point.

 5 To clear all results, click the Clear All Results button or choose File > Clear All 
Results.

 6 To save all results, click the Save All Results button or choose File > Save All 
Results.

 7 To close the Quality Center Checker, choose File > Exit.
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B
Guidelines for Upgrading and Migrating
to Quality Center

This appendix provides guidelines for upgrading and migrating from a 
previous TestDirector or Quality Center version to the latest Quality Center 
version. It covers considerations and recommendations involved in the 
upgrading process from planning, testing, and upgrading, to final 
verification.

This appendix describes: On page:

About Upgrading and Migrating to Quality Center 340

Upgrade Assessment 341

Upgrade Scope and Strategy 342

Upgrade Checklist 343

Setting Up the Testing Environment 349

Validating the Results 350

Using the E-mail Notification Utility 351

The Upgrade Process 352

Verifying the Upgrade Process 357

Migrating Projects from Oracle 8.1.7 (and earlier) to Oracle 10 362

Uninstalling TestDirector 7.6 and 8.0 362
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About Upgrading and Migrating to Quality Center

The upgrade process introduces new advanced technology, new features and 
functionalities, and performance improvements such as scalability and 
stability. It affects the entire application implementation, including the 
database structure, the user interface, administration tools, and integrations 
with other HP products and third-party applications. 

Before performing the upgrade from TestDirector to the latest version of 
Quality Center, consider the following guidelines:

➤ Check for known issues in Quality Center. For more information, see 
“Upgrade Assessment” on page 341.

➤ Define the upgrade scope and strategy, and assess the most efficient and 
effective way to install the upgrade. For more information, see “Upgrade 
Scope and Strategy” on page 342.

➤ Work out a detailed upgrade procedure.

➤ Define which key areas will be affected during the upgrade process.

➤ Consider upgrade criteria such as database version compatibility (see 
“Migrating Projects from Oracle 8.1.7 (and earlier) to Oracle 10” on 
page 362), hardware and software compatibility, and integrations with 
other HP products or third-party tools. 

➤ Complete the checklist for the current production environment. This 
checklist is used during the testing phase and the upgrading process. For 
more information, see “Upgrade Checklist” on page 343.

➤ Set up a testing system to perform testing before the upgrade. For more 
information, see “Setting Up the Testing Environment” on page 349. 

➤ Validate the test results by comparing the functionality and performance 
in the latest version of Quality Center with those in the previous version 
of Quality Center or TestDirector. For more information, see “Validating 
the Results” on page 350.

➤ Set up the e-mail utility so that you can notify TestDirector end users that 
they need to log out from certain projects during the upgrade process. 
For more information, see “Using the E-mail Notification Utility” on 
page 351. 

➤ Determine a timeline for the upgrade and schedule accordingly.
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➤ Plan how to achieve minimum downtime during the upgrade process.

Note: During the entire project upgrading process, the project is in 
inactive status.

For more information on the upgrade process and procedures, see “The 
Upgrade Process” on page 352.

➤ Back up your data and prepare a rollback procedure. For more information, 
see “Backing Up Quality Center and TestDirector Projects” on page 81 and 
“Restoring Quality Center and TestDirector Projects” on page 83.

➤ Assign roles and responsibilities for testing, performing, and verifying the 
upgrade. For more information on upgrade verification, see “Verifying the 
Upgrade Process” on page 357.

➤ When the upgrade to Quality Center has been verified, uninstall 
TestDirector or the previous version of Quality Center from the original 
production server. For information on how to uninstall TestDirector, see 
“Uninstalling TestDirector 7.6 and 8.0” on page 362.

Upgrade Assessment

Before performing an upgrade, carefully review the Quality Center readme 
and validate system requirements for hardware and software. In addition, 
check the Mercury Customer Support site for known limitations that have 
been reported since the release. Look for any limitations that affect your 
specific hardware, software, or third-party integrations.

In general, the following issues will cause the upgrade to fail:

➤ Non-compliance with hardware requirements, such as display support and 
memory requirements

➤ Non-compliance with software requirements, such as database type and 
version, Web server type and version, application server type and version, 
and browser support

➤ Incompatibility issues (HP or third-party integrations)

➤ Non-compliance with customized projects, such as adding or modifying 
tables, columns, column types, stored procedures, or triggers to database
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➤ Corrupted database, such as duplicated primary key or corrupted index

➤ Network connection failure for database or file system

➤ Insufficient user privileges in the database and operating system

After assessing the upgrade, contact Mercury Customer Support 
(http://support.mercury.com) for assistance in resolving any of the above 
issues.

Upgrade Scope and Strategy

Determine which components you want to upgrade, including database 
server, hardware, and software. The process involves project migration that 
can be performed by either a mass migration or a gradual migration. Verify 
the migration in your testing environment before performing the actual 
upgrade.

Type of Migration Points to Consider

Mass ➤ During a mass migration, the production environment, 
including TestDirector and Quality Center servers, will 
not be available to the end users.

➤ Based on the testing results, you can estimate system 
downtime and decide whether this strategy is suitable in 
your environment.

➤ A mass migration can be an appropriate strategy if you 
do not have many projects to migrate and system 
downtime is permissible.

Gradual ➤ During a gradual migration, users are not able to access 
the migrated group of projects during the upgrade.

➤ Once the migration of a group of projects is complete, 
these projects will be accessible to all end users in the 
Quality Center production environment.

➤ This strategy provides flexibility in managing the 
upgrade process by dividing the migration into smaller 
pieces and minimizing downtime during which end 
users cannot access their projects.

http://support.mercury.com
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Upgrade Checklist

Complete the checklist for the current production environment. You use 
this information checklist when setting up a testing environment and 
during the upgrade process.

TestDirector Checklist
Use the TestDirector checklist when setting a testing environment and 
during the upgrade process.

Check Item Where to get information Description of item

Operating 
System version 
(build# and 
service pack#)

Click Start > Run, and type 
winver.

➤ Windows NT 4.0 Server

➤ Windows 2000 Server

➤ Windows 2000 
Advanced Server

➤ Windows 2003 Server

➤ Build#

➤ SP#

IIS version On the server, open a browser 
and type http://localhost. 

➤ IIS 4.0

➤ IIS 5.0

Proxy Setting 1  On the TestDirector machine, 
open a Web browser, and 
choose Tools > Internet 
Options. 

2  Click the Connections tab, 
and click LAN Settings. If Use 
automatic configuration script 
or Use a proxy server for your 
LAN are selected, make a note 
of the proxy setting.

➤ Use automatic 
configuration script

➤ Use proxy server

➤ Proxy server or 
automated 
configuration script are 
not used

SSL If you use HTTPS as part of the 
URL to connect to TD, you are 
using SSL.

➤ Use SSL 

➤ Do not use SSL



Appendix B • Guidelines for Upgrading and Migrating to Quality Center

344

User Account 
set when 
TestDirector 
was installed

Check with person who installed 
TestDirector

DCOM 
configuration 
user account

1  Type dcomcnfg in the run 
command. 

2  In the Application Tab, select 
Mercury TD2000 server or 
Mercury OTASERVER. 

3  Click Properties and select the 
Identity tab. 

4  Select This user account.

Database 
version

(For Oracle)

Oracle Server: 
From the Oracle client 
program group, open SQL Plus 
Utility and connect to the 
Oracle server. Once 
connected, it displays the 
version of your Oracle server.

Oracle Client: 
1  Choose Start >Programs > 

Oracle for Windows NT (or its 
equivalent) > Oracle Client 
Release Notes. 

2  The release number is 
displayed under the Oracle 
Client X heading (where X is 
the first number of your 
version). 

Oracle:

➤ Oracle Server

➤ Oracle Client

Check Item Where to get information Description of item
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Database 
version

(For Microsoft 
SQL)

Microsoft SQL Server:
1  In your Microsoft SQL Server 

client program group, open 
Query Analyzer (for Microsoft 
SQL Server 7.0 and 2000), or 
isql_w (for 6.5). 

2  Run the SQL select @@version 
to get the version of your 
Microsoft SQL Server. 

Microsoft SQL Client:
1  Open Query Analyzer (for 

Microsoft SQL Server 7.0 and 
2000) or isql_w (for 6.5) 

2  Choose Help > About to get 
the version of SQL Server 
client.

Microsoft SQL:

➤ SQL Server

➤ SQL Client

Database 
version

(For Sybase)

Sybase Server:
1  In your Sybase client program 

group, open SQL Advantage. 

2  Run the SQL select @@version 
to get the version of your 
Sybase client.

Sybase Client:
1  Open SQL Advantage.

2  Choose Help About > SQL 
Advantage to get the version 
of Sybase client. 

Sybase:

➤ Sybase Server

➤ Sybase Client

Database 
version

(For Microsoft 
Access)

The version is Microsoft Access 
2000.

Check Item Where to get information Description of item
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TestDirector 
Server Alias 
Connection 
Information

1  In Site Administration, click 
DB server tab, and check the 
server alias name and 
connection string.

2  From the database client side:

➤ For Oracle: In <Oracle 
client installation file 
system>, open 
tnsnames.ora and get the 
server alias information.

➤ For Microsoft SQL: Open 
the Client Network Utility, 
and click the Alias tab to 
get the server alias 
information.

➤ For Sybase: Open DSEDIT 
utility to get the server alias 
information.

➤ Oracle

➤ MSSQL

➤ Sybase

TestDirector 
Domain 
Repository

1  In the Projects tab of Site 
Administration, select the 
domain, and look in the 
Physical Directory box.

2  On the TestDirector server, 
open C:\WINNT\mercury.ini 
and get the TDREPDIR.

Domain Repository

Check Item Where to get information Description of item
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Quality Center Checklist
Use the Quality Center checklist when setting a testing environment and 
during the upgrade process.

Check Item Where to get information Item Description 

Operating 
System (type 
and version)

➤ For Windows, select Start 
> Run, and type winver

➤ For Unix, type uname -a 

➤ Windows 2000 Server

➤ SP#

➤ Windows 2003 Server

➤ SP#

➤ Redhat Enterprise Linux 
AS/ES version 4

➤ Solaris 9 OE or 10

Java Virtual 
Machine

java -version  JVM 1.4.2 or above

Web Server Check with your system 
administrator

➤ IIS 5.0 or 6.0

➤ Apache 2.0.x

➤ JBoss 4.0.x

➤ WebLogic 8.1.x

Application 
Server

Check with your system 
administrator

➤ Jboss 4.0.x

➤ WebLogic 8.1.x

➤ WebSphere 5.1.1.x, 6.0.1, 6.1

Proxy Setting 1  Open a Web browser, and 
choose Tools > Internet 
Options. 

2  Click the Connections tab, 
and click LAN settings. If 
Use automatic 
configuration script or Use 
a proxy server for your 
LAN are selected, make a 
note of the proxy setting.

➤ Use automatic configuration 
script

➤ Use proxy server

➤ Proxy server or automated 
configuration script are not 
used

SSL If you use HTTPS as part of 
the URL to connect to 
Quality Center, you are using 
SSL

➤ Use SSL

➤ Do not use SSL
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User Account 
set when 
Quality Center 
was installed 

Check with the person who 
installed Quality Center

Database 
version

For Oracle:
In the Oracle client program 
group, open SQL Plus Utility 
and connect to the Oracle 
server. Once you are 
connected, it displays the 
version of your Oracle server.

For Microsoft SQL: 
1  In your Microsoft SQL 

Server client program 
group, open Query 
Analyzer. 

2  Run the SQL 
select @@version to get 
the version of your 
Microsoft SQL Server.

Quality Center 
Database 
Server Alias 
Connection 
Information

In Site Administration, click 
DB server tab, and check the 
server alias name and 
connection string.

➤ Oracle

➤ MSSQL

Quality Center 
Domain 
Repository

1  In the Site Projects tab of 
Site Administration, select 
the domain, and look in 
the Physical Directory box.

2  In the Site Configuration 
tab of Site Administration, 
look at the 
BASE_REPOSITORY_PATH 
parameter value. 

Domain Repository

Check Item Where to get information Item Description 
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Setting Up the Testing Environment

The upgrade process impacts functionality, performance, and compatibility 
with other HP products and third-party integrations. Before installing 
Quality Center on your production environment, test Quality Center in a 
testing environment that reflects your specific configuration. 

The testing environment is separate from, and precisely reflects, the 
production environment. It simulates the configurations and applications 
installed on the production system, including the database server, 
hardware/software, and production projects. By testing the upgrade in your 
testing environment, you can get a better picture of the results you will 
achieve, while identifying and preventing any potential negative impact to 
your production environment.

To set up the testing environment when migrating projects from 
TestDirector to Quality Center:

 1 Build a TestDirector testing server that simulates the existing TestDirector 
production server:

 a Install the operating system on the machine.

 b Install the database client.

 c Install TestDirector.

 d Make copies of the production projects and restore them to the testing 
machine.

 e Verify the database connection. 

 2 Build a Quality Center testing server that simulates the Quality Center 
production server.

 a Install the operating system on the machine.

 b Install the application server and the Web server.

 c Install Quality Center.

 d Verify the database connection.
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 3 In Quality Center Site Administration, create a database server alias pointing 
to a database server. The server alias must have the same name and point to 
the same database server as the database alias that exists on the TestDirector 
testing server.

For example, TDORASERVER

➤ If you want to link the domain repository during the migration process, 
create a mapped drive on the Quality Center testing server so that it can 
access the domain repository.

➤ If you are using a database version in TestDirector that is not supported in 
Quality Center (such as Oracle 8.1.7), see “Verifying the Upgrade Process” 
on page 357.

To set up the testing environment when upgrading projects from previous 
versions of Quality Center:

Build a Quality Center testing server that simulates the new Quality Center 
production server.

 a Install the operating system on the machine.

 b Install the application server and the Web server.

 c Install Quality Center 9.2.

 d Import project data.

 e Upgrade the projects.

Validating the Results

Validate test results by comparing the functionality and performance in the 
latest version of Quality Center with those in the current version. If you are 
using HP integration or a third-party tool with Quality Center, validate 
backward compatibility of these integrations as well. For example, if you use 
TDAPI functions in an HP WinRunner script, you must run the script after 
the upgrade to verify whether the new TDAPI components installed during 
upgrade procedure are compatible with the HP WinRunner application.
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Using the E-mail Notification Utility

The e-mail notification utility allows administrators to send notification 
e-mails (subject only) to TestDirector users, using Open Test Architecture. 
This program is useful for sending messages to users connected to 
TestDirector informing them to log out from TestDirector.

The e-mail notification utility does the following:

➤ It uses the SAClient.dll to verify the Site Administration password for 
security. To use it, unzip the file, copy it in the client machine and register it 
using regsvr32.

➤ It allows selection of any or all domains and any or all projects.

➤ It uses one TestDirector user account (such as Guest) to log in to all projects.

➤ It creates a log file with a list of e-mail addresses.

The utility is available on the Customer Support Web site 
(http://support.mercury.com). Go to Downloads > Browse, select the product 
TestDirector, and click the Retrieve button. Click the Sending notification e-
mails to TD 7.6 users link to download the file.

For more information on downloading the e-mail notification utility, refer 
to the Mercury Support Knowledge Base (http://support.mercury.com/cgi-
bin/portal/CSO/kbBrowse.jsp), select TestDirector for Quality Center, and 
search for Article Number 30099.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
http://support.mercury.com
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The Upgrade Process

To upgrade from TestDirector 7.6 or 8.0 to the latest version of 
Quality Center, you must migrate the projects. Projects are migrated to 
Quality Center using the Migration Tool.

The Quality Center Migration Tool performs the following upgrade steps:

➤ Deactivates the project from the TestDirector server and upgrades it to 
TestDirector 8.0 Service Pack 2.

➤ Migrates the project information to the Quality Center Site Administration 
database.

➤ Adds users that exist in the migrated project to Quality Center Site Users (in 
case they don’t exist).

➤ Upgrades the project to the latest version of Quality Center.

➤ Removes reference to the project from the TestDirector server.
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The Upgrade Flowchart
The upgrade procedure is illustrated in the following flowchart:

Define the goal of your 
upgrade

Receive Quality 
Center 9.2 DVD

Upgrade assessment

Define upgrade scope 
and strategy

Complete detailed 
upgrade procedure

Resources for 
full testing?

Upgrade on testing 
environment

Validate test results

Upgrade on productionRollback procedure

Contact Customer 
Support

Finish upgrade

Yes

No

Success

Fail

Success

Fail
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Upgrade Recommendations
Before you start the upgrade process, make sure that you consider the 
following issues:

➤ Choose supported hardware/software environments for Quality Center. For 
more information, refer to the Mercury Support Knowledge Base 
(http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp), select 
TestDirector for Quality Center, and search for Article Number 44879. You 
can also refer to the HP Quality Center Installation Guide.

➤ For maximum convenience in maintaining and managing your test 
management data, ensure that the domain repository is located on the local 
Quality Center server machine. However, if a remote repository has to be 
used under certain circumstances, on the File System > Security > Property 
setting of the remote repository, add the Quality Center application server 
service user account with Read/Write/Execute/Delete network access 
permissions to the remote repository.

➤ To troubleshoot project migration problems, check the Quality Center log 
files. The path to the log files is determined by the path set in Site 
Administration in the Servers tab.

➤ Use the e-mail utility described in “Using the E-mail Notification Utility” on 
page 351 to notify TestDirector end users that they need to log out from 
certain projects during the upgrade process.

Upgrade Procedures
When you upgrade from TestDirector to Quality Center, you can perform a 
mass migration or a gradual migration. For more information, see “Upgrade 
Scope and Strategy” on page 342.

In the upgrade procedures, the following abbreviations are used for the 
different servers:

➤ TD server. The current TestDirector production server.

➤ DB server. The database server used to store the current versions of 
TestDirector projects.

➤ QC server. The Quality Center production server.

http://support.mercury.com/cgi-bin/portal/CSO/kbBrowse.jsp
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Notes: 

➤ During the upgrade procedure, the TD server and the QC server share the 
same project database information on the same DB server, so you cannot 
change the DB server machine or upgrade the DB server version. If you 
want to upgrade the DB server version or change to a different DB server 
machine, do so either before or after the upgrade to Quality Center.

➤ Quality Center supports Oracle and MSSQL databases. If you have Access 
or Sybase projects in TestDirector, you must convert them to either 
Oracle or MSSQL projects prior to the upgrade. 

To perform a mass migration:

 1 Notify all users to log out from TestDirector projects, and then deactivate all 
projects. For TestDirector 7.6 and 8.0, you can stop the TestDirector 
application.

 2 Make a full backup of all TestDirector projects on the DB server and the TD 
server. TestDirector stores data in both the database server backend and the 
domain repository on the file system. Back up both to ensure a full backup 
of TestDirector projects.

For information on backing up data on the database server and file system, 
see “Backing Up Quality Center and TestDirector Projects” on page 81. 

 3 Make an image of the TestDirector server machine. The TD server can be 
used for a rollback system. Do not uninstall TestDirector until you verify the 
migration process on the QC server. 

 4 On the TD server, install MercuryQualityCenter_MigrationTool.exe from the 
Quality Center installation DVD. This must be installed with the same user 
that runs TestDirector.

 5 Install Quality Center on the QC server. 

For information on installing Quality Center, refer to the HP Quality Center 
Installation Guide.
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 6 Verify the new QC server installation.

Verify the database connection to the DB server by pinging the database 
server. If you want to link the domain repository from the QC server during 
the migration, you must allow access from the QC server. For more 
information on checking the connection to the database server, see 
“Defining New Database Servers” on page 115.

 7 Run the Quality Center Migration Tool and migrate all TestDirector projects 
to the QC server. If the migration procedure fails, use the backup database 
file and project files to restore the project on the TD server and DB server, 
and then migrate it to the QC server. 

For information on using the Migration Tool, see “Migrating TestDirector 
Projects to Quality Center” on page 70. For information on restoring data 
on the DB server, see “Restoring Quality Center and TestDirector Projects” 
on page 83.

 8 Activate all projects on the QC server to verify the migration.

To perform a gradual migration:

 1 Determine which TestDirector projects you want to migrate at this time, and 
make a full backup of them on the DB server and TD server. Deactivate these 
projects on the TD server.

For information on backing up data on the database server and file system, 
see “Backing Up Quality Center and TestDirector Projects” on page 81.

 2 On the TD server, install MercuryQualityCenter_MigrationTool.exe from the 
Quality Center installation DVD. 

 3 Install Quality Center on the QC server. 

For information on installing Quality Center, refer to the HP Quality Center 
Installation Guide.

 4 Verify the new QC server installation.

Verify the database connection to the DB server by pinging the database 
server. If you want to link the domain repository from the QC server during 
the migration, you must allow access from the QC server. For more 
information on checking the connection to the database server, see 
“Defining New Database Servers” on page 115.
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 5 Run the Quality Center Migration Tool and select only those TestDirector 
projects that you want to migrate to Quality Center at this time. If the 
migration procedure fails, use the backup database file and project files to 
restore the project on the TD server and DB server, and then migrate it to 
the QC server. 

For information on using the Migration Tool, see “Migrating TestDirector 
Projects to Quality Center” on page 70. For information on restoring data 
on the DB server, see “Restoring Quality Center and TestDirector Projects” 
on page 83.

 6 Activate all projects on the QC server to verify the migration.

Verifying the Upgrade Process

After you perform the upgrade, check the following:

➤ Verify that you can connect to the projects in Site Administration.

➤ Ask users to check that they can log in to all Quality Center projects using 
their accounts.

➤ Ask users to perform their routine operations and report feedback such as 
response time or the occurrence of any error.

➤ Ask users to check new features and functionalities within Quality Center 
and report feedback.

➤ Perform a load test on the testing environment to verify that it can handle 
the intended number of users.

➤ If you are using an HP integration or a third-party tool with Quality Center, 
validate backward compatibility of the integration and report feedback.

For an example of a checklist for verifying the Quality Center upgrade, see 
“Quality Center Upgrade Verification Checklist” on page 358. Gather all the 
feedback and contact Mercury Customer Support if necessary to solve any 
issues. When the upgrade to Quality Center has been verified, uninstall 
TestDirector from the original production server. For information on how to 
uninstall TestDirector, see “Uninstalling TestDirector 7.6 and 8.0” on 
page 362.
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Quality Center Upgrade Verification Checklist
Use this Quality Center checklist to verify the upgrade process after you 
have performed the upgrade.

Topic Checks

Logon ➤ Different users

➤ Different projects

➤ Logout

Customize ➤ Projects Users

➤ Groups

➤ Project Entities

➤ Project Lists

Requirements ➤ All data exists (sample few requirements)

➤ All requirements exist

➤ All test coverage exists

➤ Correct requirement details

➤ All attachments exist

➤ Add requirements

➤ Delete requirements
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Test Plan ➤ All data exists (sample few test)

➤ All folders and tests exist

➤ Correct test details

➤ Correct design steps

➤ Correct test script

➤ Test attachments exist

➤ Correct requirements coverage

➤ Add folder

➤ Move folder

➤ Delete folder

➤ Add new test

➤ Manual

➤ Script

➤ Delete test 

➤ Filter

➤ Set 

➤ Clear

➤ Refresh

➤ Launch test

➤ QuickTest Professional

➤ WinRunner

➤ Associate test to defect

Topic Checks
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Test Lab ➤ All data exists

➤ All test sets exist

➤ All tests in the test sets exist (sample a few test sets)

➤ All test run reports exist (sample a few tests)

➤ All run steps exist (sample a few runs)

➤ Check the Execution Flow (sample a few test sets)

➤ Check the Test Set Properties (sample a few test sets)

➤ Add folder

➤ Move folder

➤ Delete folder

➤ Add new test set

➤ Move test set

➤ Delete test set

➤ Copy test set

➤ Filter

➤ Set

➤ Clear

➤ Refresh

➤ Run manual test

➤ Run automated script

➤ WinRunner and QuickTest Professional

➤ Run locally

➤ Run remotely

➤ Run test set

➤ Launch test report

➤ Attach file to test set

➤ Attach file to folder

Topic Checks
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Defects ➤ All data exists (sample a few defects)

➤ All defects exist

➤ Correct defect details

➤ Correct defect attachment

➤ Correct defect history

➤ Insert new defect

➤ Delete a defect

➤ Update an existing defect

➤ Add attachment to defect

➤ Select columns and arrange columns

➤ Mail defect

➤ Defect workflow 

➤ Multiple value lists 

➤ All values exist in all multiple value list fields

➤ Fields dependencies

➤ Template

➤ Delete

➤ Save

➤ Save as default

➤ Favorites

➤ Verify that all favorite filters exist

➤ Select

➤ Add

➤ Organized

➤ Filter

➤ Set 

➤ Clear

➤ Refresh

➤ Create Report

➤ Create Graph

➤ Use Copy/Paste

➤ Copy Defects

Topic Checks
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Migrating Projects from Oracle 8.1.7 (and earlier) to 
Oracle 10

If you are migrating a TestDirector project on an Oracle 8.1.7 and earlier 
database version (not supported in Quality Center) to a version that is not 
supported in TestDirector (for example Oracle 10), you must first upgrade 
the database server to a middle version. Oracle 9.2 is a middle version that is 
supported by both TestDirector and Quality Center versions.

To migrate projects from Oracle 8.1.7 (and earlier) to Oracle 10:

 1 In the TestDirector environment, upgrade the database server to Oracle 9.2.

 2 Migrate the projects from TestDirector to Quality Center.

 3 Upgrade the database server to Oracle 10.

Uninstalling TestDirector 7.6 and 8.0

When the upgrade to Quality Center has been verified, uninstall 
TestDirector from the original production server. To uninstall TestDirector, 
refer to the TestDirector Installation Guide.

Note: To ensure a clean uninstall of TestDirector 7.6 and 8.0, also delete the 
registries that pertain to TestDirector:

➤ HKEY_CURRENT_USER\Software\Mercury Interactive\TestDirector

➤ HKEY_LOCAL_MACHINE\SOFTWARE\Mercury Interactive\TestDirector 

➤ HKEY_LOCAL_MACHINE\SOFTWARE\Mercury Interactive\Mercury 
Tours
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C
Storing Project Data in the Project’s 
Database

Quality Center enables you to store project data in the project’s database 
when creating or upgrading a project. If a project’s repository is stored in the 
database, you can also export and import Quality Center projects.

Note: For projects that have large project repositories (over 500 MB) or when 
working in a production environment, it is recommended that you use the 
file system for managing your Quality Center projects. As projects grow in 
size, you may also experience degradation in performance when storing the 
project repository in the database.

This appendix describes: On page:

About Storing Project Data in the Project’s Database 364

Exporting a Project 367

Importing a Project 368



Appendix C • Storing Project Data in the Project’s Database

364

About Storing Project Data in the Project’s Database

When you create a new project, you can store the project data in the 
REPOSITORY table in the project’s database. Storage in this table is an 
alternative to storage on the application server's file system. Note that you 
can store data in the project’s database only if the SHOW_REPOSITORY_
OVER_DB parameter is enabled in the Site Configuration tab. For more 
information, see “Configuring Parameter Settings to Store Project Data in 
the Project’s Database” on page 366.

By storing project data in the project's database, you can consolidate your 
data-handling procedure. For example, when you back up or restore a 
project. You can also perform hot backups on your database. In addition, 
security and manageability issues caused by storing data in the file system 
are eliminated. For example, you no longer have to share files.

To query specific data that is stored in the REPOSITORY table, double-click a 
project in the Site Projects tab. Select the REPOSITORY table. For more 
information on querying, see “Querying Project Tables” on page 51. For 
more information on the REPOSITORY table, refer to the HP Quality Center 
Software Database Reference.
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When the SHOW_REPOSITORY_OVER_DB parameter exists and is set to “Y”, 
you can do the following:

➤ Store project data in the project’s database when creating a new project. 

➤ Export Quality Center projects. For more information, see “Exporting a 
Project” on page 367.

➤ Create a new project by importing data from an exported Quality Center 
project file. For more information, see “Importing a Project” on page 368.

➤ Upgrade projects containing project repositories in the file system, and 
move the project’s repository to the database. For more information, see 
“Upgrading Quality Center Projects” on page 63.

Notes: 

➤ The dbid.xml file is stored in the project directory in the file system even 
if the project data is stored in the database.

➤ As an alternative to storing project data on the project’s database, you 
can store the project data on the application server's file system. For more 
information, see “Understanding the Quality Center Project Structure” 
on page 27.
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Configuring Parameter Settings to Store Project Data in 
the Project’s Database
To use the repository over database option to store project data in the 
project’s database, you must add the SHOW_REPOSITORY_OVER_DB 
parameter in the Site Configuration tab, and set its value to “Y”. When this 
parameter is enabled, you can enable additional database storage options by 
adding the following parameters:

Parameter Setting

CREATE_DB_REPOSITORY_
VISIBILITY

Set to “Y” to display the Store project’s 
repository in the database check box in the 
Create Project dialog box. 

For more information, see “CREATE_DB_ 
REPOSITORY_VISIBILITY” on page 132.

SELECT_FS_OVER_DB Set to “Y” to set Store project’s repository in 
the database check box as the default 
selection in the Create Project dialog box. 

For more information, see 
“SELECT_FS_OVER_DB” on page 138.
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Exporting a Project

Exporting Quality Center projects enables you to take project data from a 
Quality Center server, and back it up to another location or on some other 
media device. For example, you may want to create self-contained project 
image files that are backed up on a USB key or DVD. You can send the media 
device to a Quality Center server in another location, and import the project 
files. When you export a project file, it is saved and exported in ZIP format.

Notes: 

➤ You cannot import Quality Center project export files (.qcp files) to 
Quality Center 9.2 if they were created in an earlier version of 
Quality Center.

➤ The export Quality Center project data feature is available only if the 
SHOW_REPOSITORY_OVER_DB parameter exists and is set to “Y” in the 
Site Configuration tab. For more information, see “SHOW_REPOSITORY_ 
OVER_DB” on page 138.

➤ You can export a Quality Center project only if its project repository is 
stored in the database. To export a project repository stored in the file 
system, you must upgrade it and move its repository to the database.

➤ If you export a Quality Center project that has extensions installed, all 
data from the project is exported, including data for the extensions. You 
can only import such an exported project to a server that has the relevant 
extensions installed.
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To export a Quality Center Project:

 1 In Site Administration, click the Site Projects tab.

 2 In the Projects list, select a project, and click the Export Project to QC 
Project File button. Alternatively, right-click the project and choose Export 
Project. If the project is active, you are prompted to deactivate it. For more 
information, see “Deactivating and Activating Projects” on page 53.

 3 The Save As dialog box opens. Select the directory where you want to save 
the project data. Enter a name for the project in the File name box. By 
default, the data is saved as a Quality Center Project Export file (.qcp).

 4 Click Save to save the project data as a Quality Center Project Export file.

Importing a Project

You can import data from exported Quality Center project files or from 
customized projects created by content providers. For example, you can 
import customized tests, requirements, and test sets for SAP testing, Siebel 
testing, and SOX compliance testing created by HP content providers.

Notes: 

➤ The import Quality Center project data feature is available only if the 
SHOW_REPOSITORY_OVER_DB parameter exists and is set to “Y” in the 
Site Configuration tab. For more information, see “SHOW_REPOSITORY_ 
OVER_DB” on page 138.

➤ You cannot import Quality Center project export files (.qcp files) to 
Quality Center 9.2 if they were created in an earlier version of 
Quality Center. 
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To import a Quality Center Project:

 1 In Site Administration, click the Site Projects tab.

 2 You can do one of the following:

➤ Select the domain to which you want to import a project, and click the 
Import Project from QC Project File button. Alternatively, right-click the 
domain and choose Import Project.

➤ Click the Create Project button. The Create Project dialog box opens. 

Choose the Create a project by importing data from an exported 
Quality Center project file option, and click Next.
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 3 The Create Project: Select File for Import dialog box opens.

 4 Click the browse button to the right of the Import Quality Center project 
from box to locate the project that you want to import. The Open dialog 
box opens.

 5 Locate the directory.

 6 Select the Quality Center Project Export file that you want to import, and 
click Open. The selected file is displayed in the Import Quality Center 
project from box.
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 7 Click Next. The following dialog box opens.

 8 In the Project Name box, type a name for your Quality Center project.

 9 In the In Domain box, select a domain. 

Tip: After the project has been created, you can move it to a different 
domain in the Projects list using a drag-and-drop operation.
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 10 Click Next. The following dialog box opens.

 11 Under Database Type, select Oracle or MS-SQL. If you are working in MSDE, 
select MS-SQL.

 12 By default, values defined during the Quality Center installation are 
displayed for Server Name, DB Admin User, and DB Admin Password. If 
additional database servers are defined, you can select another name from 
the Server Name list. 

Note: For more information on defining database servers, see “Defining 
New Database Servers” on page 115.
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 13 Click Next.

If your selected database server does not have the text search feature 
enabled, a message box opens. It indicates that after this process completes, 
you can enable the text search feature. For more information on enabling 
the text search feature, see “Configuring Text Search” on page 120.

 14 If you are creating a Microsoft SQL project, proceed to step 15. For an Oracle 
project, the following dialog box opens.

In the Create in TableSpace box, select a storage location from the list. You 
should not use UNDO as the storage location.

In the Temporary TableSpace box, select a temporary storage location for 
the new project.
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 15 Click Next. The Add Project Administrators dialog box opens.

Selected Project Administrators lists Quality Center users that are assigned 
as project administrators. Available Users lists Quality Center users available 
in the project. When you assign project administrators, they are moved 
from the Available Users list to the Selected Project Administrators list. 

➤ Refresh. Click the Refresh button to refresh the list of available users.

➤ Find. Type the name of a user in the Find box, and click the Find button 
to search the Available Users list.

➤ Add Selected Users. Select the users you want to assign as project 
administrators, and click the Add Selected Users button. Alternatively, 
double-click a user. The selected users are displayed in the Selected 
Project Administrators list.

➤ Delete. To remove a user from the Selected Project Administrators list, 
right-click the user and click Delete.

Note: You can also assign project administrators after you have created the 
project. For more information, see “Assigning Project Administrators” on 
page 48.
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 16 Click Next. The following dialog box opens.

Verify the project details. To change any of the details, click Back.

 17 You can select Activate Project to instruct Quality Center to activate the new 
project. For more information, see “Deactivating and Activating Projects” 
on page 53.

 18 Click Create. The new project is added to the Projects list.

After you successfully complete these steps, the data is imported to a new 
project, and the new project is added to the Projects list.
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A

Action object 296
Action property 295
ActionCanExecute event 276
Actions object 295
Activate Project button 53
Activate Project command 37, 375
ActiveDialogName property 304
ActiveModule property 303
Add Cycle task 182
Add Defect Link task 190
Add Defect task 189
Add Design Step task 186
Add Folder task 186, 187
Add Host Group task 188
Add Hosts task 188
Add List Match Rule button 246
Add Primary/Secondary Rule button 245
Add Private Favorite Views task 192
Add Public Favorite Views task 192
Add Release Folder task 181
Add Release task 181
Add Requirement task 183
Add Requirement Traceability task 183
Add Selected Users button 24, 36, 374
Add Site Administrators button 24
Add Test Set task 187
Add Test task 186
Add Test to Test Set task 188
Add Tests to Coverage task 183
Add User button 161
Add User to Project dialog box 161
ADD_NEW_USERS_FROM_PROJECT 

parameter 126, 161
Add-ins Page command 15
Administration tab 191
Adobe Reader 13

AfterPost event 277
alert rules 237–239
Alert Rules link 239
Allow Multiple Values check box 203
ALLOW_MULTIPLE_VALUES parameter 130
ALLOW_REQ_COVERAGE_BY_TEST_INSTA

NCE parameter 130
Analysis tab, Permission Settings dialog box 

190
ATTACH_MAX_SIZE parameter 126
Attachment_CanDelete event 277
Attachment_CanOpen event 278
Attachment_CanPost event 278
Attachment_New event 279
Authentication Settings dialog box 100
AUTO_MAIL_SUBJECT_FORMAT parameter 

131
AUTO_MAIL_USER_NOTIFICATION 

parameter 46, 101, 131
AUTO_MAIL_WITH_ ATTACHMENT 

parameter 127
AUTO_MAIL_WITH_ HISTORY parameter 

127
Automail configuration 217–223

defining conditions 220
designating fields 219

Automail page 219, 220
automatic notification 46, 101
Automatic Refresh command 107
Available Users list 36, 374

B

BACKWARD_SUPPORT_ALL_DOMAINS_ 
PROJECTS parameter 131

BACKWARD_SUPPORT_SA_DEFAULT_USER
parameter 132

Index
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base repository 27
BASE_REPOSITORY_PATH parameter 127
Bug_AfterPost event 277
Bug_CanDelete event 280
Bug_CanPost event 282
Bug_FieldCanChange event 285
Bug_FieldChange event 286
Bug_Fields object 298
Bug_MoveTo event 288
Bug_New event 289
Business Criticality customizing criteria 227
Business Criticality tab 227

C

Calculated Testing Time grid 234
CanAddTests event 279
CanCustomize event 279
CanDelete event 280
CanLogin event 281
CanLogout event 281
CanPost event 282
CanRemoveTests event 282
Change button 170
Change User Properties and Password task 

192
character set 128
Checked property 296
Clear History task 192
Clear Messages command 260
Code Complete button 262
Code Template button 262
Collapse All command, Script Editor 260
collecting Oracle statistics 67

after upgrading projects 69
before upgrading projects 68

Configure Automail task 193
Connection String Editor dialog box 57, 118
connection string, editing 57
Contact E-mail link 30
Contact Name link 30
Copy button, Script Editor 259
Copy Folder task 186, 188
Copy Graph To Clipboard button, Site 

Analysis 148
Copy Test Set task 187

COPY_CHANGES_USER_FIELDS parameter 
132

COPY_PASTE_CHANGES_OWNER 
parameter 132

Count property 299
Create Domain button 30
Create Domain dialog box 30
Create Project button 32, 38, 369
Create Project dialog box 32, 38, 369

Add Project Administrators 36, 374
copying data 40
Select File for Import 370

CREATE_DB_REPOSITORY_VISIBILITY 
parameter 132

CREATE_HTTP_SESSION parameter 127
CUSTOM_ENABLE_USER_ADMIN parameter 

126
Customer Support Web Site command 15
customization, project 197–216
Customize link 154
Customize Module Access task 192
Customize Project Entities task 192
Customize Project Lists task 193
Customize Requirement Types task 192
Customize Risk-Based Quality Management 

task 193
Cut button, Script Editor 259

D

Data Grid, Site Analysis graphs 145
data hiding 176
Database Administrator Password button 

118
Database Administrator Password link 118
Database Administrator User Name link 118
database name 116
database server permissions 32
database servers

deleting 119
modifying properties 117

DATACONST table 222
Data-Hiding Filter link 177
DB admin password 116
DB admin user 116
Deactivate Project button 53
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Default DB Server list 31
Default Testing Policy grid 235
DefaultRes event 283
Defects Data-Hiding Filter dialog box

Filter tab 177
Visible Fields tab 178

Defects Data-Hiding Filter link 177
Defects module, renaming per project 60
Defects tab, Permission Settings dialog box 

189
Define New Database Server dialog box 115
Delete button

Groups page 180
Script Editor 259

Delete Cycle task 182
Delete Database Server button 119
Delete Defect task 190
Delete Design Step task 186
Delete Domain button 56
Delete Folder task 186, 188
Delete Host Group task 188
Delete Hosts task 188
Delete Item button 216
Delete List button 216
Delete List Match Rule button 246
Delete Parameter button 141
Delete Primary/Secondary Rule button 245
Delete Private Favorite Views task 192
Delete Project button 55
Delete Public Favorite Views task 192
Delete QC Server button 114
Delete Release Folder task 182
Delete Release task 181
Delete Requirement task 183
Delete Run task 188
Delete Test Set task 187
Delete Test task 186
Delete User button 104
Design Excel Report task 191
DesignStep_FieldCanChange event 285
DesignStep_FieldChange event 286
DesignStep_Fields object 298
DesignStep_MoveTo event 288
DesignStep_New event 289
DialogBox event 283

DIRECTORY_TIME_LIMIT_CONSTRAINT 
parameter 134

DISABLE_COMMAND_INTERFACE 
parameter 133

DISABLE_CONSOLE_DEBUG_INFO 
parameter 133

DISABLE_EXTENDED_ STORAGE parameter 
133

Disconnect Users button 107
Documentation Library 13
documentation updates 15
Domain User Quota dialog box 31
domains

creating 30
deleting 56

E

Edit Connection String button
DB Servers tab 118
Site Projects tab 57

Edit Parameter button 141
Edit Parameter dialog box 141
Edit Project Description dialog box 45
e-mail notification utility 351
Enable Selected Extensions button 51
Enable/Rebuild Text Search button 44, 123
Enabled property 296
EnterModule event 284
entities 199–207

adding user-defined fields 203
definition 199
deleting user-defined fields 205
event procedure naming conventions 

273
field settings 201
modifying system and user-defined 

fields 204
event procedures

functions 272
module 273
naming conventions 273
reference 271–291
subroutines 272

examples, workflow 305
Execute method 297
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Execute SQL button 52
ExitModule event 284
Expand All command, Script Editor 260
Export button, Site Configuration tab 141
Export Data To File dialog box

Site Configuration tab 141
Site Users tab 104

Export Data To File dialog box, Site Users tab 
104

Export Project command 368
Export Project to QC Project File button 368
Export User Data To File button, Site Users 

tab 104
exporting

grid data, Site Analysis tab 147
projects 367

Extended Storage object 133
extensions, enabling for projects 50

F

Failure Probability
customizing criteria 227

Failure Probability tab 227
FAVORITES_DEPTH parameter 133
field list customization, script generation 

243
Field Names command, Script Editor 263
Field object 299
Field property 299
FieldById property 299
FieldCanChange event 285
FieldChange event 286
FieldLabel property 300
FieldName property 300
Fields tab 219
Filter button, Site Analysis tab 146
Find button

assigning project administrators 36, 
374

Script Editor 259
Find Next button, Script Editor 259
FullName property 303
functions, workflow events 272

G

Generate Excel Report task 191
Generate Script task 186
GetDetailsPageName event 287
GetNewBugPageName event 287
Getting Started 13
Go to Line Number command 260
Goto List button 202
Group By button 107
Group By Domain command 102
Group By Project command 107
Group By User command 107
Groups page 168

H

Handle Conflict dialog box 94
HEBREW parameter 134
Help on this page command 13
History check box 201
HP Quality Center Options window 19
HP Quality Center Site Administration Login 

window 20
HP Software Web site command 15
https 137

I

ignore_workflow_parameter parameter 155
Import LDAP Users button 89
Import LDAP Users dialog box 89
Import Project command 369
Import Project from QC Project File button 

369
importing projects 368
Input Mask Editor dialog box 206
IsInGroup property 303
IsModified property 300
IsMultiValue property 300
IsNull property 300
IsReadOnly property 300
IsRequired property 300
IsVisible property 300
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K

Knowledge Base command 15

L

LDAP
authentication search criteria 99
enabling authentication for users 99
importing users 88
settings for importing users 90

LDAP Import Settings dialog box 91
LDAP_IMPORT_ATTRIBUTE_MASK 

parameter 134
LDAP_SEARCH_USER_CRITERIA parameter 

99, 128
LDAP_TIMEOUT parameter 134
LICENSE_ARCHIVE_PERIOD parameter 128
Licenses tab 109
Line Chart, Site Analysis graphs 145
List Match rule 243
List property

Field object 300
Lists object 301

List Value button 260
lists 213–216

allowing multiple values 203
creating 214
customizing using workflow 243
deleting 216
deleting items or sub-items 216
renaming 215
renaming items or sub-items

 215
Lists object, workflow scripts 301
LoadRunner, LR DIRECTFILEACCESS 

parameter 135
locale, NLS_SEARCH_LOCALE parameter 

135
LOCK_TIMEOUT parameter 128
Log File Location dialog box 114
log file, Quality Center server 113
Log Level dialog box 114
Log Level link 114
Login button 21
LR DIRECTFILEACCESS parameter 135

M

mail protocol, setting 142
MAIL_FORMAT parameter 128
MAIL_INTERVAL parameter 128
MAIL_MESSAGE_CHARSET parameter 128
mailing defects

defining Automail conditions 220
designating Automail fields 219

Masked check box 201
Max. Log Days link 114
Max. Log Lines link 114
Maximum Database Connections dialog box 

114
Maximum Log Days dialog box 114
Maximum Log Lines dialog box 114
Messages pane 259
Microsoft IIS SMTP Service 142
Microsoft SQL

copying projects 38
creating projects 32
defining database server 116

migrating projects to Quality Center
guidelines 339

Migration Tool 70
MIGRATION_MAX_NUMBER_ 

OF_PROJECTS parameter 135
Modify Cycle task 182
Modify Defect Link task 190
Modify Defect task 189
Modify Design Step task 186
Modify Folder task 186, 188
Modify Host Group task 188
Modify Hosts task 188
Modify License button 110
Modify Private Favorite Views task 192
Modify Public Favorite Views task 192
Modify Release Folder task 182
Modify Release task 181
Modify Requirement task 183
Modify Requirement Traceability task 183
Modify Run task 188
Modify Test in Test Set task 188
Modify Test Set task 187
Modify Test task 186
Module Access page 195



Index

382

modules
customizing access 194
event procedure naming conventions 

273
renaming 136

Move Folder task 186, 188
Move Test Set task 187
MoveTo event 288
MoveToFolder event 288
MoveToSubject event 289
multiple values, allow in list 203

N

New button
Add User to Project dialog box 161
Groups page 168

New Database Server button 115
New event 289
New Field button 204
New Group dialog box 168
New Item button 214
New Item dialog box 214
New List button 202, 214
New List dialog box 214
New Parameter button 141
New Parameter dialog box 141
New Sub-Item button 214
New Sub-Item dialog box 214
New User button 87
New User dialog box 87
NEWREQTYPE parameter 135
NLS_SEARCH_LOCALE parameter 135
Numeration command 136

O

object, workflow 293–303
Oracle

collecting statistics 67
copying projects 38
creating projects 32
defining database server 116

ownership field
COPY_CHANGES_USER_FIELDS 

parameter 132
COPY_PASTE_CHANGES_OWNER 

parameter 132

P

PageNo property 300
parameters 126
Password button

DB Servers tab 118
Site Users tab 98

passwords, changing user passwords 97
Paste button, Script Editor 259
Period pane 145
Permission Settings dialog box 170, 180
permissions

assigning existing set to other user 
groups 179

changing 170
customizing module access for user 

groups 194
data hiding 176
setting user groups 169
transition rules 173
viewing 169

Ping Database Server button 117, 119
Ping Database Server dialog box 117, 119
Ping Project button 54
Primary/Secondary rule 243
Print button, Script Editor 259
Print Graph button, Site Analysis 148
project administration

activating projects 53
assigning project administrators 48
assigning projects to users 101
assigning users to projects 46
backing up projects 81
copying projects 38
copying users from other projects 48
creating domains 30
creating projects 32
deactivating projects 53
deleting database servers 119
deleting domains 56
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deleting projects 55
deleting Quality Center servers 114
editing connection string 57
exporting projects 367
importing projects 368
migrating TestDirector projects to 

Quality Center 70
pinging projects 54
removing projects from Projects list 

55
removing users 48
renaming projects 54
renaming the Defects module for a 

project 60
restoring access to projects 58
restoring projects 83
SQL queries 51
updating project details 42
upgrading projects 63

Project Administrator
about 11
adding during project creation 36, 

374
assigning to projects 48

Project Administrator check box 49
project customization 197–216

adding user-defined fields 203
creating lists 214
deleting items or sub-items 216
deleting lists 216
deleting user-defined fields 205
generating workflow scripts 241
modifying fields 204
overview 151, 197
Project Customization window 151
renaming items or sub-items 215
renaming lists 215
return to main window 154
starting 151

Project Customization window 151
directly logging in to 155

Project Details tab 42
project entities 199–207
Project Entities page 199
Project Extensions tab 50
project lists 213–216

Project Lists page 213
Project User Quota dialog box 45
Project Users page 160, 162, 164
Project Users tab 46
projects

activating 53
assigning users 46
backing up 81
backing up the database 81
backing up the file system 82
copying 38
creating 32
deactivating 53
deleting 55
editing connection string 57
enabling extensions 50
exporting 367
importing 368
migrating TestDirector projects to 

Quality Center 70
pinging 54
removing from Projects list 55
renaming 54
renaming the Defects module 60
restoring 83
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